# 1. ARIES User Manual

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>Overview</td>
<td>7</td>
</tr>
<tr>
<td>1.1.1</td>
<td>Conventions</td>
<td>7</td>
</tr>
<tr>
<td>1.1.2</td>
<td>Security &amp; Access</td>
<td>9</td>
</tr>
<tr>
<td>1.1.3</td>
<td>Entering Data &amp; CADR Required Fields</td>
<td>9</td>
</tr>
<tr>
<td>1.2</td>
<td>ARIES Components</td>
<td>9</td>
</tr>
<tr>
<td>1.2.1</td>
<td>Clients</td>
<td>9</td>
</tr>
<tr>
<td>1.2.2</td>
<td>Staff</td>
<td>10</td>
</tr>
<tr>
<td>1.2.3</td>
<td>Agencies</td>
<td>10</td>
</tr>
<tr>
<td>1.2.4</td>
<td>ARIES Applications</td>
<td>10</td>
</tr>
<tr>
<td>1.3</td>
<td>Getting Started</td>
<td>11</td>
</tr>
<tr>
<td>1.4</td>
<td>Browser Settings</td>
<td>11</td>
</tr>
<tr>
<td>1.5</td>
<td>Logging into ARIES</td>
<td>14</td>
</tr>
<tr>
<td>1.6</td>
<td>Welcome</td>
<td>15</td>
</tr>
<tr>
<td>1.7</td>
<td>Menus</td>
<td>15</td>
</tr>
<tr>
<td>1.8</td>
<td>Keyboard Shortcuts</td>
<td>17</td>
</tr>
<tr>
<td>1.9</td>
<td>Client Tab Bar</td>
<td>18</td>
</tr>
<tr>
<td>1.10</td>
<td>Printing</td>
<td>19</td>
</tr>
<tr>
<td>1.10.1</td>
<td>In Internet Explorer</td>
<td>19</td>
</tr>
<tr>
<td>1.10.2</td>
<td>Copying and Pasting into Word</td>
<td>19</td>
</tr>
<tr>
<td>1.10.3</td>
<td>Importing into Word</td>
<td>21</td>
</tr>
<tr>
<td>1.11</td>
<td>Sessions and Timeouts</td>
<td>21</td>
</tr>
<tr>
<td>1.12</td>
<td>Edit Locks</td>
<td>21</td>
</tr>
<tr>
<td>2.</td>
<td>Clients</td>
<td>22</td>
</tr>
<tr>
<td>2.1</td>
<td>Working with Clients in ARIES</td>
<td>23</td>
</tr>
<tr>
<td>2.1.1</td>
<td>Looking up a client</td>
<td>23</td>
</tr>
<tr>
<td>2.1.2</td>
<td>Creating a new client</td>
<td>25</td>
</tr>
<tr>
<td>2.1.3</td>
<td>Recording a service for a client</td>
<td>29</td>
</tr>
<tr>
<td>2.2</td>
<td>Client Screens</td>
<td>34</td>
</tr>
<tr>
<td>2.2.1</td>
<td>Client Search</td>
<td>34</td>
</tr>
<tr>
<td>2.2.2</td>
<td>Client Search Results</td>
<td>36</td>
</tr>
<tr>
<td>2.3</td>
<td>Creating Clients</td>
<td>37</td>
</tr>
<tr>
<td>2.4</td>
<td>Client Details</td>
<td>41</td>
</tr>
<tr>
<td>2.5</td>
<td>Demographics</td>
<td>41</td>
</tr>
<tr>
<td>2.5.1</td>
<td>Contact Information</td>
<td>42</td>
</tr>
<tr>
<td>2.5.2</td>
<td>Contact Information Edit</td>
<td>43</td>
</tr>
<tr>
<td>2.5.3</td>
<td>Demographic Detail</td>
<td>46</td>
</tr>
</tbody>
</table>
2.5.4 Client Identifiers ....................................................................................... 47
2.5.5 Identifiers Edit .......................................................................................... 47
2.5.6 Demographics ........................................................................................... 48
2.5.7 Demographics Edit.................................................................................... 49
2.5.8 Living Situation ........................................................................................ 52
2.5.9 Living Situation Edit ................................................................................. 53
2.5.10 Related/Affected Individuals ................................................................. 55
2.5.11 Related/Affected Individuals Edit ............................................................. 55
2.5.12 Related/Affected Individual Relationship Edit ......................................... 58
2.5.13 HOPWA .................................................................................................... 59
2.5.14 HOPWA Edit ............................................................................................ 60
2.5.15 Agency Specifics ...................................................................................... 61
2.5.16 Agency Specifics Edit ............................................................................... 63

2.6 Eligibility .......................................................................................................... 65
2.6.1 Eligibility Documents ............................................................................... 66
2.6.2 Eligibility Document Edit ......................................................................... 67
2.6.3 Financial .................................................................................................... 69
2.6.4 Financial Edit ............................................................................................ 70
2.6.5 Insurance ................................................................................................... 73
2.6.6 Insurance Edit ........................................................................................... 74

2.7 Programs .......................................................................................................... 76
2.7.1 Program Summary & Agency Staff Assignment ...................................... 76
2.7.2 Staff Assignment....................................................................................... 77
2.7.3 Staff Assignment Edit ............................................................................... 78
2.7.4 EIP/Bridge/Positive Changes .................................................................... 78
2.7.5 EIP/Bridge/Positive Changes Enrollment ............................................... 80
2.7.6 EIP Enrollment Status Change ................................................................. 82
2.7.7 EIP Psychosocial Factors Edit .................................................................. 83
2.7.8 EIP Psychological Abuse Edit ................................................................... 84
2.7.9 EIP Psychological Legal Edit .................................................................... 85
2.7.10 EIP Psychological Diagnostic Edit ........................................................... 86
2.7.11 EIP Functional Section 1 Edit .................................................................. 88
2.7.12 EIP Functional Section 2 Edit .................................................................. 89
2.7.13 EIP Functional Section 3 Edit .................................................................. 90
2.7.14 EIP Behavioral Section 1 Edit .................................................................. 91
2.7.15 EIP Behavioral Section 2 Edit .................................................................. 93
2.7.16 EIP Behavioral Section 3 Edit .................................................................. 95
2.7.17 EIP Behavioral Section 4 Edit .................................................................. 95
2.7.18 Bridge Project ........................................................................................... 96
2.7.19 Bridge Enrollment Status Change ............................................................ 97
2.7.20 Bridge Project-Barriers to Care Assessment Section I ............................. 98
2.7.21 Bridge Project—Barriers to Care Assessment Section 2 ......................... 99
2.7.22 Positive Changes ..................................................................................... 100
2.7.23 Positive Changes Enrollment ................................................................. 100
2.7.24 Positive Changes Enrollment Status Change ........................................... 100
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.7.25</td>
<td>TMP</td>
<td>101</td>
</tr>
<tr>
<td>2.7.26</td>
<td>TMP Enrollment</td>
<td>102</td>
</tr>
<tr>
<td>2.7.27</td>
<td>TMP Edit</td>
<td>105</td>
</tr>
<tr>
<td>2.7.28</td>
<td>CMP/MCWP</td>
<td>108</td>
</tr>
<tr>
<td>2.7.29</td>
<td>CMP/MCWP Enrollment</td>
<td>109</td>
</tr>
<tr>
<td>2.7.30</td>
<td>CMP/MCWP Edit</td>
<td>111</td>
</tr>
<tr>
<td>2.7.31</td>
<td>CARE/HIPP</td>
<td>113</td>
</tr>
<tr>
<td>2.7.32</td>
<td>CARE/HIPP Enrollment</td>
<td>114</td>
</tr>
<tr>
<td>2.7.33</td>
<td>CARE/HIPP Edit</td>
<td>116</td>
</tr>
<tr>
<td>2.7.34</td>
<td>MEDICARE PART D</td>
<td>118</td>
</tr>
<tr>
<td>2.7.35</td>
<td>MEDICARE PART D Enrollment</td>
<td>118</td>
</tr>
<tr>
<td>2.7.36</td>
<td>MEDICARE PART D Edit</td>
<td>120</td>
</tr>
<tr>
<td>2.8</td>
<td>Medical</td>
<td>121</td>
</tr>
<tr>
<td>2.8.1</td>
<td>Basic Medical</td>
<td>122</td>
</tr>
<tr>
<td>2.8.2</td>
<td>Basic Medical Edit</td>
<td>123</td>
</tr>
<tr>
<td>2.8.3</td>
<td>Medical History</td>
<td>130</td>
</tr>
<tr>
<td>2.8.4</td>
<td>Medical History Edit</td>
<td>132</td>
</tr>
<tr>
<td>2.8.5</td>
<td>OB/GYN &amp; Pregnancy</td>
<td>142</td>
</tr>
<tr>
<td>2.8.6</td>
<td>Edit OB/GYN &amp; Pregnancy</td>
<td>143</td>
</tr>
<tr>
<td>2.8.7</td>
<td>Medical History Flowsheet</td>
<td>147</td>
</tr>
<tr>
<td>2.9</td>
<td>Medications</td>
<td>151</td>
</tr>
<tr>
<td>2.9.1</td>
<td>ART Edit</td>
<td>152</td>
</tr>
<tr>
<td>2.9.2</td>
<td>Other Medications</td>
<td>156</td>
</tr>
<tr>
<td>2.10</td>
<td>Risk &amp; Assessments</td>
<td>158</td>
</tr>
<tr>
<td>2.10.1</td>
<td>Risk Factors Edit</td>
<td>160</td>
</tr>
<tr>
<td>2.10.2</td>
<td>Substance Abuse</td>
<td>162</td>
</tr>
<tr>
<td>2.10.3</td>
<td>Substance Abuse Edit</td>
<td>163</td>
</tr>
<tr>
<td>2.10.4</td>
<td>Mental Health</td>
<td>165</td>
</tr>
<tr>
<td>2.10.5</td>
<td>Mental Health Edit</td>
<td>165</td>
</tr>
<tr>
<td>2.10.6</td>
<td>Assessments</td>
<td>167</td>
</tr>
<tr>
<td>2.11</td>
<td>Needs Assessment/Care Plan/Referral Overview</td>
<td>167</td>
</tr>
<tr>
<td>2.11.1</td>
<td>Needs Assessment</td>
<td>168</td>
</tr>
<tr>
<td>2.11.2</td>
<td>Needs Assessment Edit</td>
<td>169</td>
</tr>
<tr>
<td>2.11.3</td>
<td>Care Plan</td>
<td>170</td>
</tr>
<tr>
<td>2.11.4</td>
<td>Care Plan Edit</td>
<td>172</td>
</tr>
<tr>
<td>2.11.5</td>
<td>Referrals</td>
<td>176</td>
</tr>
<tr>
<td>2.11.6</td>
<td>Referrals Edit</td>
<td>177</td>
</tr>
<tr>
<td>2.12</td>
<td>Case Notes</td>
<td>179</td>
</tr>
<tr>
<td>2.12.1</td>
<td>Case Notes Edit</td>
<td>181</td>
</tr>
<tr>
<td>2.13</td>
<td>Services</td>
<td>184</td>
</tr>
<tr>
<td>2.13.1</td>
<td>Edit Service</td>
<td>186</td>
</tr>
<tr>
<td>3.</td>
<td>Staff</td>
<td>191</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td>------</td>
</tr>
<tr>
<td>3.1</td>
<td>Working with Staff in ARIES</td>
<td>191</td>
</tr>
<tr>
<td>3.1.1</td>
<td>Changing Your Preferences</td>
<td>192</td>
</tr>
<tr>
<td>3.1.2</td>
<td>Changing Your Password</td>
<td>192</td>
</tr>
<tr>
<td>3.1.3</td>
<td>Adding a New Staff person</td>
<td>193</td>
</tr>
<tr>
<td>3.2</td>
<td>Staff Screens</td>
<td>195</td>
</tr>
<tr>
<td>3.2.1</td>
<td>Staff Search</td>
<td>196</td>
</tr>
<tr>
<td>3.2.2</td>
<td>Staff Search Result</td>
<td>197</td>
</tr>
<tr>
<td>3.2.3</td>
<td>Staff Detail</td>
<td>197</td>
</tr>
<tr>
<td>3.2.4</td>
<td>Staff Edit</td>
<td>198</td>
</tr>
<tr>
<td>3.2.5</td>
<td>Staff Permissions</td>
<td>200</td>
</tr>
<tr>
<td>3.2.6</td>
<td>Editing Permissions</td>
<td>202</td>
</tr>
<tr>
<td>4.</td>
<td>Agencies</td>
<td>203</td>
</tr>
<tr>
<td>4.1</td>
<td>Working with Agencies in ARIES</td>
<td>204</td>
</tr>
<tr>
<td>4.1.1</td>
<td>Changing Your Agency Information</td>
<td>204</td>
</tr>
<tr>
<td>4.1.2</td>
<td>Adding or Editing a Site</td>
<td>206</td>
</tr>
<tr>
<td>4.1.3</td>
<td>Creating or Changing Contracts</td>
<td>207</td>
</tr>
<tr>
<td>4.1.4</td>
<td>Creating an Agency</td>
<td>209</td>
</tr>
<tr>
<td>4.2</td>
<td>Agency Screens</td>
<td>215</td>
</tr>
<tr>
<td>4.2.1</td>
<td>Agency Search</td>
<td>216</td>
</tr>
<tr>
<td>4.2.2</td>
<td>Agency Search Result</td>
<td>217</td>
</tr>
<tr>
<td>4.2.3</td>
<td>Agency Detail</td>
<td>217</td>
</tr>
<tr>
<td>4.2.4</td>
<td>Funding &amp; Contracts</td>
<td>218</td>
</tr>
<tr>
<td>4.2.5</td>
<td>Services Provided</td>
<td>219</td>
</tr>
<tr>
<td>4.2.6</td>
<td>CADR</td>
<td>220</td>
</tr>
<tr>
<td>4.2.7</td>
<td>Agency Edit</td>
<td>220</td>
</tr>
<tr>
<td>4.2.8</td>
<td>Agency Sites</td>
<td>222</td>
</tr>
<tr>
<td>4.2.9</td>
<td>Agency Funding Sources</td>
<td>224</td>
</tr>
<tr>
<td>4.2.10</td>
<td>Agency Contracts</td>
<td>225</td>
</tr>
<tr>
<td>4.2.11</td>
<td>Agency Primary Services</td>
<td>226</td>
</tr>
<tr>
<td>4.2.12</td>
<td>Agency Subservices</td>
<td>226</td>
</tr>
<tr>
<td>5.</td>
<td>Reports</td>
<td>228</td>
</tr>
<tr>
<td>5.1</td>
<td>Generating reports in ARIES</td>
<td>228</td>
</tr>
<tr>
<td>5.1.1</td>
<td>Filter Values</td>
<td>229</td>
</tr>
<tr>
<td>5.1.2</td>
<td>Report Results</td>
<td>232</td>
</tr>
<tr>
<td>5.1.3</td>
<td>Exporting Reports</td>
<td>233</td>
</tr>
<tr>
<td>5.1.4</td>
<td>Printing Reports</td>
<td>237</td>
</tr>
<tr>
<td>5.1.5</td>
<td>Change Display Order</td>
<td>237</td>
</tr>
<tr>
<td>5.2</td>
<td>Client Reports</td>
<td>238</td>
</tr>
<tr>
<td>5.2.1</td>
<td>Pending Eligibility Documents</td>
<td>239</td>
</tr>
<tr>
<td>5.2.2</td>
<td>Client Status</td>
<td>241</td>
</tr>
<tr>
<td>5.2.3</td>
<td>Active Client Roster by Staff</td>
<td>244</td>
</tr>
<tr>
<td>5.2.4</td>
<td>Referrals Report</td>
<td>245</td>
</tr>
<tr>
<td>5.2.5</td>
<td>Needs Assessment</td>
<td>248</td>
</tr>
</tbody>
</table>
5.2.6 Immunizations ........................................................................................................... 251
5.2.7 Disease Management ................................................................................................. 254

5.3 Services Reports ........................................................................................................... 256
5.3.1 Mailing Labels ........................................................................................................... 256

5.4 Finance Reports ........................................................................................................... 259
5.4.1 Financial ..................................................................................................................... 260

5.5 Management Reports .................................................................................................. 262
5.5.1 Missing HRSA Data .................................................................................................... 263
5.5.2 Staff User ................................................................................................................... 266
5.5.3 Care Plan Incomplete Tasks ....................................................................................... 268
5.5.4 Unsigned Case Notes ............................................................................................... 271

5.6 Cross Tab Wizard ......................................................................................................... 272
5.6.1 Cross Tab Reports Counting Clients Served .............................................................. 273
5.6.2 Cross Tab Reports Counting All Clients .................................................................... 275
5.6.3 Cross Tab Reports Counting Service Records ......................................................... 277
5.6.4 Cross Tab Reports Counting Service Units ............................................................... 280
5.6.5 Cross Tab Reports for Services by Table ................................................................. 282
5.6.6 Cross Tab Wizard ...................................................................................................... 285
5.6.7 Cross Tab Results ...................................................................................................... 286
5.6.8 Save Report ............................................................................................................... 288

5.7 Compliance Reports ..................................................................................................... 289
5.7.1 CARE Act Data Report ............................................................................................... 291
5.7.2 Care Services Report ................................................................................................ 300
5.7.3 WICY ......................................................................................................................... 303
5.7.4 Ryan White Cross Titles Data Summary .................................................................... 306
5.7.5 HOPWA Progress Report ........................................................................................ 309
5.7.6 HOPWA TDH Housing Assistance Program ............................................................ 310
5.7.7 AIDS Medi-Cal Waiver Enrollment/Disenrollment Form ........................................ 312
5.7.8 Last Date of MCWP Services Compliance Report .................................................. 312
5.7.9 Last Date of MCWP Case Management Compliance Report ................................ 314
5.7.10 Missing MCWP Required Data Compliance Report .............................................. 316
5.7.11 Number of MCWP Clients Served Compliance Report ........................................ 318
5.7.12 Office of AIDS Summary Service Data Report for EIP ........................................ 319
5.7.13 Office of AIDS Summary Referral Data Report for EIP ......................................... 321
5.7.14 Contact History Report ........................................................................................... 322
5.7.15 Active EIP Clients by Program ID Order ................................................................. 325
5.7.16 Active EIP Clients with dates of most recent Major Assessment ............................ 327
5.7.17 EIP Overall Summary .............................................................................................. 329
5.7.18 EIP Compliance Report .......................................................................................... 332
5.7.19 Last Date of CMP Services Compliance Report .................................................... 334
5.7.20 Last Date of CMP Case Management Compliance Report ................................... 336
5.7.21 Missing CMP Required Data Compliance Report ................................................ 338
5.7.22 Number of CMP Clients Served Compliance Report ............................................ 340
1. ARIES User Manual

ARIES, the AIDS Regional Information and Evaluation System, was developed by the State of Texas, the County of San Diego, the County of San Bernardino, and the State of California.

The goal of ARIES is to enhance services for clients with HIV by helping providers automate, plan, manage, and report on client data.

**Overview**

ARIES centralizes client data, service details, and agency and staff information to maximize the quality of care and services to clients in need. Clients receive better care since agencies have a more complete picture of the care plan and the services available. Agencies can better automate service tracking and reporting. As ARIES is used by multiple agencies, service referrals are simplified and, with the client’s permission, agencies can share client records.

Following are typical uses of ARIES by staff members:

- Intake personnel use ARIES to perform enrollments and enter new client records.
- Case managers complete assessments, create care plans, make referrals, and enter services for clients through ARIES.
- Service providers and clinicians use ARIES to access their schedules and enter client notes.
- Agency managers generate reports to track costs and reimbursements. ARIES helps simplify support services for clients, like transportation and food services.
- Researchers can use ARIES for aggregate reporting and data analysis, while maintaining client confidentiality.

ARIES is also readily customizable. ARIES administrators can design new reports with ARIESReportExport and create custom data fields using ARIESAdmin.

**Conventions**

The ARIES user manual is organized by sections of the application. At the beginning of each section, step-by-step examples are given for the most commonly performed tasks, followed by full explanations of every screen and function.
When referring to selecting menu items from the ARIES menu bar, the manual uses terms like, “choose the Find → Client menu item.” In performing this action, move your cursor to the Find menu option. When your cursor rolls over “Find,” a menu drops down, presenting all the available choices. Move your cursor down to the “Client” option and click your mouse to select it.

Also, when filling out forms, ARIES incorporates various input options as outlined in the table below:

<table>
<thead>
<tr>
<th>Input Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>drop-down list</td>
<td>A single-line form item with a gray box on the right of it. Clicking on the box opens up a list of possible choices. Moving your cursor through the list and clicking an item selects that choice.</td>
</tr>
<tr>
<td>text field</td>
<td>An input box that accepts a single line of text. Click your cursor within the box and type.</td>
</tr>
<tr>
<td>text box</td>
<td>An input box that accepts multiple lines of text.</td>
</tr>
<tr>
<td>radio buttons</td>
<td>Two or more small round objects used to select a single choice between multiple selections. Clicking one radio button selects that choice. Clicking another one deselected the first button and selects the new choice.</td>
</tr>
<tr>
<td>checkbox</td>
<td>A square box used to select an option. Clicking a checkbox creates an “x” within it. Clicking it again deselects the checkbox.</td>
</tr>
<tr>
<td>scroll box</td>
<td>A list of text options. Click an item to select it. To select multiple items, hold down the control (Ctrl) key on your keyboard while clicking the choices you wish to include.</td>
</tr>
</tbody>
</table>
**Security & Access**

ARIES employs extensive security measures to protect client data; administrators have fine-grained control over who has access to which parts of the system. This allows all staff persons to use ARIES while preserving client trust.

Not all users have access to all ARIES functions. Staff must have the proper permissions to access each section of ARIES. The permissions are customizable for individual users by an ARIES administrator.

Depending on your permissions, you may not see all the functions referenced in the manual or forms may have fields that are grayed out and inaccessible. To have your permissions changed, contact your supervisor.

Also, ARIES employs multiple layers of security to protect access to data. Each user uses a unique login and password to access ARIES. Also, each computer must have a separate digital security certificate installed on it for every user who accesses the system.

Lastly, the ARIES web servers and databases are protected by firewalls to prevent unauthorized access.

**Entering Data & CADR Required Fields**

When entering data, try to be as accurate and detailed as possible. Accurate information helps ensure that clients receive the services they are entitled to and also that your agency is reimbursed properly. Clinicians also rely on this data when administering health services so quality information is a priority.

When a red asterisk accompanies a field in a form, this field is required in the CARE Act Data Report (CADR). These fields provide required CADR information; without this information, your agency’s reimbursement for services may be delayed. It is important to enter this information as soon and as accurately as possible. In some cases, you will not be able to save forms without filling in all red-asterisked fields.

**ARIES Components**

The ARIES application is divided into four main sections:

**Clients**

Clients are individuals who receive services from your agency. These services can be anything from medical care to housing to counseling to meals. There are clients who are related to or are affected by persons with HIV. Those may include family members, dependents, or roommates, who are eligible for services like housing assistance or transportation.

From the client screens, you can search for clients, create new client records, enter services for clients, and create client reports. The records also contain all of the client’s contact information and medical history.
Staff

All services are administered by staff. Staff persons include clinicians, receptionists, volunteers, administrators, and case managers.

Every staff person at your agency, whether they are full-time, part-time, or volunteer, should be added to ARIES. Once they are in the system and if you have the proper permissions you can ascribe services to clients, enter case notes for them, and so forth. The staff screens allow you to search for staff at your agency, see all their contact information, and edit their preferences and permissions.

Even if a staff person doesn’t directly use ARIES, it is important that they be included in the system. Their inclusion allows for better tracking of clients and other items.

Agencies

Agencies are organizations that administer services. All staff members are associated with an agency as are clients. Clients registered with multiple agencies can agree to share their data between agencies, which can help facilitate services. Agencies that manage other agencies are known as administrative agencies. Administrative agencies are allowed to report on the administered agency’s client and service data.

The agency screens in ARIES allow you to search for agencies, view agency addresses, manage agency contracts, and produce CADR reports. A search for agencies by services provided can be helpful if you need to find referrals for services such as housing, food banks, or transportation. Administrative agencies can also create new agency records.

ARIES Applications

ARIES has four separate components that work in conjunction with one another. ARIES is the main application where staff persons enter, search, edit, and generate reports from records. The other support components allow administrators to customize and perform maintenance on ARIES.

Not all users will have access to these other applications, but they further expand ARIES’ capabilities.

ARIESReportExport – The ARIESReportExport application allows you to define custom reports. You can also export ARIES data in a variety of formats including XML for inclusion in other applications.

ARIESImport – Use ARIESImport to bring data into ARIES from other sources. ARIESImport accepts XML files, checks them for validity, and then inserts or updates the database with the data.

ARIESAdmin – ARIESSAdmin is the administration application for ARIES. With it, you can monitor and control ARIES activity as well as customize ARIES edit screens. You can oversee users and groups, design reports, customize data entry, troubleshoot problems, and perform maintenance.
Getting Started

Your ARIES administrator will typically configure ARIES for you on your computer. To run ARIES, the minimum client system requirements are:

- Internet Explorer v6.0 or above; JavaScript and cookies must be enabled
- Windows 2000 or above
- Pentium processor
- 64 MB RAM
- 25 MB free disk space

Access to the Internet via DSL, cable modem, satellite connection, or faster that allows secure sockets layer (SSL) communication. Access with a 56 Kb modem will provide a less satisfying user experience.

You will be given a login and password by an ARIES administrator. If you choose your own password, it must include at least one number, one lower case, and one uppercase character, and must be 6-12 characters long. For instance, “rover” is not an acceptable password but “roVer82” is. You can also change your password at any time (see page 192).

As a security measure, passwords have a lifespan of six months. After six months, ARIES will prompt you to change your password.

You must also have a security certificate installed on your computer. A certificate is a small file that allows you to connect securely to ARIES using the SSL (Secured Sockets Layer) protocol. The security certificate is installed by an ARIES administrator.

Browser Settings

In order to run ARIES, your browser must be configured properly. ARIES employs cookies to maintain your login session as you navigate from screen to screen. ARIES also uses JavaScript (also known as Active Scripting) to add functionality to forms and buttons.

To ensure your browser settings are correct, in Internet Explorer select the Tools→Internet Options… menu item. Click the Security tab and click the Custom Level button, which brings up a list of options.
Scroll down to the bottom of the list and under Scripting, make sure that Active scripting is enabled.
Click the OK button and then select the Privacy tab of the Internet Options window to check your cookies settings.

Click the Advanced button and click the “Override automatic cookie handling” checkbox.
Make sure that your browser is set to accept First-party Cookies. If it is already configured to do so, you can click the Cancel button. Or select the Accept radio button and click OK.

Lastly, your computer must have the proper digital security certificate installed. Digital certificates are used as an extra layer of security to prevent ARIES from being accessed by an unauthorized computer and to encrypt data to and from the web server. This means that if you access ARIES from multiple computers, each computer must have a separate security certificate installed on it by an ARIES administrator.

Each time you first login to ARIES, you are prompted for the proper security certificate. If the proper certificate is not selected, you must close the browser window and open a new one. You will be prompted again for the correct certificate.

If your browser is not properly configured, ARIES will not allow you to login.

**Logging into ARIES**

When you are set up as an ARIES user, you will be given a URL or link that connects to the ARIES system. Bookmark this link in your browser. Do this by navigating to the link in your Internet Explorer browser and select “Add to Favorites…” from the Favorites menu.

You can then select the ARIES link from your browser’s Favorites menu. The screen will present you with two text fields: one for your login; the other for your password.

Enter both and click the login button. This takes you to the Welcome Screen if you are logging in for the first time. From the Staff Edit screen (see page 198), you can use the Home Page drop-down list to change your default home page screen.
**Welcome**

When you login for the first time, ARIES brings you to the Welcome screen. Choose a button from the bottom to be taken to that area. Clicking the Clients or Agency button takes you to their respective search screens. Clicking the Reports button takes you to the Reports screen. Clicking the My Profile button takes you to your own Staff Detail screen (see page 197).

Select the “Do not show this screen again” checkbox if you want to skip this screen when you login. ARIES will then set your home page to the Client Search screen. You can change your home page through the Staff Edit screen (see page 198).

**Menus**

On the top of every read-only screen is the ARIES menu bar. From here, you can quickly navigate to different areas of ARIES. The only time the menu bar does not appear is
when you are filling out a form that must be saved or cancelled before you proceed. When you cancel or save the form, the menu bar reappears.

The back button on the left of the menu bar allows you to navigate to previous ARIES screens. It is highly recommended that you use this button instead of your browser’s back button. The Internet Explorer history feature often causes edit locks (see page 21) if you are editing a form and you use the back button without saving or canceling. To avoid this, just use the ARIES navigation buttons.

The home button takes you to your selected home page. You can set this in your Staff Edit screen (see page 198).

The Find menu brings up the search pages for the three sections of ARIES: Client, Staff, and Agency.

The New menu allows you to create new records in ARIES. You can create new clients, staff, and service line items.

The Reports menu offers shortcuts to the reports pertaining to clients, services, finance, management, and compliance. You can also jump to the Cross Tab Wizard for simple ad hoc reports.

The Shortcuts menu contains frequently used functions of ARIES. You can jump immediately to any of these screens by selecting them from the menu.
The Help menu gives access to the help system and to a screen showing the ARIES version information.

Selecting logout will log you out of ARIES and take you back to the login screen.

### Keyboard Shortcuts

Data entry staff persons will use ARIES to enter single or multiple amounts of service data. To speed up their work, ARIES provides keyboard shortcuts.

Every edit screen has a default button in gold that responds to the Enter key. For instance, in the Staff Detail screen, the Edit button is in gold. Pressing the Enter key takes you to the Staff Edit screen.

Every edit screen includes a Cancel button, which leaves the screen without saving any changes. Use the Esc key as the keyboard shortcut for the Cancel button.

For repetitive data entry, like Service data, the screen has a Save + Another button. Pressing this button saves all the current values and brings up a new screen pre-filled with the same values. At the bottom, the values are listed in a read-only table for your reference. Say you were entering service line items for a group therapy session. After entering the first client, click Save + Another and an identical screen comes up. Enter the name of the next client in the group and click Save + Another until all the clients are entered. ARIES will not save the new record unless at least one field has changed from the previously saved record.

For direct access to specific screens the following shortcuts are available:

<table>
<thead>
<tr>
<th>Shortcut Key</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Shift “D”</td>
<td>Auto enter a time/date stamp into a text field</td>
</tr>
<tr>
<td>Ctrl+Shift &quot;S&quot;</td>
<td>Go to Client Search Screen</td>
</tr>
<tr>
<td>Ctrl+Shift “W”</td>
<td>Go to Cross Tab Wizard Screen</td>
</tr>
<tr>
<td>Ctrl+Shift “M”</td>
<td>Go to My Profile Screen</td>
</tr>
</tbody>
</table>
Ctrl+shift "E" | EIP TAB under Programs TAB
Ctrl+Shift "P" | CMP TAB under Programs TAB
Ctrl +Shift "H" | HIPP TAB under Programs TAB

**Notes:**

1) *Key only works after a client has been found.*

It is not recommended to use your browser’s back button when navigating the ARIES screens. The browser history feature often causes problems if you are editing a form and you use the back button without saving or canceling. Instead, use the ARIES back button included in the ARIES menu bar.

If the ARIES menu bar does not appear in a screen, this means you must either click the Save or Cancel button to proceed.

If you need to access help, use the F1 function key to open up the help window. The function is context sensitive, so it will bring up help pertaining to the screen you are on. If you are using a pop-up window blocker with your browser, this function may not work correctly. In this case, either disable the pop-up blocker or use the Help → Help Topics selection from the menu bar.

**Client Tab Bar**

The Client screens contain client contact information, medical history, program information, etc. Case managers and intake personnel access these screens most frequently. To help navigate through them, they are organized using tabs. Clicking a tab brings that section to the foreground.

The Client screens feature an upper tab bar, which contains all the client sections. Each section contains a lower set of tabs for more detailed screens within that section. For instance, clicking the Program tab in the upper tab bar brings up a summary of the client’s programs. The lower bar features tabs let you focus in on specific programs. So clicking the EIP tab in the lower tab bar brings up the client’s Early Intervention Program data. You can return to the previous screen by clicking the Program Summary tab.
Printing

You can print every screen in ARIES with the Internet Explorer print capabilities. For greater control over formatting and layout, you can also save the screen as HTML, import it into a word processor, reformat in the word processor, and print.

In frequently printed screens like reports, ARIES presents the option to display the screen in a printable format. The screen redisplayes without the ARIES menu bar or buttons. When you have printed the page, use the browser’s back button to restore the ARIES menu bar.

In Internet Explorer

Every screen in ARIES can be printed using your browser’s print function. For wider screens and reports, it is best to print in landscape document orientation, where the printed page is horizontal. This ensures that no data is cut off on the right hand side of the page. To print in Internet Explorer, select the File → Page Setup menu item. In the Page Setup window, select the Landscape option for document orientation. Then select File → Print to display the print dialog. Choose the printer and press Print.

Copying and Pasting into Word

To quickly incorporate ARIES data into your documents and reports, you can copy and paste directly from your browser into Microsoft Word (version 2000 or later).

Use your cursor to highlight the text you wish to copy.
From the Internet Explorer Edit menu, select “Copy.” Bring up your Microsoft Word document and select “Paste” from the Edit menu.
The ARIES information displays, retaining its formatting and table structure. You can use Word’s document tools to format your data further.

**Importing into Word**

You can also save an entire web page and import from within Microsoft Word.

From the Internet Explorer menu, select the File → Save As menu item. Save the HTML page on your computer.

Open Microsoft Word. Select the File → Open menu item and select the saved HTML page. Within Word you can modify formatting and layout as required.

When you are finished formatting, select the File → Print menu item from the Word menu.

**Sessions and Timeouts**

As a security feature, if you do not access your ARIES screen for 30 minutes, you must login again. This is done so that unauthorized users cannot access ARIES if you step away from your computer. ARIES continues to keep your session active for eight hours if you have any unsaved data.

If your ARIES screen has been inactive for longer than 30 minutes and you try to save data or navigate in ARIES, you are prompted to login again. After you enter the correct password, ARIES will return to the screen you were previously. If your inactivity has exceeded 8 hours and you try to save an unsaved form, your changes will be lost.

**Edit Locks**

When two users attempt to enter data for the same record, ARIES employs edit locks to prevent data loss. The user who accessed the record first is able to edit and save their data while the other user is not immediately able to access the record and is instead prompted with a warning.

![Edit Lock](image)

If the two users are both within the same agency, the person who encounters the edit lock is informed of the identity of the user editing the record. Also, they can override the lock and edit the record. However, if the lock is overridden and both users save their changes, edited data may be lost. It is safer to either wait until the user controlling the record is finished editing the record before entering new data.

ARIES User Manual 21
If the record is being edited by a user at another agency – for instance, if the record is for a client who has agreed to share their data between agencies – then the user who encounters the edit lock does not have the option of overriding a lock. Also, they will not know the identity of the user currently editing the record.

If you are editing a record and exit the screen without saving or using the Cancel button – i.e., you use the browser back button or close the browser window – then the record will remain open and locked until you access the record again and save it. The record will remain locked to others until your session expires after 8 hours. To minimize edit locks, it is highly recommended to not use the browser back button. Instead use the ARIES menu bar back button or if you are editing a record, click the Cancel or Save button to exit the screen.

2. Clients

Clients are individuals who receive services from your agency. These services can be anything from medical care to housing to counseling to meals. There are clients who are related to or are affected by persons with HIV. Those may include family members, dependents, or roommates, who are eligible for services like housing assistance or transportation.

Each client is recorded into the ARIES system by intake personnel as part of the client enrollment process. Their client records contain contact information, demographics, medical information, and services information.

Case managers and intake personnel verify service eligibility of clients and then provide services, create care plans, enter case notes and make referrals for them. Clinicians use the client records to enter and approve treatment plans. Agency managers use client records to create reports for budgeting, tracking of costs and services, and grant writing.

Client records are also accessed by data users who will use the information for program evaluation, planning, aggregate reporting, and data analysis.

A client may give permission to share their data with other agencies. The benefit to the client is that they do not have to go through the intake process at each agency where they wish to access services. Furthermore, the staff at each agency gets a better overall view of the client’s case and is thus able to provide the most appropriate services.

Since many staff persons access client records, it is important that all information entered is detailed and correct. If incorrect information is entered, reports will be affected, and most importantly, clients may not receive the services they need.

The most common tasks in working with clients include:
Looking Up a Client
Creating a New Client
Recording a Service for a Client

The client screens include:
Client Search
Client Search Results
Creating Clients
Demographics
Eligibility
Programs
Medical
Medications
Risk & Assessments
Care Plan
Case Notes
Services

Working with Clients in ARIES

The most common tasks in working with clients include:
Looking Up a Client
Creating a New Client
Recording a Service for a Client

Looking up a client

1. From the ARIES menu bar (see page 15) at the top of the ARIES screen, choose the Find → Client menu item to get to the Client Search screen.
2. From this screen, you can search the client list of your agency. You limit the search results by using filters for name, agency client ID, social security number, and date of birth.

3. To perform a quick search, enter the client’s last name in the top text field and click the Search button. If the last name isn’t available, try the client’s first name. Do not use initials, i.e., “Mary J.” If you are unsure of the spelling of a name, you can try using the wildcard “*.” For instance, if you enter, “Mac*” in the last name field, the search will return all last names and all Also Known As field names that begin with “Mac.”

4. You can also search by entering any of the client’s identification numbers in the Agency Client ID text field. Agency client IDs are unique identifiers assigned by your agency or by programs.

5. You can specify the number of results to return on your search. The more results you ask for, the longer the search takes. The default is set at 20, which is about what will fill the results screen. You can always easily increase the number displayed in the search results screen.

6. Click the search button, and results appear in the Client Search Results screen. If only one client matches your search criteria, ARIES takes you directly to that individual’s Contact Information screen. If no clients match, then the Client Search screen redisplays, giving you an opportunity to broaden your search.

7. Selecting the Search Related/Affected Individuals checkbox broadens your search to include clients who are HIV negative as well as those with unknown HIV status. An affected client can be a family member or partner but must be linked to an infected client who is receiving services.
If you are having trouble finding a client, try reducing your search criteria. You may search for any client registered at your agency. If you are at an administrative agency, you may search for clients at all the agencies you administer.

Creating a new client

When creating a new client, be careful not to enter duplicate client records. ARIES helps you avoid this by first asking you to search for the individual in the system before you create a new record for them.

1. From the ARIES menu bar (see page 15) at the top of the ARIES screen, choose the New → Client menu item, which takes you to the Client Search screen (see page 34). Here, you start with a quick search to make sure the client has not already enrolled at your agency.

   **Client Search**

   To find a client, or to check if a client is new to your agency, enter in some or all of the following information. You may use the wildcard *.

   - **Last Name**: Porter
   - **First Name**:
   - **Middle Initial**:
   - **Agency Client ID**:
   - **SSN**: 123-45-6789
   - **Date of Birth**: 09/27/1968
   - **Display**: 20 results
   - **Search Related/Affected Individuals**

2. Enter the client’s information in the appropriate text fields. Start with just the client’s last name. This will catch any records for the client where they might have used a nickname or slightly different details. For a more specific search, you can fill in more details like first name and middle initial. For Social Security Number (SSN), enter it using the following format: 123-45-6789. For “Date of Birth,” use the following format: MM/DD/YYYY. For example, for September 27, 1968, enter, “9/27/1968.”

3. With the Display text field, you can specify the number of results to return on your search. The more results you ask for, the longer the search will take. The default is set at 20, which is about what will fill the results screen. You can always narrow your search or increase your search results later.

4. Selecting the Search Related/Affected Individuals checkbox broadens your search to include clients who are HIV negative as well as those with unknown HIV.
status. An affected client can be a family member or partner but must be linked to an infected client who is receiving services.

5. Click the Search button. If multiple matches are found, you are taken to the Client Search Result screen (see page 36), which lists all clients who match your search. If the new client is not listed, click the Create New Client button at the bottom of the list. If you do not see the button, you may not have the proper permissions to create new clients.

6. If there is a single match for your search, you are taken to their Client Contact Information screen. If the record does not match the new client, start the client search again with more detailed information.

7. If there are no matches for your search, then the Client Search screen redisplays with a suggestion to broaden your search, as well as a Create New Client button at the bottom. If you only searched using the client’s last name, and you are sure it is correct, then you know that the client has not visited your agency before. Click the Create New Client button to search the records of other agencies and create a new record if the client isn’t found.

8. ARIES clients can receive services from multiple agencies. If a particular client is new to your agency, but has received services from another agency, ARIES alerts you that a record for them already exists. If the client has agreed to share their data between agencies, your agency will share access to the client’s record and you do not need to make a new client entry.

9. If the client has a record at another agency and they have chosen not to share their information between agencies, you are alerted. Explain to the client that a record for them already exists in the system with another agency. If they choose to, they...
can sign a release and a staff person with the proper permissions can enable their record to be shared with your agency. If the client chooses to keep separate, private records at each agency, you must create a new record for them.

### New Client

To check if this client may already be registered in ARIES, please accurately enter the following data:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>Porter</td>
</tr>
<tr>
<td>First Name</td>
<td>John</td>
</tr>
<tr>
<td>Middle Initial</td>
<td>A</td>
</tr>
<tr>
<td>Mother's Maiden Name</td>
<td>Jones</td>
</tr>
<tr>
<td>Date of Birth</td>
<td>09/27/1968</td>
</tr>
<tr>
<td>Gender</td>
<td>Male</td>
</tr>
</tbody>
</table>

10. In the New Client screen, ARIES matches the client’s personal details against existing records to prevent any duplicates. Enter in the client’s last name, first name, middle initial, mother’s maiden name, and date of birth in the corresponding text fields. You must be precise with this information to prevent duplicate records. Avoid using nicknames. If the client has no middle name, leave the Middle Initial field blank. For date of birth, use the format: MM/DD/YYYY. So for September 27, 1968, enter “9/27/1968.”

11. Use the drop-down list to choose the appropriate gender. In addition to male and female, a client may be transgender MTF (male-to-female) or transgender FTM (female-to-male). A client may also be listed as “Other,” “Unknown,” or “Refused to Report.”
12. When you click the Search button, ARIES checks all clients for an exact match. If the search yields an exact match, and the client has agreed to share their data, then you will be taken to the Client Contact Information screen. If no match is found, ARIES will prompt you to double check your information for accuracy. This is done to avoid multiple records for a client. Press the Tab key through each text field and ensure that all the client’s information has been entered properly and is correctly spelled.

13. If you tab through each field and all the information is correct, the Search button becomes a Create button. Before you click this button, explain to the client that if
they choose, their record can be shared with other agencies. This helps expedite the intake process at other agencies. Ask them to review and sign the release allowing their record to be shared. If they agree to share their data and sign the release, select the “Client agrees to share data” checkbox.

14. Click the Create button to save the client record and start the intake process with the Client Contact Information Edit screen (see page 43).

**Recording a service for a client**

Agencies provide services for clients. Services can include medical consultations, meals, housing assistance, psychological counseling, transportation, medication, and case management. ARIES manages and tracks services to help automate budgeting, create reports, and provide quality care for clients.

Each service must be entered as a separate service line item. This is done to track individual services for reporting purposes. Wherever possible, ARIES pre-fills text fields to make data entry quick and simple.

Staff persons enter new service line items after a client’s eligibility for services has been verified and the client has been entered into the ARIES system. Staff who enter service line items include intake personnel, case managers, support services providers, and data entry personnel.

1. There are two ways to enter new service line items. From the ARIES menu bar (see page 15) at the top of the ARIES screen, choose the New → Service menu item to get to the Services screen. You can also perform a Client Search (see page 34) to access the Client Details screen. Select the Service tab on the far right of the client tabs. This brings up the client’s Services screen, which lists all the client’s service line items. Clicking the New button brings up the New Service screen pre-filled with the client’s name. You’ll find that this approach may be more helpful, as the new service line item is automatically associated with the client.
2. On the upper left of the service screen is the client identifier drop-down list. If the client’s name isn’t already pre-filled, use the drop-down list to choose how you want to identify the client. Client name (first and last name) is most common identifier, but you can also use an agency-specific client ID or program client ID. If you use the client’s name, do not enter their middle initial. Enter the corresponding name or ID in the text field. If you have accessed the screen through a client record, the client’s name will be entered by default.

3. From the Staff drop-down list, select the staff person responsible for the service. Your name is the pre-selected choice, but if you are entering data on behalf of someone else, select the name of the person providing the service.

4. If your agency has multiple sites, use the Site drop-down list to select the location where the service was provided.
5. Enter the date the service was administered using the format: MM/DD/YYYY. So for June 22, 2005 you would enter 6/22/2005. You can also use the pop-up calendar by clicking the calendar icon. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes. If the service spans over multiple days – for instance, a hospital stay or daily transportation – enter the start date of the service.

6. The Days to Next Service text fields indicate when the client should receive their next service. For instance, if the client needs a follow up visit after three months, enter 90 in the first text field and the date is calculated into the Date field. Likewise, if you enter the date, the number of days is calculated. The days to next service can be used as a reminder or to-do item for this client.

7. Enter the service type by using the Program, Contract Name, and Services drop-down lists. Your choice from one drop-down list filters what will be in the other drop-down lists. For instance, if a client is eligible for services under your agency’s Medicare contract, select the Medicare contract from the “Contract Name” drop-down list. Only the services available under that contract will be available in the service drop-down lists.

8. Services are organized in four tiers – program, primary service, secondary service, and agency subservice. The drop-down selection you choose at one tier fills in the
available services at lower tiers. For instance, if you wish to see what mental health services your agency provides, choose “Mental Health Services” from the Primary Service drop-down list. The Secondary Service drop-down will list only the mental health services your agency provides. Choosing a secondary service fills the Agency Subservice drop-down with the specialized subservices your agency offers. Again, only those services specified in the contract setup display.

9. Also, if you choose a service, ARIES selects the corresponding contracts that fund that service. For example, if you choose the secondary service “Speech Therapy,” ARIES lists which contracts cover that service in the “Contract Name” drop-down. If there are multiple contracts listed, make sure that you choose the contract under which the service is to be reimbursed.

10. If the service line item is medication, the HRSA Drug Code drop-down list appears in the form. Select the code that corresponds to the client’s medication. Each line in the drop-down lists the medication’s brand name, generic name, and HRSA drug code.

11. When you enter the service type, the Units of Service fields fill in the default values defined by the contract. However, you can change the costs and unit quantities. For instance, an intake, which is measured in quarter hour visits, may normally take 3 hours, or 12 units. When you choose the subservice of intake, the units defaults to 12. However, if you have a particularly lengthy intake that takes four hours, you would replace the “12” with “16.” The total recalculates in the Total text field. Some services are not calculated by units of service. For example, one-way trips might be reimbursed by mileage. The unit of service is 1 but a one-way trip could be several miles. In such cases, leave the cost text field empty and enter the actual cost of the service in the Total text field. For medication, the unit of service is by prescription – a 100-pill prescription is still one unit of service, so enter the cost of the medication in the Total field.

12. In the Client Payment field, enter the actual dollar amount paid by the client if applicable. In the CARE/HIPP Co-Payment field, enter the amount of the co-payment paid for the CARE/HIPP service.

13. For certain services, like temporary housing or meals, the Daily Service End Date text field will appear. This makes it easy to enter a number of identical service records over consecutive days. Enter in the last date the service will be provided. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.” When you save the service line item, ARIES creates a separate record for every day of service. For instance, if a client is to receive
meals from 7/14/2005 through 7/21/2005, ARIES creates 8 service line items for
every day the client receives meals. Make sure that the time span of the service
does not extend beyond the end of a contract. For example, if a client is approved
to receive 20 days of hotel stay starting on December 27, 2005 and the contract
for that service expired at the end of the year, enter 12/31/2005 in the Daily
Service End Date text field. Then enter a new service line item for the hotel stay
starting on 1/01/2006 and ending 1/15/2006 under the renewed contract.

14. In the Actual Minutes Spent text field, enter the amount of time used for an
appointment. For instance, if a consultation lasted 35 minutes – even if it was
scheduled for an hour – enter “35.” This does not affect the reimbursement
process but is used for internal reports and scheduling.

15. Use the Service Notes text box to enter any other details pertaining to the service
line item, including any additional payment sources.

16. Select the Finalize checkbox to prevent the record from being edited further once
saved.

17. Click the Save + Done button to return to the client’s Services screen. Click the
Save + Another button to enter additional service line items. A new screen
appears filled out identically to the one you just saved. This can be a time saver if
you are entering multiple service line items for a client or if multiple clients
receive the same service. Say you were entering clients for a group therapy
session. After entering the first client, click Save + Another and an identical
screen comes up. Enter the name of the next client in the group and click Save +
Another until all the clients are entered. ARIES will not save the new record
unless at least one field has changed from the previously saved record. Clicking
the cancel button takes you back to the client’s services list without saving any information entered.

**Client Screens**

The client screens are accessed by a wide range of staff persons. Data entry staff enter in new client and service information, clinicians access medical data, and case managers enter in needs assessments and case notes.

Because client records are shared amongst many staff persons, it is extremely important to ensure that the information you enter is precise and detailed.

The client screens include:

- [Client Search](#)
- [Client Search Results](#)
- [Creating Clients](#)
- [Demographics](#)
- [Eligibility](#)
- [Programs](#)
- [Medical](#)
- [Medications](#)
- [Risk & Assessment](#)
- [Care Plan](#)
- [Case Notes](#)
- [Services](#)

**Client Search**

From the ARIES menu bar (see page 15) at the top of the ARIES screen, choose the Find → Client menu item to get to the Client Search screen.
From this screen, you can search the client list of your agency. You limit the search results by using filters for name, agency client ID, social security number, and date of birth.

To perform a quick search, enter the client’s last name in the top text field and click the Search button. If the last name isn’t available, try the client’s first name. Do not use initials, i.e., “Mary J.” If you are unsure of the spelling of a name, you can try using the wildcard “*.” For instance, if you enter, “Mac*” in the last name field, the search will return all last names and all Also Known As field names that begin with “Mac.”

You can also search by entering any of the client’s identification numbers in the Agency Client ID text field. Agency client IDs are unique identifiers assigned by your agency or by programs.

You can specify the number of results to return on your search. The more results you ask for, the longer the search takes. The default is set at 20, which is about what will fill the results screen. You can always easily increase the number displayed in the search results screen.

Click the search button, and results appear in the Client Search Results screen. If only one client matches your search criteria, ARIES takes you directly to that individual’s Contact Information screen. If no clients match, then the Client Search screen redisplays, giving you an opportunity to broaden your search.

Selecting the Search Related/Affected Individuals checkbox broadens your search to include clients who are HIV negative as well as those with unknown HIV status. An affected client can be a family member or partner but must be linked to an infected client who is receiving services.
If you are having trouble finding a client, try reducing your search criteria. You may search for any client registered at your agency. If you are at an administrative agency, you may search for clients at all the agencies you administer.

Client Search Results

When you click the Search button on the Client Search screen, ARIES looks up all the clients who match all your criteria and then displays them on the Client Search Result screen. If there is only a single result for your search, you will be taken to the Contact Information screen.

<table>
<thead>
<tr>
<th>Name</th>
<th>ID</th>
<th>SSN</th>
<th>DOB</th>
<th>Gender</th>
<th>Status</th>
<th>Agency Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abara, Anthony</td>
<td>2/3/1965</td>
<td>Male</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Acalotto, Benjamin</td>
<td>7/29/1955</td>
<td>Male</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adair, Beryl</td>
<td>10/24/1971</td>
<td>Female</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adams, Bryan</td>
<td>10/24/1956</td>
<td>Male</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adamson, Charie</td>
<td>5/2/1954</td>
<td>Female</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agazzi, Carissa</td>
<td>11/26/1969</td>
<td>Female</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Abert, Dory</td>
<td>2/26/1935</td>
<td>Female</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alameda, Emma</td>
<td>4/6/1971</td>
<td>Female</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alamo, Fuller</td>
<td>2/10/1956</td>
<td>Male</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allodi, Faron</td>
<td>5/30/1948</td>
<td>Male</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alani, Kevin</td>
<td>3/17/1970</td>
<td>Male</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amancin, Martin</td>
<td>11/8/1963</td>
<td>Male</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amato, Mary</td>
<td>2/24/1964</td>
<td>Female</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Anacapa, Polly</td>
<td>5/12/1961</td>
<td>Female</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Anamapu, Paul</td>
<td>12/25/1969</td>
<td>Male</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Anastasio, Randall</td>
<td>9/15/1950</td>
<td>Male</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Araki, Raul</td>
<td>5/10/1966</td>
<td>Male</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arenda, Salvador</td>
<td>6/7/1950</td>
<td>Male</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Aratuinian, Samuel</td>
<td>7/13/1953</td>
<td>Male</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Araujo, Timothy</td>
<td>12/18/1954</td>
<td>Male</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

20 records displayed

Your search results are listed in a table alphabetically by client name. Also listed in columns is the client’s agency ID number (if applicable), social security number, date of birth, gender, status and agency contact.

Clicking on a client name takes you to that individual’s Contact Information screen (see page 42).
If your search didn't show the client you were looking for, you can increase the number of results displayed by entering a new number in the text field and clicking the Display button.

If you still can’t find the client you are searching for, try a new search using fewer criteria (try using the last name only). To create a new client, click the New Client button to enter a new client, which will take you to the Client Search screen.

**Creating Clients**

When creating a new client, be careful not to enter duplicate client records. ARIES helps you avoid this by first asking you to search for the individual in the system before you create a new record for them.

From the ARIES menu bar (see page 15) at the top of the ARIES screen, choose the New → Client menu item, which takes you to the Client Search screen (see page 34). Here, you start with a quick search to make sure the client has not already enrolled at your agency.

```
To find a client, or to check if a client is new to your agency, enter some or all of the following information. You may use the wildcard *.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>Porter</td>
</tr>
<tr>
<td>First Name</td>
<td></td>
</tr>
<tr>
<td>Middle Initial</td>
<td></td>
</tr>
<tr>
<td>Agency Client ID</td>
<td></td>
</tr>
<tr>
<td>SSN</td>
<td>123-45-6789</td>
</tr>
<tr>
<td>Date of Birth</td>
<td>mm/dd/yyyy</td>
</tr>
<tr>
<td>Display</td>
<td>20 results</td>
</tr>
</tbody>
</table>

Enter the client’s information in the appropriate text fields. Start with just the client’s last name. This will catch any records for the client where a nickname or slightly different details were used. For a more specific search, you can fill in more details like first name and middle initial. For Social Security Number (SSN), enter it using the following format: 123-45-6789. For “Date of Birth,” use the following format: MM/DD/YYYY. For example, for September 27, 1968, enter, “9/27/1968.”

With the Display text field, you can specify the number of results to return on your search. The more results you ask for, the longer the search will take. The default is set at 20, which is about what will fill the results screen. You can always narrow your search or increase your search results later.

ARIES User Manual 37
Selecting the Search Related/Affected Individuals checkbox broadens your search to include clients who are HIV negative as well as those with unknown HIV status. An affected client can be a family member or partner but must be linked to an infected client who is receiving services.

Click the Search button. If multiple matches are found, you are taken to the Client Search Result screen (see page 36), which lists all clients who match your search. If the new client is not listed, click the “Create New Client” button at the bottom of the list.

If there is a single match for your search, you are taken to their Client Contact Information screen. If the record does not match the new client, start the client search again with more detailed information.

If there are no matches for your search, then the Client Search screen redisplayes with a suggestion to broaden your search, as well as a Create New Client button at the bottom. If you only searched using the client’s last name, and you are sure it is correct, then you know that the client has not visited your agency before. Click the Create New Client button to search the records of other agencies and create a new record if the client isn’t found.

Clients can receive services from multiple agencies. If a particular client is new to your agency, but has received services from another agency, ARIES alerts you that a record for them already exists. If the client has agreed to share their data between agencies, your agency will share access to the client’s record and you do not need to make a new client entry.

If the client has a record at another agency and they have chosen to not share their information between agencies, you are alerted. Explain to the client that a record for them already exists in the system with another agency. If they choose to, they can sign a release and a staff person with the proper permissions can enable their record to be shared with your agency. If the client chooses to keep their record private from your agency, you must create a new record for them.
In the New Client screen, ARIES matches the client’s personal details against existing records to prevent any duplicates. Enter in the client’s last name, first name, middle initial, mother’s maiden name, and date of birth in the corresponding text fields. You must be precise with this information to prevent duplicate records. Avoid using nicknames. If the client has no middle name, leave the Middle Initial field blank. For date of birth, use the format: MM/DD/YYYY. So for September 27, 1968, enter “9/27/1968.”

Use the drop-down list to choose the appropriate gender. In addition to male and female, a client may be transgender MTF (male-to-female) or transgender FTM (female-to-male). A client may also be listed as “Other,” “Unknown,” or “Refused to Report.”
When you click the Search button, the system checks all the ARIES clients for an exact match. If the search yields an exact match, and the client has agreed to share their data, then you will be taken to the client’s Client Contact Information screen. If no match is found, ARIES will prompt you to double check your information for accuracy. Tab through each text field and ensure that all the client’s information has been entered properly and is correctly spelled.

If you tab through each field without making any changes the Search button becomes a Create button. Before you click this button, explain to the client that if they choose, their record can be shared with other agencies. This helps expedite the intake process at other
agencies. Ask them to review and sign the release allowing their record to be shared. If they agree to share their data and sign the release, select the “Client agrees to share data” checkbox.

Click the Create button to save the client record and start the intake process with the Client Contact Information Edit screen (see page 43).

Client Details

Client information can be navigated through the screen tabs. The top tabs correspond to the various sections of a client’s record:

Demographics
Eligibility
Programs
Medical
Medications
Risk & Assessments
Care Plan
Case Notes
Services

Demographics

The Client Demographics screens contain the client’s residential and personal information. This information is valuable as it contains important contact and assistance details. It is also valuable as there are programs available for specific demographic groups. Having a full demographic overview could avail a client of these programs. Lastly, for data collectors and researchers, aggregate demographics can help enhance the quality and efficiency of services to clients.

John A Porter

If there is a yellow caution icon, next to a client’s name, this signifies that a client alert has been entered. Clicking on the icon will open an alert box with message details, who entered the information, and when it was recorded. These alerts contain important details about dealing with the client, for instance if they have sensitive health problems or behavioral issues.
The demographics screens include a second tier of navigational tabs. Use these tabs to jump to each section’s screen. The demographics screens include:

- **Contact Information**
- **Demographic Detail**
- **Living Situation**
- **HOPWA**
- **Agency Specifics**

**Contact Information**

When you access a client’s demographic details, the first screen that displays is the Contact Information screen. This screen contains phone numbers, current and previous addresses, email address, and emergency contact information, as well as the client’s contact preferences.

![Contact Information Screen](image)

Please be aware of any notes next to the contact phone numbers:

- **Do not call** – do not use this phone number under any circumstances
- **No messages** – if the client or contact is not available, do not leave a message of any kind
- **Be confidential** – do not use the agency name or leave any HIV-related information in a message or on an answering machine
If the client chooses to be contacted by mail, use the mailing address given. “Stay confidential” means that the client wants no reference to the agency on the envelope.

If the emergency contact contains the note, “Confidential,” this means that the agency should only speak to the individual listed as the contact. “No messages” means that if the emergency contact is not available, do not leave a message of any kind.

If you have the proper permissions, click the Edit button to change any contact information.

**Contact Information Edit**

In this screen, you can edit phone numbers, addresses and emergency contact information for the client. The top portion of the screen contains a table of all the address fields.

Under Residence, enter the date the client began living at their current residence. Use the following format: MM/DD/YYYY. For instance, February 1, 2005 would be “2/1/2005.” You can also use the pop-up calendar.
Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the Since text field. The calendar window automatically closes.

In the Street, City, and State, enter the client’s current residential address. In the Zip field, enter the client’s five-digit zip code.

If the client lives in California, use the County drop-down list to select which county they live in. Outside of California, leave this selection blank.

If the client lives in Texas, use the “Geog Area HSDA” to select the client’s corresponding Health Service Delivery Area. Outside of Texas, leave this selection blank.

Under the Mailing heading, select the “Same as Residence” checkbox if the client’s mail is delivered to their residential address. ARIES will automatically populate the mailing address fields with the residence address. Otherwise, enter their mailing address in the appropriate fields. Select which county or HSDA the address is in.

Under Previous, enter the date the client first began living at their previous residence. Use the following format: MM/DD/YYYY. For instance, December 15, 1992 would be “12/15/1992.” You can also click the calendar icon to bring up the pop-up calendar.

Enter the client’s previous address in the appropriate fields. Select which county or HSDA the address is in.

Under Emergency, enter the name of the client’s emergency contact. Enter the contact’s address and telephone number. For telephone number, use hyphens, e.g. 650-555-1212.
From the Confid drop-down list, select “Yes” if the client wants emergency calls to be confidential. This means the client does not want your agency’s name in a message or on the contact’s answering machine. Otherwise, select “No.”

If the client does not want any messages left for the contact, select “No” under Msgs OK.

On the left, use the drop-down lists to select the client’s mail preferences. If the client agrees to receive mail, select “Yes.” If the client wants mail delivered in envelopes with no agency references, select “Yes” next to “Should mail be confidential?”

Enter any additional contact information or any other details in the Note text box to the right.

The lower portion of the Contact Info Edit screen contains a table of fields for phone and email information.

In Phone 1, enter the client’s primary phone number. Use hyphens including area code, e.g., “650-555-1212.”

To the right, under Phone Type, use the drop-down list to indicate which type of phone number this is: home, work, mobile, fax, etc. If the client has a voicemail box or messaging service, select “Message.” Select “TTY” if the phone number is for a telephone typewriter for the hearing impaired.

Under Allow Contact, select “Yes,” if the client agrees to allow the agency to contact them using this number. Under Confid, select “Yes” if the client does not want your agency’s name in a message or on the client’s answering machine. If the client does not want any phone messages left at all, select “No” under Msgs OK.

Next to Phone 2, enter a second phone number, if available. Select whether the client wishes to allow calls, messages, and whether they want messages to be confidential.
In the third row, enter the client’s email address, if available. Select whether the client wishes to allow emails from the Allow Contact drop-down list. Under Confid, select “Yes” if the client does not want your agency’s name in the message. If the client has agreed to accept emails, select “Yes” under Msgs OK.

If you are finished entering contact information, click the Save + Next button at the bottom to proceed to the Demographics Edit screen. If you have no more changes, click the Save + Done button. Click the Cancel button to return to the Contact Info screen without saving any changes.

Demographic Detail

The Demographic Detail screen contains personal information about the client including gender, race, education, and marital status. To access this screen, from the Client Detail screen, click the Demographic Detail tab in the second row of tabs.

The client’s demographic details include:

Client Identifiers
Demographics
Client Identifiers

The client identifiers screen lists the client’s gender, birth date, and age.

To edit or change any information, click the Edit button, which takes you to the Identifiers Edit screen.

Identifiers Edit

In the Identifiers Edit screen you can edit a client’s name, mother’s maiden name, date of birth, and gender, which, collectively are used as a unique identifier for the client known as the extended URN (Unique Record Number).

The ARIES URN is composed of the first and third characters of the client’s first and last name, their middle initial, the first and third characters of the client’s mother’s maiden name, their date of birth, and gender.

If you wish to edit the client’s name, enter their last name in the first text field and their first name in the second field. Avoid using nicknames or initials. In the Middle Initial text field, enter the client’s middle initial only – do not enter a period. If the client does not have a middle name, leave the field empty.

For security reasons, Mother's Maiden Name does not display, even though it was previously entered and saved. If you leave this entry blank, ARIES maintains the previously entered mother’s maiden name. You only need to enter Mother's Maiden Name on this screen if you have reason to believe that the original information was incorrect.
For date of birth, use the format: MM/DD/YYYY. So for September 27, 1968, enter, “9/27/68.”

Use the drop-down list to choose the client’s gender. In addition to male and female, a client may be transgender MTF (male-to-female) or transgender FTM (female-to-male). A client may also be listed as “Other,” “Unknown,” or “Refused to Report.”

When you are finished making changes, click the Save button to return to the Demographic Detail screen or click Cancel to return without saving any changes.

Demographics

The client demographics include background information about the client. This information is used to help administer services and is also used in aggregate reporting.

<table>
<thead>
<tr>
<th>AKA</th>
<th>Also known as. Any alias used by the client.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSN</td>
<td>The client’s social security number.</td>
</tr>
<tr>
<td>Hispanic</td>
<td>Indicates if the client is Hispanic, and if so, their national origin.</td>
</tr>
<tr>
<td>Race</td>
<td>If the client is not Hispanic, the client’s race and nationality; up to three are listed.</td>
</tr>
<tr>
<td>Marital Status</td>
<td>Clients are listed as: single, married, in domestic partnership, divorced, separated, or widowed.</td>
</tr>
</tbody>
</table>
### Demographics Edit

The Demographics Edit screen displays a form for the client’s personal information.

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sexual Orientation</td>
<td>Clients are listed as: heterosexual, homosexual, lesbian, bisexual, or unsure. They may also be listed as “Declines to State” or “Unknown.” Clients under 13-years of age are listed as “Pediatric/Not Applicable.”</td>
</tr>
<tr>
<td>Education</td>
<td>The highest level of education completed by the client.</td>
</tr>
<tr>
<td>Veteran</td>
<td>Indicates if the client is a military veteran.</td>
</tr>
<tr>
<td>Primary language</td>
<td>The primary language spoken by the client.</td>
</tr>
<tr>
<td>Secondary language</td>
<td>Any other language used by the client.</td>
</tr>
<tr>
<td>Place of Death</td>
<td>If the client is deceased, where the client died. The date of death is also listed.</td>
</tr>
<tr>
<td>Special Needs</td>
<td>Lists the client’s physical disabilities, if any.</td>
</tr>
<tr>
<td>Notes</td>
<td>Any additional demographic information about the clients.</td>
</tr>
</tbody>
</table>

To change or add any demographics information, click the Edit button.
The demographic fields include:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AKA</td>
<td>Also known as. List any alias or nickname used by the client.</td>
</tr>
<tr>
<td>Hispanic</td>
<td>Use the drop-down list to indicate whether the client is Hispanic or not. If “Yes”, select the client’s nationality “Nat’l Orig/Ethnic.” drop-down list to the right. For instance, if the client’s family originated from Ecuador, select “South American.” For mixed race, select the option that most closely matches the client. Enter additional race(s) in the Race fields below.</td>
</tr>
<tr>
<td><strong>Race</strong></td>
<td>If the client is not Hispanic, list the client’s race from the drop-down list. Also list the client’s ethnicity or nationality from the “Nat’l Orig/Ethnic.” drop-down list to the right. For instance, if the client is ethnically Iranian, select “White” from the ethnicity drop-down list. If the client is multi-racial, list all races using the second and third lines. If the client is of more than three races, list the three primary races. If the client is Hispanic, select “Other.” If the client is of mixed race including Hispanic, indicate the client’s Hispanic ethnicity above and select their other race(s) here.</td>
</tr>
<tr>
<td><strong>SSN</strong></td>
<td>Enter the client’s Social Security Number (SSN). Use the following format: 123-45-6789.</td>
</tr>
<tr>
<td><strong>Marital Status</strong></td>
<td>Select the client’s marital status: single, married, domestic partnership, divorced, separated, or widowed. The definition of a domestic partnership is where two persons live together and are in a personal relationship, but they are not married.</td>
</tr>
<tr>
<td><strong>Sexual Orientation</strong></td>
<td>List the client’s sexual orientation as: heterosexual, homosexual, lesbian, bisexual, or unsure. They may also be listed as “Declines to State” or “Unknown.” List clients under 13-years of age as “Pediatric/Not Applicable.”</td>
</tr>
<tr>
<td><strong>Primary Language</strong></td>
<td>List the client’s primary spoken language. If the client’s primary language is not listed, select “Other” and indicate which language is spoken in the Notes text box.</td>
</tr>
<tr>
<td><strong>Secondary language</strong></td>
<td>If the client speaks a second language, select it from the drop-down list. For instance, if the client primarily speaks Tagalog, but can also speak English, select “English.” If the client’s language is not listed, select “Other” and indicate which language is spoken in the Notes text box.</td>
</tr>
<tr>
<td><strong>Place of Death</strong></td>
<td>If the client is deceased, use the drop-down list to indicate where the client died: home, hospital, nursing facility, or residence hospice (Residential Care Facility for the Chronically Ill). If the client died elsewhere, select “Other” and indicate the location in the text field below.</td>
</tr>
<tr>
<td><strong>Date of Death</strong></td>
<td>If the client is deceased, indicate the date in this text field. Use the format: MM/DD/YYYY. For instance, for March 30, 2004, enter, “3/30/2004.”</td>
</tr>
</tbody>
</table>
Education Level | Select the highest level of education completed by the client from the drop-down list. For example, if the client completed college, select “College degree” or if the client did not complete high school but passed an equivalency exam, select “High school diploma/GED.”

Veteran | Use the drop-down list to indicate if the client is a military veteran or not.

Special Needs | Use this drop-down list to indicate any physical disabilities the client has. For instance, if the client requires a walker, select “Mobility.” If the client has multiple disabilities, select “More than one” and indicate which ones in the Notes text box.

Notes | Use this text box to enter any pertinent demographics details not listed elsewhere including primary and secondary languages not listed in the drop-down list or any additional special needs the client might have.

If you are finished entering demographics information, click the Save + Next button to proceed to Living Situation Edit. If you have no other client details to edit, click Save + Done to return to the Demographics screen. To return to the Demographics screen without saving any changes, click Cancel.

**Living Situation**

The Living Situation screen includes current housing information of the client. To access this screen, from the Client Detail screen, click the Demographics Tab and select the Living Situation tab in the second row of tabs.
The Living Situation information includes:

<table>
<thead>
<tr>
<th>Current Living Situation</th>
<th>The type of residence the client is living in and how long they have been there.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Has signed lease/title/tax receipt</td>
<td>If the client owns or rents, this indicates whether they have shown documents confirming this.</td>
</tr>
<tr>
<td>Living situation in last 12 months</td>
<td>This lists the client’s living situations for the previous 12 months.</td>
</tr>
<tr>
<td>Housing assistance</td>
<td>This indicates whether the client is receiving housing assistance. If the client is receiving HUD (Department of Housing and Urban Development) aid, also listed is the date the client applied for assistance.</td>
</tr>
</tbody>
</table>

To change or add living situation information, click the Edit button.

**Living Situation Edit**

In this screen, you can enter or edit the client’s living situation information.
The Living Situation fields include:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Living Situation since</td>
<td>In the dropdown list underneath the date, select the client’s current living situation. If the client’s situation is not listed, select “Other.”</td>
</tr>
<tr>
<td></td>
<td>In the text field, enter the date the client first began living in their current situation using the format: MM/DD/YYYY. For instance, if the client moved into their current apartment on June 22, 2003 you would enter 6/22/2003. You can also use the pop-up calendar by clicking the calendar icon. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.</td>
</tr>
<tr>
<td>Has signed lease/title/tax receipt</td>
<td>If the client owns or rents their residence, use the drop-down list to indicate whether they have shown documents confirming this. They must present a signed lease, a title document, or a property tax receipt.</td>
</tr>
<tr>
<td>Housing assistance</td>
<td>If the client is receiving housing assistance, indicate which kind from this drop-down list.</td>
</tr>
</tbody>
</table>
HUD Application Date

If the client is receiving HUD (Department of Housing and Urban Development) assistance, indicate when the client first applied for assistance. Use the format: MM/DD/YYYY. So if the client applied for HUD Shelter & Care assistance on June 22, 2003, you would enter 6/22/2003. You can also use the pop-up calendar by clicking the calendar icon. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

Living situation in last 12 months

This lists all the client’s living situations for the previous 12 months. Select all that apply. For instance, if the client was homeless for a month before finding transitional housing, select “Homeless from the streets” and “Transitional housing.” Include their current living situation.

When you are finished entering new information, click the Save + Next button to proceed to the HOPWA Edit screen. If you have no further changes, click the Save + Done button to return to the Living Situation screen. If you wish to return to the Living Situation screen without saving any changes, click Cancel.

**Related/Affected Individuals**

This lists other clients associated with the client who are HIV negative as well as those with unknown HIV status. An affected client can be a family member or partner but must be linked to an infected client who is receiving services. Affected clients may be eligible for services like housing assistance or transportation.

For instance, if the client is an HIV+ mother, her children may be eligible for services like meals or daycare.

Related or affected individuals have their own separate client records. Clicking on an individual’s name takes you to their client record.

To add a related or affected individual, click the New button, which takes you to the Related/Affected Individuals Edit screen. To edit the relationship between the client and the affected individual, click the Edit Relationship button next to their name, which takes you to the Related/Affected Individual Relationship Edit screen.

**Related/Affected Individuals Edit**

In this screen, you can create or change a related/affected individual record for the client. When you create a new related/affected record, ARIES creates a new client record for
that individual linked to the HIV+ client. Once their record is created, new services can be entered for the related/affected individual.

Enter the individual’s first name, middle initial, and last name in the corresponding text fields. Avoid using nicknames.

Enter the individual’s date of birth using the format MM/DD/YYYY. For example, for April 12, 1957 enter “4/12/1957.” You can also click the calendar icon to bring up the pop-up calendar.
Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the Date of Birth text field. The calendar window automatically closes.

Enter the individual’s mothers maiden name.

Use the drop-down list to choose the appropriate gender. In addition to male and female, a client may be transgender MTF (male-to-female) or transgender FTM (female-to-male). A client may also be listed as “Other,” “Unknown,” or “Refused to Report.”

From the Relationship drop-down list, select the individual’s relation to the client. Choose from: Parent, Partner, Spouse, Son, Daughter, Sibling, or Roommate. If the relationship is not listed, select the “Other” option and enter the relationship in the Other text field underneath.

Select the client’s status with your agency. Status can be one of the following:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Client is eligible and currently receiving services.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Client is no longer receiving services.</td>
</tr>
<tr>
<td>Disenrolled</td>
<td>Client is no longer eligible for services.</td>
</tr>
<tr>
<td>Lost to Followup</td>
<td>The agency has lost contact with the client after followup call or visit.</td>
</tr>
<tr>
<td>Discharged</td>
<td>The client has had a successful outcome and no longer requires services. For instance, if your agency provides housing and has placed the client, they can then be discharged,</td>
</tr>
<tr>
<td>Reported Deceased</td>
<td>Client has passed away. Status in unconfirmed.</td>
</tr>
<tr>
<td>Confirmed Deceased</td>
<td>Client has passed away. Status has been confirmed.</td>
</tr>
<tr>
<td>Unknown/Unreported</td>
<td>Client’s status is unknown</td>
</tr>
</tbody>
</table>

If you change the individual’s agency status, enter the date in the status as of date text field. Use the format MM/DD/YYYY. So for November 20, 2004, enter “11/20/2004.”

If the individual is deceased, enter their date of death.

From the drop-down list underneath, indicate whether the individual is Hispanic or not.
From the Race 1 drop-down list, select the race of the individual. If the individual is Hispanic, select “Other.” If the client is of mixed race, select “Other.”

Select the individual’s primary medical insurance. If the client is uninsured, select “No insurance.”

If the individual lives with the client, indicate so by selecting the “Living with client” checkbox. If not, enter the individual’s residential address.

If the individual is in California, select which county they live in from the County drop-down list. Otherwise, leave this field blank.

In the Phone 1 field, enter the individual’s primary phone number using the format: 310-555-1212.

From the Living Situation drop-down list, select the individual’s current living situation. If none of the selections match the listed options, select “Other.” Other selections include “Unknown” and “Refused to answer.”

In the text field underneath, enter the individual’s estimated annual household income. For instance, if the client lives with the individual, enter their combined income.

Indicate how many people are in the household.

The Federal Poverty Level percentage will be calculated when you save the form; it cannot be edited.

When you are finished entering information, click the Save button to return to the Living Situation screen. To return to the Living Situation without saving any changes, click the Cancel button.

**Related/Affected Individual Relationship Edit**

In this screen, you can change the relationship between a client and a related or affected individual. For instance, if a client marries their partner, you can change their relationship in this screen.

The screen displays the related/affected individual’s name. Next to relationship, use the drop-down list to indicate the individual’s relationship to the client. If the relationship is not listed, select “Other” and enter the relationship in the text field.
Select the “Living with client” checkbox if the individual lives with the client. Click the Save button to return to the Living Situation screen or click Cancel to return without saving any changes. Click the deactivate button to remove the related or affected individual from view.

**HOPWA**

The HOPWA screen contains the client’s details if they are receiving assistance from Housing Opportunities for Persons With AIDS (HOPWA). To access this screen, from the Client Detail screen, click the HOPWA tab in the second row of tabs.

The HOPWA information includes:

<table>
<thead>
<tr>
<th>Enrollment Date</th>
<th>The date the client first enrolled in HOPWA.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monthly Adjusted Gross Income</td>
<td>The client’s monthly income. This is the client’s household’s monthly income reduced by deductions (or allowances) for dependents, elderly households, medical expenses, disability assistance expenses, and childcare.</td>
</tr>
<tr>
<td>Median Area Income</td>
<td>The median annual income of the client’s geographic area according to the Department of Housing and Urban Development.</td>
</tr>
<tr>
<td>Number of Bedrooms</td>
<td>The total number of bedrooms in the client’s residence.</td>
</tr>
</tbody>
</table>

**John A Porter**

**HOPWA**

- **Enrollment Date:** 11/21/2002
- **Monthly Adjusted Gross Income:** $1,200.00
- **Median Area Income:** $42,000.00
- **Number of Bedrooms:** 1
- **Reason for leaving program:** Still in program
- **Application Type:** Individual
### Reasons for Leaving Program

If the client is no longer participating in HOPWA, the reason is listed.

| Application Type | Indicates whether the client is an individual or family HOPWA participant. |

To change or add any HOPWA information, click the Edit button.

**HOPWA Edit**

From this screen you can edit or add HOPWA related information.

<table>
<thead>
<tr>
<th>Enrolment Date</th>
<th>11/21/2002</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monthly Adj Gross Income</td>
<td>1,200.00</td>
</tr>
<tr>
<td>Median Area Income</td>
<td>42,000.00</td>
</tr>
</tbody>
</table>

**HJD Area Income Website (used for Median Income Calculation)**

<table>
<thead>
<tr>
<th>Number of Bedrooms</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason for Leaving Program</td>
<td>Still in program</td>
</tr>
<tr>
<td>if Other:</td>
<td></td>
</tr>
</tbody>
</table>

**Application Type**

- Individual
- Family

Enter household information under Related/Affected Individuals

In the first text field, enter the date the client enrolled in HOPWA. Use the format MM/DD/YYYY, so for March 14, 2000, enter “3/14/2000.” You can also use the pop-up calendar.
Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the Enrollment Date text field. The calendar window automatically closes.

In the second text field enter the client’s monthly adjusted gross income. This is the client’s household’s monthly income reduced by deductions (or allowances) for dependents, elderly households, medical expenses, disability assistance expenses, and childcare.

In the third text field, enter the median area income based on the client’s address. To look this up, click on the “HUD Area Income Website” link. This will open a new window for the HUD User website where you can look up the median family incomes for the client’s geographic area.

From the Number of Bedrooms drop-down list, select the number of bedrooms of the client’s residence. If the client lives in a single room occupancy, select “SRO.”

If the client is no longer a HOPWA participant, use the “Reason for Leaving Program” drop-down list to indicate why. If the reason isn’t listed, select “Other” and indicate why in the “if Other” text field. If the client is still receiving HOPWA assistance, select “Still in program.”

Next to Application Type, select the radio button for the type of HOPWA assistance the client is receiving: individual or family. If the client is a family applicant, make sure all members of the household are entered as Related/Affected Individuals (see page 55).

When you are finished entering the client’s HOPWA information, click the Save + Next button to continue to the Agency Specifics Edit screen. If you have no other information to enter, click Save + Done to return to the HOPWA screen. To return to the HOPWA screen without saving any changes, click the Cancel button.

**Agency Specifics**

The Agency Specifics screen contains all the relevant agency information about the client. To access this screen, from the Client Detail screen, click the Agency Specifics tab in the second row of tabs.
The Agency Specifics information includes:

<table>
<thead>
<tr>
<th>Share Data</th>
<th>If the client has agreed to share their records with other agencies. This helps expedite the intake process at other agencies.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agency Status</td>
<td>Lists client’s status with the agency and the date when reported.</td>
</tr>
<tr>
<td>Reason for Status Change</td>
<td>If the client’s status has changed, list the reason in this text field.</td>
</tr>
<tr>
<td>Agency Enrollment Date</td>
<td>The date the client first enrolled with the agency.</td>
</tr>
<tr>
<td>Referral</td>
<td>From where the client was referred and when.</td>
</tr>
<tr>
<td>Client IDs</td>
<td>The client’s agency-assigned identifier. If your agency employs multiple IDs, the second one is also listed.</td>
</tr>
</tbody>
</table>
Agency User Fields

The two Agency User Fields may be used to store any data your agency chooses. These fields are particularly useful for identifying groups or subsets of clients within your agency. You must decide on the codes or words you want to use in these fields to identify each group or subset of clients. You must also be careful to enter those codes or words correctly. Data you enter in these fields is available in Crosstab and Ad Hoc reports.

To change any agency specifics, click the Edit button.

Agency Specifics Edit

The Agency Specifics Edit screen allows you to change or add relevant agency information about the client. You must have proper permissions to edit all Agency Specifics fields. Share Data status can only be changed by a supervisor. Enrollment Date, Referral Date, and Referral Source are entered once and may not be changed.

The Agency Specifics fields include:

Share Data

When the client is first entered into the system, they are asked whether they wish to share their information with other agencies. This helps expedite the intake process at other agencies. If the client previously did not agree to share data but now wants to, ask them to review and sign the ARIES consent form allowing their record to be shared. If they agree to share their data and sign the form, select the Yes radio button next to “Agrees to share data.”
<table>
<thead>
<tr>
<th>Agency Status</th>
<th>Select the client’s status with your agency. Status can be one of the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Client is eligible and currently receiving services.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Client is no longer receiving services.</td>
</tr>
<tr>
<td>Disenrolled</td>
<td>Client is no longer eligible for services.</td>
</tr>
<tr>
<td>Lost to Followup</td>
<td>The agency has lost contact with the client after followup call or visit.</td>
</tr>
<tr>
<td>Discharged</td>
<td>The client has had a successful outcome and no longer requires services. For instance, if your agency provides housing and has placed the client, they can then be discharged.</td>
</tr>
<tr>
<td>Reported Deceased</td>
<td>Client has passed away. Status is unconfirmed.</td>
</tr>
<tr>
<td>Confirmed Deceased</td>
<td>Client has passed away. Status has been confirmed.</td>
</tr>
<tr>
<td>Unknown/Unreported</td>
<td>Client’s status is unknown.</td>
</tr>
</tbody>
</table>

Note: If you changed a client’s status to a status other than Active, you may also need to change the client’s program status from the Programs Tab. For example, if a client is now deceased, you would change their status in all the specific programs in which they are enrolled in at your agency. (i.e., EIP, CMP, HOPWA, etc).

<table>
<thead>
<tr>
<th>Reason for Status Change</th>
<th>If the client’s status has changed, list the reason in this text field.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status as of Date</td>
<td>If you change the client’s agency status, enter the date in this text field. Use the format MM/DD/YYYY. So for November 20, 2004, enter “11/20/2004.”</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Agency Enrollment Date</td>
<td>The date the client first enrolled with the agency. Use the format MM/DD/YYYY. So for November 20, 2004, enter “11/20/2004.” This information can only be entered once; it cannot be revised.</td>
</tr>
<tr>
<td>Referral Date</td>
<td>The date the client was referred to the agency. Use the format MM/DD/YYYY. So for November 20, 2004, enter “11/20/2004.” This information can only be entered once; it cannot be revised.</td>
</tr>
<tr>
<td>Referral Source</td>
<td>From this drop-down list, select from where the client was referred. Select from MD (medical doctor), Case Manager, RN (registered nurse), Self, or Other. If the client selects “Other,” enter the source in the “if Other” text field. This information can only be entered once; it cannot be revised.</td>
</tr>
<tr>
<td>Client IDs</td>
<td>If your agency employs client identifiers, enter them in the Agency Client ID text fields.</td>
</tr>
<tr>
<td>Agency User Fields</td>
<td>If your agency uses these two fields, enter data in either as appropriate.</td>
</tr>
<tr>
<td>Client Alert</td>
<td>Client alerts contain important details about dealing with the client, like sensitive health problems or behavioral issues. For instance, if a client has a violent history, it is important for all staff persons to be aware of this. Use the text box to enter any pertinent alerts. When an alert is entered, a yellow icon appears next to the client’s name in the Client Details screens. Clicking on this icon will open an alert box containing the alert message.</td>
</tr>
</tbody>
</table>

If you are finished entering the client’s agency specifics, click the Save + Next button to continue to the Eligibility Documents Edit screen. If you have no further changes, click the Save + Done button to return to the Agency Specifics screen. To return to the Agency Specifics screen without saving any changes, click the Cancel button.

**Eligibility**

The Eligibility screens contain the records of the client’s eligibility documents required for your agency’s services as well as financial records and insurance information. To access this screen, from the Client Detail screen, click the Eligibility tab in the top row of tabs.
This information is used to determine which services the client is eligible for. Accurate details help ensure the client receives all the benefits to which they are entitled.

The Eligibility screens include:

- Eligibility Documents
- Financial
- Insurance

**Eligibility Documents**

The Eligibility Documents screen contains a table listing the client’s eligibility documents. To access this screen, from the Client Detail screen, click the Eligibility tab from the top row of tabs.

<table>
<thead>
<tr>
<th>Type</th>
<th>Doc Date</th>
<th>Obtained</th>
<th>Expires</th>
<th>Source</th>
<th>Location</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proof of Income</td>
<td></td>
<td></td>
<td></td>
<td>Parkland</td>
<td></td>
<td>client to bring 2003 1040</td>
</tr>
</tbody>
</table>

The table headings are as follows:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type of eligibility document.</td>
</tr>
<tr>
<td>Doc Date</td>
<td>When the document was dated.</td>
</tr>
</tbody>
</table>
Obtained | When the document was received by the agency.
Expires | When the document expires (if applicable). For instance, if the document is a driver’s license, when the license expires.
Source | From where the document was obtained.
Location | The agency that received the document. Clicking on a Location link will take you to that agency’s contact information screen.
Notes | Any additional information pertaining to the eligibility document.

To change or add any eligibility document information, click the Edit button.

**Eligibility Document Edit**

In this screen, you can change an existing document record or add a new one.

<table>
<thead>
<tr>
<th>Type</th>
<th>Pending</th>
<th>Doc Dated</th>
<th>Obtained</th>
<th>Expires</th>
<th>Source</th>
<th>Location</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>HIV Letter of Diagnosis</td>
<td>No</td>
<td>7/10/2001</td>
<td>5/20/2004</td>
<td>7/1/2005</td>
<td>Client</td>
<td>Parkland</td>
<td>lease agreement</td>
</tr>
<tr>
<td>Proof of Income</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>tax returns</td>
</tr>
</tbody>
</table>

To edit an existing record, click the Edit button next to the entry. To create a new eligibility document record, click the New button.

<table>
<thead>
<tr>
<th>Type</th>
<th>Pending</th>
<th>Doc Dated</th>
<th>Obtained</th>
<th>Expires</th>
<th>Source</th>
<th>Location</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proof of Residency</td>
<td>No</td>
<td>10/10/2003</td>
<td>5/20/2004</td>
<td>7/1/2006</td>
<td>Client</td>
<td>Parkland</td>
<td>lease agreement</td>
</tr>
<tr>
<td>Proof of Income</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>tax returns</td>
</tr>
</tbody>
</table>

Enter in the document information in the table row. The column headings are as follows:
<table>
<thead>
<tr>
<th>Type</th>
<th>Select the document type from the drop-down list:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proof of Residency</td>
<td>Any document that establishes the client’s place of residence. This can include driver’s license, lease agreement, or business mail addressed to the client.</td>
</tr>
<tr>
<td>HIV Letter of Diagnosis</td>
<td>A letter confirming the client’s HIV+ status.</td>
</tr>
<tr>
<td>Proof of Income</td>
<td>This includes current pay stubs, Social Security check stubs, or other assistance check stubs.</td>
</tr>
<tr>
<td>Release of Information</td>
<td>This document allows the agency to contact other entities for referrals for the client. For instance, this release would permit a case manager to consult an outside physician about a possible referral.</td>
</tr>
<tr>
<td>ARIES Consent Form</td>
<td>This document permits your agency to share the client’s records with other agencies, which can expedite the intake process at other agencies.</td>
</tr>
<tr>
<td>ARIES Consent Form</td>
<td>This document acknowledges client’s agreement to receive services from your Agency</td>
</tr>
<tr>
<td>Picture ID</td>
<td>Identification can be a current driver’s license or state-issued ID card, passport, or military ID.</td>
</tr>
<tr>
<td>ADAP</td>
<td>AIDS Drug Assistance Program (ADAP) identification card.</td>
</tr>
<tr>
<td>HOPWA</td>
<td>Documentation confirming client’s participation in Housing Opportunities for Persons With AIDS (HOPWA).</td>
</tr>
<tr>
<td>HIPPA</td>
<td>Documentation acknowledging Health Insurance Portability &amp; Accountability Act.</td>
</tr>
</tbody>
</table>

Pending | If the client has not yet provided the document to the agency, select the Pending checkbox.
Doc Dated | The date of the document. For instance, if the client brings in a piece of business mail, enter the postmark date. If the client brings a passport, enter the date it was issued.
--- | ---
Obtained | Enter the date the document was received by the agency.
Expires | Enter the date of expiration, where applicable. For instance, if the client brings in their ADAP card, enter the expiration date.
Source | Enter the document source. For instance, if the type of document is a picture ID, enter what type, i.e., driver’s license, state ID, etc.
Location | ARIES automatically enters your agency’s name.
Note | Enter any other information regarding the document.

When you have finished entering in a document entry, click the Save button to preserve your changes. Click Cancel to return to the Eligibility Documents Edit screen without saving your changes.

If you wish to remove an entry from view, click Edit and then click the Deactivate button.

When you have finished entering in eligibility document information, click the Next button to continue to the Financial Edit screen. If you have no more changes, click Done to return to the Eligibility Documents screen.

Financial

The Financial screen displays all of the client’s financial information including household income and assets. To access this screen, from the Client Detail screen, click the Eligibility tab from the top row of tabs, then click the Financial tab from the second row of tabs.

![Financial Screen](image)

Paula F Bevins

Financial Edit

Employment: Full-time
Public Assistance:
# Children in Household: 0
# HIV+: People in Household: 1

**CURRENT INCOME**

<table>
<thead>
<tr>
<th></th>
<th>Amount</th>
<th>Period</th>
<th>Shared by</th>
<th>Poverty Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client</td>
<td>$3,000</td>
<td>Monthly</td>
<td>1</td>
<td>36%</td>
</tr>
<tr>
<td>Family</td>
<td>$0</td>
<td>Monthly</td>
<td>0</td>
<td>0%</td>
</tr>
</tbody>
</table>

**INCOME HISTORY**

<table>
<thead>
<tr>
<th>Date</th>
<th>Client</th>
<th>Household</th>
<th>Family</th>
<th>Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>10/4/2006</td>
<td>$24,000</td>
<td>$24,000</td>
<td>$0</td>
<td>Annual</td>
</tr>
<tr>
<td>10/4/2006</td>
<td>$26,000</td>
<td>$20,000</td>
<td>$0</td>
<td>Annual</td>
</tr>
<tr>
<td>9/1/2006</td>
<td>$24,000</td>
<td>$24,000</td>
<td>$0</td>
<td>Annual</td>
</tr>
<tr>
<td>8/31/2005</td>
<td>$26,000</td>
<td>$20,000</td>
<td>$0,000</td>
<td>Annual</td>
</tr>
<tr>
<td>8/30/2005</td>
<td>$19,491</td>
<td>$19,491</td>
<td>$0</td>
<td>Annual</td>
</tr>
</tbody>
</table>

**INCOME DETAIL/ASSETS**

<table>
<thead>
<tr>
<th>Source (Monthly):</th>
<th>Amount:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employment/Wages</td>
<td>$3,000.00</td>
</tr>
<tr>
<td>Supp Security Income/SSI</td>
<td>$0.00</td>
</tr>
<tr>
<td>Soc Sec Disability Ins SSDI</td>
<td>$0.00</td>
</tr>
<tr>
<td>Social Security Retirement</td>
<td>$0.00</td>
</tr>
<tr>
<td>Gen Assist/Gen Relief Ga/Gr</td>
<td>$0.00</td>
</tr>
<tr>
<td>Unemployment/Un</td>
<td>$0.00</td>
</tr>
<tr>
<td>State Disability Ins SSI</td>
<td>$0.00</td>
</tr>
<tr>
<td>Rental</td>
<td>$0.00</td>
</tr>
<tr>
<td>Food Stamps</td>
<td>$0.00</td>
</tr>
<tr>
<td>Total</td>
<td>$3,000.00</td>
</tr>
</tbody>
</table>

**Owns Home:** Yes
**Owns Car:** Yes
**Dollar Amount of Other Assets:** Yes (Value $22.00)
The left side of the screen displays the client’s employment situation, whether they receive public assistance, and how many children live in the client’s household. Also listed is how many HIV+ people live in the household, including the client.

Below that is a table of the client’s current income. The first row displays the client’s personal income and whether the amount is earned annually or monthly.

The second row displays the combined income of everyone who lives in the client’s household, whether the amount is earned annually or monthly, how many people live in the household (including the client), and the poverty index of the household. Each year, the Federal Poverty Guidelines are published by the Federal Department of Health and Human Services. The poverty index tells you how the client’s income compares to the federal poverty threshold.

The third row in the table lists the combined income of everyone related to the client (including the client), whether the amount is earned monthly or annually, how many people are in the family (including the client), and the poverty index of the client’s family.

The table on the bottom of the screen shows the client, household and family income history.

On the right side of the screen is a table listing the client’s sources of income. The list below indicates if the client is a homeowner, if they own a car, and the total value of their other assets.

To change or edit the client’s financial information, click the Edit button, which takes you to the Financial Edit screen.

Financial Edit

The client’s income and asset information can be edited and changed in the Financial Edit screen. The screen is separated into five sections: Client Income, Household Income, Family Income, Assets and Income History.
In the Client Income form ARIES calculates the client’s income. First, use the radio buttons to select whether you are recording the client’s monthly or annual income.

From the Employed drop-down list, select the employment status of the client: full-time, part-time, not employed, other, or unknown. Select “Other” if the client is a student, volunteers, etc.

If the client receives any sort of public assistance, select “Yes” from the Public Assistance drop-down list. Public assistance is defined as financial help from government sponsored programs that provide for disadvantaged groups. This can include food stamps, Social Security assistance, and other welfare programs.

Enter the client’s income in the corresponding sources text fields. For instance, if the client receives $800/month from their job and $600/month from veteran’s benefits, enter 800 in the Employment/Wages text field and 600 in Veterans Benefits. Use the third column for additional sources of income. For sources of income not listed, use the “other” text fields and indicate the source in the accompanying text fields on the left.

If the client receives food stamps, enter how much they receive in the Food Stamps text field.

The client’s total income is calculated in the Total text field.

If the client has no income, select the “No source of income” checkbox.
In the Household Income section, enter the income information about the client’s household, which includes everyone who lives with the client, related or not.

In the Household Income text field, enter the combined income of every individual in the client’s household over the age of 15 (including the client). Use the radio buttons to the right to indicate whether the income figure is monthly or annual.

Enter the total number of persons in the household in the next text field. This includes relatives and children.

The Federal Poverty Level percentage will be calculated when you save the form; it cannot be edited.

In the bottom left text field, enter the number of persons under the age of 15 (including the client, if applicable) in the household.

In the text field to the right, enter the number of HIV+ people in the household, including the client.

<table>
<thead>
<tr>
<th>Household Income</th>
<th>2450</th>
<th>Monthly</th>
<th>Annual</th>
</tr>
</thead>
<tbody>
<tr>
<td># People in Household</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td># Children in Household</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td># HIV+ People in Household</td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In the Family Income section, enter the income information about the client’s family.

In the first text field, enter the client’s family income. This is the combined income of every family member who lives with the client (including the client) who is over the age of 15. Use the radio buttons to indicate if the income figure is monthly or annual.

In the second text field, enter the total number of family members who live with the client (including the client). Include any children, too. So if the client lives with her husband and two children, enter “4.” The Federal Poverty Level percentage will be calculated when you save the form; it cannot be edited.

<table>
<thead>
<tr>
<th>Family Income</th>
<th>1600</th>
<th>Monthly</th>
<th>Annual</th>
</tr>
</thead>
<tbody>
<tr>
<td># People in Family</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Percent Federal Poverty Level</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
In the Assets section, list the client’s assets. Use the corresponding drop-down lists to indicate whether or not the client owns a house or a car.

If the client has any other assets, select “Yes” from the third drop-down list. List the dollar amount of any additional assets in the accompanying text field. Assets can include savings, bonds, or other investments.

In the last section, Income History, click on the New button and ARIES will populate the income history fields with the revised income you have just entered in the sections above. After you have entered the date for this income history, click the Save button. To exit without saving your changes, click the Cancel button. Each time the financial information is edited, be sure to click the New button for Income History and save the new information for historical purposes.

If you are finished entering new information, click the Save + Next button to proceed to the Insurance Edit screen. Click Save + Done to save your changes and return to the Financial screen. To exit without saving your changes, click the Cancel button.

**Insurance**

The Insurance screen lists the client’s health insurance information in a table. To access this screen, from the Client Detail screen, click the Eligibility tab from the top row of tabs, then click the Insurance tab from the second row of tabs.
The insurance table lists:

<table>
<thead>
<tr>
<th>Source</th>
<th>Type</th>
<th>Pend.</th>
<th>Prim Ins</th>
<th>Prim HIV Ins</th>
<th>Carrier</th>
<th>Policy #</th>
<th>Start / End</th>
<th>Prem</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Private 1</td>
<td>Restricted</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Blue Cross</td>
<td>1111</td>
<td>10/29/2002 -</td>
<td>$200.00</td>
<td></td>
</tr>
<tr>
<td>Medicare</td>
<td>Restricted</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td></td>
<td>555444</td>
<td>04/22/2003 -</td>
<td>$80.00</td>
<td>supplemental</td>
</tr>
</tbody>
</table>

The insurance table lists:

- **Source**: The insurance source, i.e., public, private, ADAP, Medicare, Medi-Cal/Medicaid, etc.
- **Type**: The type of medical insurance, i.e., restricted, COBRA, managed, Medicare A or B, etc.
- **Pend.**: Indicates if the insurance is pending and not yet effective.
- **Prim Ins**: Indicates if this insurance policy is used for the client’s primary healthcare.
- **Prim HIV Ins**: Indicates if this insurance policy is used for the client’s primary HIV healthcare.
- **Carrier**: The client’s insurance carrier, i.e., Kaiser, Aetna, Blue Cross, etc.
- **Policy #**: The client’s insurance policy number.
- **Start/End**: The effective dates of the insurance policy.
- **Prem**: The client’s monthly insurance premium costs.
- **Note**: Any additional notes regarding the insurance policy.

To change or add any insurance information, click the Edit button to go to the **Insurance Edit** screen.

**Insurance Edit**

The Insurance Edit screen lists the client’s health insurance information.
To change a current policy, click the Edit button next to its row. To create a new entry, click the New button. Enter new information in the table row.

The table columns include:

<table>
<thead>
<tr>
<th>Source</th>
<th>Type</th>
<th>Pending</th>
<th>Prim Ins</th>
<th>Prim HIV Ins</th>
<th>Carrier</th>
<th>Policy #</th>
<th>Start Date</th>
<th>End Date</th>
<th>Mo. Premium</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Private 1</td>
<td>Restricted</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Blue Cross</td>
<td>1111</td>
<td>10/29/2002</td>
<td></td>
<td>$200.00</td>
<td></td>
</tr>
<tr>
<td>Medicare</td>
<td>Restricted</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Source**: Select the source of insurance from the drop-down list. If the client has health insurance from a source not listed, select “Other.”
- **Type**: Use the drop-down list to select the type of medical insurance plan, i.e., restricted, COBRA, managed, Medicare A or B, etc. If the client has an insurance type not listed, select other.
- **Pending**: Select this checkbox if the client has applied for this insurance policy, but is not yet eligible for benefits. If a policy is pending, you must enter the date it becomes effective in the Note field.
- **Prim Ins**: Select this checkbox if this insurance policy is used for the client’s primary healthcare.
- **Prim HIV Ins**: Select this checkbox if this insurance policy is used for the client’s primary HIV healthcare.
- **Carrier**: Use the drop-down list to select the policy’s insurance carrier: Kaiser, Aetna, or Blue Cross. If the insurance carrier is not listed, select “Other” and enter the name of the insurance carrier in the Note field.
- **Pol #**: Enter the client’s insurance policy number.
Start Date
Enter the start date of the client’s medical coverage under this policy. Use the format: MM/DD/YYYY. So if the client’s benefits begin on July 12, 2005, enter “07/12/2005.” You can also use the pop-up calendar. Click the calendar icon above the Start Date field to bring up the calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the Start Date text field. The calendar window automatically closes.

End Date
Enter the end date of the client’s insurance policy. For instance, if the client is receiving COBRA benefits, enter the last day of coverage. If the client’s coverage is ongoing, leave the text field empty.

Prem
Enter the client’s monthly insurance premium costs.

Note
Enter any additional notes regarding the insurance policy. For instance, if the client’s insurance carrier isn’t listed, enter the carrier’s name here. Also, if a policy is pending, enter the date it becomes effective here.

When you have finished entering policy information, click the Save button to return to the Insurance Edit screen. To return to the screen without saving changes, click Cancel. To remove the entry from view, click the Deactivate button.

When you have finished entering the client’s insurance information, click the Next button to continue to the client’s Basic Medical Edit screen (see page 123). If you have no further changes, click the Done button to return to the Insurance screen.

**Programs**

For some regions and agencies, services are available through specialized programs. These programs are set up for persons with specific needs who meet certain eligibility requirements. For instance, CARE/HIPP benefits are only available for financially needy persons with private insurance.

Each program has a separate enrollment process. Accuracy is critical in the enrollment process, as clients cannot receive benefits unless enrollment process is complete.

To access the Programs screen, from a client’s information screen, click the Programs tab from the top tier of tabs. The first screen that displays is the Program Summary screen.

**Program Summary & Agency Staff Assignment**

The program summary screen displays a table of the programs the client is enrolled in.
The table lists the program name, the status of the client within the program, for instance, if the client is active or disenrolled. Next lists: the date the program information was entered, the agency the client is enrolled at, the client ID, the staff person assigned for that program, and the reason for their disenrollment, if any.

To access information regarding a specific program, use the second tier of tabs to select the program you wish to view.

Clients can be assigned to specific staff persons. This can include case managers, clinicians, or even individuals outside of your agency. You want to assign the staff persons who have regular contact with the client so that others who might need information about a client can access it easily by looking up their staff assignment.

For example, a staff person can look up a client’s staff assignments to see who their therapist is. Or, if an agency administrator has a question about a client’s care plan, they can quickly look up the client’s case manager to ask about it.

To change or enter a client’s staff assignments, click the Edit button in the Program Summary screen to access the Staff Assignment Edit screen.
Staff Assignment Edit

The Staff Assignment Edit screen allows you to enter up to 4 agency staff persons to a client. Use the drop-down lists to select a staff person. For instance, you might list a client’s case manager as the Staff 1 assignment and their primary physician as their Staff 2 assignment.

If you wish to enter staff assignments from outside your agency, enter them in the Other Staff text fields. For instance, you might list a client’s dentist who works in conjunction with your agency.

When you have finished entering staff assignments, click the Save button to return to the Program Summary screen. Click Cancel to return without saving any changes.

EIP

The Early Intervention Program (EIP) was created to prevent HIV transmission and to enhance and prolong the health and productivity of persons with HIV. EIP provides HIV-related medical care, risk reduction counseling, and ongoing psychosocial support and health education.

All EIP services are provided as needed to enrolled clients, and formal assessments of physical health, HIV transmission risk, psychosocial status, and health education awareness are provided at six-month intervals. To be eligible, clients must be HIV-infected and have no other source of medical care. HIV-negative, at-risk partners of EIP clients are also eligible for non-medical services.
To access the EIP screen, from a client’s information screen, click the Program tab from the top tier of tabs. From the second tier of tabs, select the EIP/Bridge/Positive Changes tab.

The EIP/Bridge/Positive Changes screen is separated into five sections. The top portion shows the client’s program status in a table. Listed are the client’s status, the date of their last program update, the agency that enrolled them, their client ID, and the staff person assigned to them. Also included are any additional notes.

To enroll a client, click the Enroll button, which takes you to the EIP Enrollment screen. If a client has already been enrolled and you need to change their enrollment status, click the Change Status button, which takes you to the EIP Enrollment Change Status screen.

**EIP Psychosocial Factors**

The second section is the EIP Psychosocial Factors. When a client is first enrolled in EIP, a baseline assessment of psychosocial status is conducted. To change or view a client’s baseline assessment, click the Edit button, which takes you to the EIP Psychosocial Factors Edit screens.

**EIP Functional Status**

The third section is for EIP Functional Status evaluations. Every six months, program participants are assessed for general quality of life status, emphasizing factors that affect coping skills, risk behaviors, ability to adhere to treatment, and ability to participate in health care decisions.

The table lists the dates of the evaluations and who administered the evaluation. To change or view a client’s Functional Status evaluation, click the Edit button. To create a
new entry, click the New button. Either action takes you to the EIP Functional Section 1 Edit screen.

**EIP Behavioral Risk**

The fourth section lists the client’s EIP Behavioral Risk evaluations table. Every six months, program participants are given assessments of their sexual and substance abuse behaviors.

The table lists the dates of the evaluations and who administered the evaluation. To change or view a client’s Behavioral Risk evaluation, click the Edit button. To create a new entry, click the New button. Either action takes you to the EIP Behavioral Section 1 Edit screen.

**Bridge Project Barriers to Care**

The bottom section lists the client’s Bridge Project, Barriers to Care Assessments table. To change or view a client’s Barriers to Care Assessment, click on the Edit button. To create a new entry, click on the New button.

**EIP/Bridge/Positive Changes Enrollment**

In this screen, you can enroll eligible clients into EIP, Bridge and Positive Changes programs. First, from the program drop-down list select the program you are enrolling the client in. When you first enter a client, the client’s Status defaults to “Enroll.”

<table>
<thead>
<tr>
<th>Program</th>
<th>Status</th>
<th>Date</th>
<th>Agency</th>
<th>Client Program ID</th>
<th>Staff 1</th>
<th>Staff 2</th>
<th>Staff 3</th>
<th>Staff 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>EIP</td>
<td>Enroll</td>
<td>10/5/2004</td>
<td>Parkland</td>
<td>4117</td>
<td>Jones, Mary</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In the Date text field, enter the date of enrollment. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar.
Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

In the last text field, if the program uses separate IDs from your agency, enter the Client Program ID. You can also select the Auto-generate checkbox and ARIES will create an ID to assign the client.

From the Staff drop-down lists, select the staff persons who are assigned to the client’s EIP/Bridge/Positive Changes services. For instance, you may assign the client’s case manager as well as a counselor who specializes in EIP/Bridge/Positive Changes cases.

When you are finished, click the Save button. If you are enrolling a client in EIP, ARIES will then take you to the client’s EIP Psychosocial Factors Edit screen. To return to the EIP/Bridge/Positive Changes screen without saving changes, click the Cancel button.

**EIP/Bridge/Positive Changes Enrollment Change Status**

A client’s enrollment status in a program can change based on their health, financial status, or any variety of reasons. When you change a client’s program status, a new entry will display at the bottom of a table of the programs the client is enrolled in.
To change a client’s enrollment status, click the Change Status button, which takes you to the Enrollment Change Status screen.

**EIP Enrollment Status Change**

A client’s enrollment status in a program can change based on their health, financial status, or any variety of reasons. When you change a client’s program status, a new entry will display at the bottom of a table of the programs the client is enrolled in.

From the Status drop-down list, select the client’s new status:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>The client is eligible to receive services.</td>
</tr>
<tr>
<td>Transitioned</td>
<td>The client's medical condition requires a higher degree of care than EIP can provide, so medical services are being provided at another agency. However, the client is still eligible to receive non-medical services from EIP.</td>
</tr>
<tr>
<td>Medically Reactivated</td>
<td>The client was previously Transitioned, but the client's medical condition has now improved to the point where the client is now eligible for the full range of services offered by EIP.</td>
</tr>
<tr>
<td>Disenrolled</td>
<td>The client, for whatever reason, is no longer participating in the program.</td>
</tr>
<tr>
<td>Re-enrolled</td>
<td>A client who was previously disenrolled in the program is now re-enrolled.</td>
</tr>
</tbody>
</table>
When changing a client’s EIP enrollment status, please observe the following rules:

- Active clients may only be changed to Transitioned or Disenrolled
- Transitioned clients may only be changed to Medically Deactivated or Disenrolled
- Medically Reactivated clients may only be changed to Transitioned or Disenrolled
- Disenrolled clients may only be changed to Re-enrolled
- Reenrolled clients may only be changed to Transitioned or Disenrolled

In the Date text field, enter the date of enrollment status change. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar.

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

From the Reason drop-down list, select the reason for the client’s change in status. If the reason is not listed, select “Other” and enter the reason in the adjacent text field.

Use the Staff drop-down list, if you need to make changes to the client’s staff assignments for this program.

When you have finished entering changes, click Save to return to the EIP/Bridge/Positive Changes screen, or click Cancel to return without saving changes.

**EIP Psychosocial Factors Edit**

When you first enroll a client into EIP, the EIP Psychosocial Factors Edit screen displays. The evaluation consists of three screens: History of Abuse, Legal, and Diagnostic Impression and Mental Health History. When performing an evaluation, attention to detail is critical.
EIP Psychological Abuse Edit

In this screen, assess the client’s history of abuse.

### John A Porter EIP Psychosocial Factors: History of Abuse

<table>
<thead>
<tr>
<th></th>
<th>Childhood (&lt;17)</th>
<th>Adult (≥17)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Emotional</strong></td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td><strong>Physical</strong></td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Sexual</strong></td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td><strong>Domestic Violence</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Observed in Childhood</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Adult Perpetrator</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

Use the drop-down lists to indicate whether or not the client has a history of abuse.

### EIP Psychosocial Factors: History of Abuse

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Emotional</strong></td>
<td>Was the client a victim of emotional abuse as a child (under 17-years of age)? As an adult (17 and older)?</td>
</tr>
<tr>
<td><strong>Physical</strong></td>
<td>Was the client a victim of physical abuse as a child (under 17-years of age)? As an adult (17 and older)?</td>
</tr>
<tr>
<td><strong>Sexual</strong></td>
<td>Was the client a victim of sexual abuse as a child (under 17-years of age)? As an adult (17 and older)?</td>
</tr>
<tr>
<td><strong>Domestic Violence</strong></td>
<td>When the client was under 17-years of age, did the client witness violence in their household?</td>
</tr>
<tr>
<td>Observed in Childhood</td>
<td></td>
</tr>
<tr>
<td>Adult Perpetrator</td>
<td>As an adult (17 and older), has the client committed any acts of violence on others in their household?</td>
</tr>
</tbody>
</table>

Click the Save + Next button to continue to the legal evaluation, or click Cancel to return to the EIP screen without saving any changes.
EIP Psychological Legal Edit

This screen is used to assess the client’s legal history.

**John A Porter EIP Psychosocial Factors: Legal**

Does the client have legal issues pending in any of the following areas?

- **Divorce, Child Support or Custody**
- **Housing, Employment or Health Care Discrimination**
- **Immigration Status**
- **Mental Health Commitment**
- **Social Security Disability or SSI**
- **DUI**
- **Other**

<table>
<thead>
<tr>
<th>Factor</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Divorce, Child Support or Custody</td>
<td></td>
<td>Na</td>
</tr>
<tr>
<td>Housing, Employment or Health Care Discrimination</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Immigration Status</td>
<td>Na</td>
<td></td>
</tr>
<tr>
<td>Mental Health Commitment</td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>Social Security Disability or SSI</td>
<td></td>
<td>Na</td>
</tr>
<tr>
<td>Is the client currently on parole or probation?</td>
<td>Na</td>
<td></td>
</tr>
<tr>
<td>How much combined time has the client spent in jail or prison (Total Months)?</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Use the drop-down lists to list any pending legal issues the client may have.

<table>
<thead>
<tr>
<th>EIP Psychosocial Factors: Legal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Divorce, Child Support or Custody</td>
</tr>
<tr>
<td>Does the client have a pending divorce or are they involved in a child support or custody dispute?</td>
</tr>
<tr>
<td>Housing, Employment or Health Care Discrimination</td>
</tr>
<tr>
<td>Is the client currently involved in a legal discrimination dispute involving housing, employment, or health care?</td>
</tr>
<tr>
<td>Immigration Status</td>
</tr>
<tr>
<td>Is the client’s immigration status to the U.S. pending?</td>
</tr>
<tr>
<td>Mental Health Commitment</td>
</tr>
<tr>
<td>Does the client have any unresolved legal issues regarding their commitment for mental health reasons?</td>
</tr>
<tr>
<td>Social Security Disability or SSI</td>
</tr>
<tr>
<td>Is the client currently involved in a dispute over Social Security Disability or Income payments?</td>
</tr>
<tr>
<td>DUI</td>
</tr>
<tr>
<td>Does the client have any outstanding charges for driving under the influence of alcohol or any other controlled substance?</td>
</tr>
<tr>
<td>Other</td>
</tr>
<tr>
<td>If the client has any other outstanding legal issues, enter them in this text field.</td>
</tr>
</tbody>
</table>
Is the client currently on parole or probation?
If the client is presently on parole or probation, indicate so from the drop-down list.

How much combined time has the client spent in jail or prison?
Enter the number of months the client has served in prison or jail. For instance, if the client served a six-month sentence and another two-year (24 months) sentence, enter 30.

When you have finished entering the client’s legal information, click Save + Next to continue to the Psychological Diagnostic Edit screen.

**EIP Psychological Diagnostic Edit**

This section of the psychosocial assessment evaluates the client’s mental health background. In the first half, use the drop-down lists to evaluate the client’s mental health symptoms from mild to severe. If the client is not experiencing the symptoms, leave the selection blank. Then, in the second column of drop-down lists, select whether the client’s symptoms present a risk to their physical well-being.

### John A Porter EIP Psychosocial Factors: Diagnostic Impression and Mental Health History

**Diagnostic Impressions and Mental Health History**

<table>
<thead>
<tr>
<th>Anxiety Symptoms</th>
<th>Mental Health</th>
<th>Depressive Symptoms</th>
<th>Mental Health</th>
<th>Personality Symptoms</th>
<th>Mental Health</th>
<th>Psychotic Symptoms</th>
<th>Mental Health</th>
<th>Substance Use</th>
<th>Mental Health</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Severe</td>
<td>Affecting Risk</td>
<td>Mild</td>
<td>Not Affecting Risk</td>
<td></td>
<td></td>
<td>Moderate</td>
<td>Not Affecting Risk</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**How would you describe the client’s current drug/alcohol use?**

- Heavy user

**Psychiatric History?**

- Yes

**If yes, specify:**

- Depression

**History of Drug Treatment?**

- No

**Current Psychiatric Medications?**

- Yes

**If yes, specify:**

- Zoloft

**History of Psychiatric Hospitalization?**

- No

**If yes, specify:**

Below are the question explanations:
<table>
<thead>
<tr>
<th>EIP Psychosocial Factors: Diagnostic Impression and Mental Health History</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anxiety Symptoms</td>
</tr>
<tr>
<td>Depressive Symptoms</td>
</tr>
<tr>
<td>Personality Symptoms?</td>
</tr>
<tr>
<td>Psychotic Symptoms</td>
</tr>
<tr>
<td>Substance Abuse</td>
</tr>
<tr>
<td>How would you describe the client’s current drug/alcohol use?</td>
</tr>
<tr>
<td>Psychiatric History?</td>
</tr>
<tr>
<td>Current Psychiatric Medications?</td>
</tr>
<tr>
<td>History of Drug Treatment?</td>
</tr>
<tr>
<td>History of Psychiatric Hospitalization</td>
</tr>
</tbody>
</table>
When you have completed entering the client’s mental history, click the Save button to return to the EIP screen. Click the Cancel button to return without saving any changes.

**EIP Functional Section 1 Edit**

Every six months, EIP participants must be evaluated for their functional status and their quality of life. The assessment is separated into two sections: one based on their current state of health, and the other based on the client’s well-being for the previous month.

Ask the client the listed questions and use the drop-down lists to best estimate their answer.

Next to “As of Date” enter the date of the evaluation. Use the format MM/DD/YYYY, so for March 14, 2000, enter “3/14/2000.” You can also use the pop-up calendar.
Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the Enrollment Date text field. The calendar window automatically closes.

For the first question, use the drop-down list to describe the client’s self-evaluation of their current state of health.

For the second question, use the drop-down lists to assess how accurately the client feels each statement describes their current state.

When you have finished, click the Save + Next button to continue to Section 2. Click Cancel to return to the EIP screen without saving changes. Click the Deactivate button to remove this evaluation from view.

**EIP Functional Section 2 Edit**

The second section of the assessment covers how the client has felt over the past month. Ask the client to estimate their answer for each question based on the choices listed in each drop-down list.
For each of the following questions, please select the option for the one answer that comes closest to the way you have been feeling during the past month.

3. How much of the time, during the past month, has your health limited your social activities (like visiting with friends or close relatives)?

   A little of the time

4. How much of the time, during the past month:

   a. Have you been a very nervous person?

      A little of the time

   b. Have you felt calm and peaceful?

      A little of the time

   c. Have you felt downhearted and blue?

      All of the time

   d. Have you been a happy person?

      None of the time

   e. Have you felt so down in the dumps that nothing could cheer you up?

      A good bit of the time

Click the Save + Next button to continue to the Section 3. Clicking Cancel returns you to the EIP screen without saving changes.

**EIP Functional Section 3 Edit**

This screen is a continuation of the previous screen covering how the client has felt over the past month. Ask the client to estimate their answer for each question based on the choices listed in each drop-down list.
**John A Porter Early Intervention Program, Functional Status/Quality of Life Section 3**

For each of the following questions, please select the option for the one answer that comes closest to the way you have been feeling during the past month:

5. How often during the past month:

   a. Did you feel full of pep? [Some of the time]
   b. Did you feel worn out? [A good bit of the time]
   c. Did you feel tired? [All of the time]
   d. Did you have enough energy to do the things you wanted to do? [All of the time]
   e. Did you feel weighed down by your health problems? [All of the time]

When you are finished, click the Save button to return to the EIP screen or click the Cancel button to return without saving any changes.

**EIP Behavioral Section 1 Edit**

This section lists the client’s EIP Behavioral Risk assessments. Every six months, program participants are assessed for HIV transmission risk, including sexual and substance abuse behaviors as well as changes in life circumstances or health and mental status that may affect risk behaviors.

The assessment is separated into four screens. The first screen covers the client’s general high-risk behaviors; the second screen addresses the client’s sexual behavior for the past three months, and the third and fourth sections addresses the client’s drug use for the past 30 days.
Next to “As of Date” enter the date of the evaluation. Use the format MM/DD/YYYY, so for March 14, 2000, enter “3/14/2000.” You can also use the pop-up calendar.
Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the Enrollment Date text field. The calendar window automatically closes.

Use the drop-down list to select the staff person performing the assessment.

Use the drop-down lists to answer each question. The first column of questions concerns the client’s behavior for the past three months. The second column of questions concerns the client’s general history.

The two questions at the bottom of the screen address the client’s behavior for the past three months.

When you have finished answering the questions of section 1, click the Save + Next button to continue to Section 2. Click the Cancel button to return to the EIP screen without saving changes. Click the Deactivate button to remove the assessment from view.

**EIP Behavioral Section 2 Edit**

This screen covers the client’s sexual behavior over the past three months.

**John A Porter Early Intervention Program, Behavioral Risk, Section 2**

**In the past 3 months, have you had vaginal, oral or anal sex?**

If Yes, with a...

<table>
<thead>
<tr>
<th>Man?</th>
<th>Yes</th>
<th>If Yes, how many men?</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Woman?</td>
<td>No</td>
<td>If Yes, how many women?</td>
<td></td>
</tr>
<tr>
<td>Transgender?</td>
<td>No</td>
<td>If Yes, how many transgender?</td>
<td></td>
</tr>
</tbody>
</table>
For the first question ask the client whether they have had sex (oral, anal, or vaginal) in the past three months. If they answer yes, indicate whether the client’s partners were men, women, or transgender, then enter in the corresponding text fields how many partners the client had from each gender.

For the second question of section 2, ask what type of sex the client had and whether they used a condom or other barrier. If the client did use condoms or barriers, ask them how frequently they used them for each type of sex.

For instance, if a client performed vaginal sex and received oral sex, ask them how often they used condoms for vaginal sex and how often they used them for oral sex. Use the drop-down lists to estimate the frequency of condom use.

For the third question of section 2, ask the client if they have had unprotected sex (anal or vaginal) during the past three months. If they respond yes, ask how many people they had unprotected sex with and ask the HIV status of the client’s partners. Use the information to fill out the drop-down lists and text fields.
For the last part of the question, enter the client’s spouse or partner information.

When you have finished entering information for section 2, click Save + Next to continue to the third section. Click the Cancel button to return to the EIP screen without saving changes.

EIP Behavioral Section 3 Edit

For the third section, ask the client whether they have taken any of the non-injected drugs listed in the past 30 days. If the client drinks alcohol, ask them if they have drunk 5 or more alcoholic drinks in one sitting over the past 30 days. If the client responds yes to any of the questions, select “Yes” from the corresponding drop-down list and then enter how many times the client has used that drug or alcohol over the past 30 days. For instance, if the client has drunk heavily on 8 occasions in the past month, select “Yes” next to Alcohol and enter “8” in the adjacent text field.

John A Porter Early Intervention Program, Behavioral Risk, Section 3

In the past 30 days, have you used any of the following non-injected drugs? Yes

If Yes, have you used the following drugs? If Yes, how many times in the past 30 days?

<table>
<thead>
<tr>
<th>Drug</th>
<th>Yes</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crack</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Cocaine</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Heroin</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Amphetamines (speed, crystal)</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

If the client has taken any non-injected drugs that aren’t listed, enter them in the Other text field at the bottom of the list and enter the frequency in the accompanying text field.

When you have finished entering the client’s information, click the Save + Next button to continue to section 4, which deals with injected drugs. Click the Cancel button to return to the EIP screen without saving changes.

EIP Behavioral Section 4 Edit

For section 4, ask the client whether they have used injected drugs – prescribed or otherwise – in the past 30 days. If they respond yes, use the drop-down lists to indicate which drugs the client has injected. Use the adjacent text fields to enter how many times the client has injected drugs in the past 30 days.
If the client has injected a drug or medication not listed, enter it in the Other text field and enter how often in the corresponding text field.

The last two questions in section 4 concern the client’s needle usage. Use the drop-down lists to indicate what type of needles the client used and whether they shared needles with other drug users.

When you have finished entering information, click the Save button to return to the EIP screen or click the Cancel button to return without saving changes.

**Bridge Project**

The Bridge Project seeks to identify HIV-positive persons who have never been in care, or who have been lost to care, and link them with the Early Intervention Program or other HIV care providers. Bridge workers are trained treatment educators and work to increase access to care in communities highly impacted by AIDS.

To access the Bridge Project screen, from a client’s information screen, click the Program tab from the top tier of tabs. From the second tier of tabs, select the EIP/Bridge/Positive Changes tab.
To enroll a client, click the Enroll button, which takes you to the Bridge Project Enrollment screen. If a client has already been enrolled and you need to change their enrollment status, click the Change Status button, which takes you to the EIP/Bridge/Positive Changes Enrollment Change Status screen.

Bridge Enrollment Status Change

A client’s enrollment status in a program can change based on their health, financial status, or any variety of reasons. When you change a client’s program status, a new entry will display at the bottom of a table of the programs the client is enrolled in.

From the Status drop-down list, select the client’s new status:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>The client is eligible to receive services.</td>
</tr>
<tr>
<td>Disenrolled</td>
<td>The client, for whatever reason, is no longer participating in the program.</td>
</tr>
<tr>
<td>Re-enrolled</td>
<td>A client who was previously disenrolled in the program is now re-enrolled.</td>
</tr>
</tbody>
</table>

In the Date text field, enter the date of enrollment status change. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar.

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

From the Reason drop-down list, select the reason for the client’s change in status. If the reasoning not listed, select “Other” and enter the reason in the adjacent text field.

Use the Staff drop-down lists if you need to make changes to the client’s staff assignments for this program.
When you have finished entering changes, click Save to return to the EIP/Bridge/Positive Changes screen, or click Cancel to return without saving changes.

**Bridge Project-Barriers to Care Assessment Section I**

The Bridge Project seeks to identify HIV-positive clients who have never been in care and link them with the appropriate service providers. The Bridge Project also works with clients who have dropped out of care, in an effort to bring them back into care.

To access the Bridge Project Barriers to Care screen, from a client’s information screen click the Program tab from the top tier of tabs. From the second tier of tabs, select the EIP/Bridge Pos Changes tab.

The table lists the dates of the evaluations and who administered the evaluation. To change or view a client’s Bridge Project Barriers to Care assessment, click the Edit button. To create a new entry, click the New button. Either action takes you to the Bridge Barriers to Care assessment, Section 1 Edit screen.

Next to “Date of Assessment” enter the date of the assessment. Use the format MM/DD/YYYY, so for March 14, 2000, enter “3/14/2000.” You can also use the pop-up calendar.

![Calendar](image)

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the Enrollment Date text field. The calendar window automatically closes.

Next to “Bridge Worker” use the drop-down list to select the staff person performing the assessment.

ARIES will automatically populate the “Date of first HIV-positive test” text field. This field cannot be edited.

<p>| Date dropped out of HIV medical care | Record the date the client dropped out of HIV medical care. |</p>
<table>
<thead>
<tr>
<th>Current or Former EIP client</th>
<th>From the drop-down list, indicate whether client is a current or former EIP client</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial barriers</td>
<td>Indicate the financial barriers indicated by the client that are impeding them from continuing their HIV medical care. Check all that apply. For other financial reasons use the text field to specific other reason.</td>
</tr>
<tr>
<td>Health barriers</td>
<td>Indicate the health barriers indicated by the client that are impeding them from continuing their HIV medical care. Check all that apply. For other health reasons use the text field to specific other reason.</td>
</tr>
</tbody>
</table>

When you have finished answering the questions of section 1, click the Save + Next button to continue to Section 2. Click the Cancel button to return to the EIP/Positive Changes screen without saving changes. Click the Deactivate button to remove the assessment from view.

**Bridge Project—Barriers to Care Assessment Section 2**

Continue the Barriers to Care Assessment by completing the fields below:

<table>
<thead>
<tr>
<th>Clinic/Facility barriers</th>
<th>Select all the applicable Clinic/Facility barriers that client reports are impeding their access to HIV medical care. If Other, check “Other” and explain in the text field below.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Housing/Responsibility barriers</td>
<td>Select all the applicable Housing/Responsibility barriers that client reports are impeding their access to HIV medical care. If Other, check “Other” and explain in the text field below.</td>
</tr>
<tr>
<td>Knowledge/belief barriers</td>
<td>Select all the applicable Knowledge/belief barriers that client reports are impeding their access to HIV medical care. If Other, check “Other” and explain in the text field below.</td>
</tr>
</tbody>
</table>
When you have finished answering the questions of section 2, click the Save button to save the assessment. Click the Cancel button to return to the EIP/Bridge/Positive Changes screen without saving changes. Click the Deactivate button to remove the assessment from view.

**Positive Changes**

Positive Changes provides intensive one-on-one risk reduction counseling for HIV-positive persons at high risk for transmitting HIV and whose prevention needs are too complex to be addressed by the standard risk reduction interventions offered in the Early Intervention Program (EIP). Positive Changes counselors link clients’ life goals to risk reduction in ways that help them achieve desired goals and reduce their risk of HIV transmission. Incremental steps toward small changes are emphasized in order to maximize client success and enhance motivation to continue.

Clients can transition back into EIP’s standard services once they are no longer at high risk for HIV transmission. They may re-engage with Positive Changes at any point they or EIP staff believe they are in danger of slipping back into high risk behaviors.

To access the Positive Changes screen, from a client’s information screen, click the Program tab from the top tier of tabs. From the second tier of tabs, select the EIP/Bridge/Positive Changes tab.

**Positive Changes Enrollment**

To enroll a client, click the Enroll button, which takes you to the Bridge Project Enrollment screen. If a client has already been enrolled and you need to change their enrollment status, click the Change Status button, which takes you to the EIP/Bridge/Positive Changes Enrollment Change Status screen.

**Positive Changes Enrollment Status Change**

A client’s enrollment status in a program can changed based on their health, financial status, or any variety of reasons. When you change a client’s program status, a new entry will display at the bottom of a table of the programs the client is enrolled in.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>The client is eligible to receive services.</td>
</tr>
<tr>
<td>Disenrolled</td>
<td>The client, for whatever reason, is no longer participating in the program.</td>
</tr>
</tbody>
</table>
Re-enrolled  A client who was previously disenrolled in the program is now re-enrolled.

In the Date text field, enter the date of enrollment status change. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar.

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

From the Reason drop-down list, select the reason for the client’s change in status. If the reason is not listed, select “Other” and enter the reason in the adjacent text field.

Use the Staff drop-down lists if you need to make changes to the client’s staff assignments for this program.

When you have finished entering changes, click Save to return to the EIP/Bridge/Positive Changes screen, or click Cancel to return without saving changes.

**TMP**

The Therapeutic Monitoring Program (TMP) is a care program in the state of California created to provide vouchers for viral load and resistance testing for certain ADAP (AIDS Drug Assistance Program) participants. Test results help ensure that clients receive the most effective drug treatments through ADAP. For more information about ADAP eligibility, visit the ADAP website at: [http://www.phsb.com/patient/ca_eligible.html](http://www.phsb.com/patient/ca_eligible.html).
To access the TMP screen, from a client’s information screen, click the Program tab from the top tier of tabs. From the second tier of tabs, select the TMP tab.

The TMP screen is separated into two sections. The top portion shows the client’s program status in a table. Listed are the client’s status, the date of their last program update, the agency that enrolled them, their client ID, and the staff person assigned to them. Also included are any additional notes.

To enroll a client, click the Enroll button, which takes you to the TMP Enrollment screen.

If a client has already been enrolled and you need to change their enrollment status, click the Change Status button, which takes you to the TMP Enrollment Change Status screen.

The bottom half of the screen lists the client’s TMP service history in a table. The first column displays the voucher number used for the diagnostic test followed by the test type, the physician administering the test, when the client’s blood plasma was collected, and when the test result was recorded.

To edit a service entry, click the Edit button, or to enter a new a new test, click the New button. Either action takes you to the TMP Edit screen.

**TMP Enrollment**

In this screen, you can enroll eligible clients into TMP. First, make sure that you have selected TMP from the Program drop-down list. When you first enter a client the client’s Status defaults to “Enroll.”
In the Date text field, enter the date of enrollment. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar.

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

In the last text field, if the program uses separate IDs from your agency, enter the Client Program ID. You can also select the Auto-generate checkbox and ARIES will create an ID to assign the client.

From the Staff drop-down lists, select the staff persons who are assigned to the client’s TMP services. For instance, you may assign the client’s case manager as well as a counselor who specializes in TMP cases.

When you are finished click the Save button, which takes you to the client’s TMP Edit screen. To return to the TMP screen without saving changes, click the Cancel button.
**TMP Enrollment Change Status**

A client’s enrollment status in TMP can change based on their health status, ADAP status or any variety of reasons. When you change a client’s program status, a new entry will display at the bottom of a table of the programs the client is enrolled in.

### John A Porter Program Enrollment

<table>
<thead>
<tr>
<th>Program</th>
<th>Status</th>
<th>Date</th>
<th>Agency</th>
<th>Client Program ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>EIP</td>
<td>Active</td>
<td>10/5/2003</td>
<td>Parkland</td>
<td>1111</td>
</tr>
<tr>
<td>EIP</td>
<td>Disenrolled</td>
<td>3/4/2004</td>
<td>Parkland</td>
<td>2442</td>
</tr>
<tr>
<td>TMP</td>
<td>Enroll</td>
<td>10/1/2003</td>
<td>Parkland</td>
<td>2442</td>
</tr>
<tr>
<td>TMP</td>
<td>Disenroll</td>
<td>10/7/2004</td>
<td>Parkland</td>
<td>4225</td>
</tr>
</tbody>
</table>

**Reason** Left Service Area

**Staff**

**Staff 1** Jones, Mary

**Staff 2**

**Staff 3**

**Staff 4**

From the Status drop-down list, select the client’s new status:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enroll</td>
<td>A client’s initial status. They are currently receiving benefits from the program.</td>
</tr>
<tr>
<td>Disenroll</td>
<td>The client is no longer participating in the program.</td>
</tr>
<tr>
<td>Transitioned</td>
<td>The client’s status within the program has changed. For instance, if a client’s viral load decreases, they may not be eligible for the same number of services.</td>
</tr>
<tr>
<td>Medically Reactivated</td>
<td>The client was disenrolled due to a change in their health status. But due to another change in their health, they are again eligible for services.</td>
</tr>
<tr>
<td>Benefits Expired</td>
<td>The client has used all the benefits available to them in the program.</td>
</tr>
</tbody>
</table>

From the Reason drop-down list, select the reason for the client’s change in status. If the reason is not listed, select “Other” and enter the reason in the adjacent text field.

Use the Staff drop-down lists if you need to make changes to the client’s staff assignments for this program.
When you have finished entering changes, click Save to return to the TMP screen, or click Cancel to return without saving changes.

**TMP Edit**

TMP services are administered in the form of vouchers that are exchanged for HIV testing – either viral load or resistance tests.

**John A Porter Therapeutic Monitoring Program**

<table>
<thead>
<tr>
<th>Voucher Number</th>
<th>FL11</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voucher Type</td>
<td>Viral Load</td>
</tr>
<tr>
<td>Plasma Draw Site</td>
<td>OPC-AC</td>
</tr>
<tr>
<td>Submitting Physician</td>
<td>Dr. Henry Dittman</td>
</tr>
<tr>
<td>Email</td>
<td><a href="mailto:hdittman@ryanwhite.org">hdittman@ryanwhite.org</a></td>
</tr>
<tr>
<td>Income AGI</td>
<td>$12,000.00</td>
</tr>
<tr>
<td>Medical Record #</td>
<td>4499HC</td>
</tr>
</tbody>
</table>

In the TMP Service Edit screen, enter in the voucher number in the first text field, then use the Voucher Type drop-down list to select which kind of test the client received: viral load, genotypic resistance, or phenotypic resistance.

From the next drop-down list, select from which site the client had plasma drawn and then enter the name of the submitting physician and their email address in the next two text fields.

In the Income AGI text field, enter the client’s adjusted gross income. This is the client’s household’s annual income reduced by deductions (or allowances) for dependents, elderly households, medical expenses, disability assistance expenses, and childcare.

In the Medical Record # field, enter the client’s medical record number.
If the voucher is for a viral load test, under Viral Load Test Type drop-down list, select the type of viral load test the client received. If the client received a resistance test, skip this entry and select the type of resistance test: genotype or phenotype.

You must select this option before you select the provider name. Once you have chosen the resistance test type, use the Provider drop-down list to choose the test manufacturer name.

The last five questions relate to the client’s HIV status. If the client was first infected by HIV in the past two months, indicate so from the first drop down.

If the client is currently in an anti-retroviral therapy (ART) regime, in the next text field enter how many weeks they have been in it. If the client is not taking ART drugs, leave this field blank.

Use the drop-down lists to answer the last three questions about the client’s ART frequency and adherence.

When you have finished entering the service information, click the Save button to return to the TMP screen. If you wish to enter test results for this service, click the Save + Outcome button. Click Cancel to return to the TMP screen without saving changes or click Deactivate to remove the service entry from view.

**TMP Service Outcome Edit**

In this screen, enter the TMP testing information.
In the top half of the TMP Service Outcome Edit screen, enter the date and times of the plasma specimen collection, date and time plasma was frozen, and date and time of delivery, and testing. For date, use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar.

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

For time, use the format HH:MM AM/PM. For example: 4:30 PM.

Use the drop-down list to indicate whether the samples were handled correctly. Enter the lab accession number in the Lab Accession # text field.

If the client received a viral load test, enter the results under Viral Load Test. If the client’s viral results were undetectable, indicate so using the checkbox next to the viral test type.
If the client received resistance testing, enter the results in the Resistance Test section. Use the drop-down list next to each Result to indicate the class of drugs tested. Enter the results in the adjacent text box.

When you have finished entering the test results, click the Save button to return to the TMP screen. Click the Cancel button to return without saving changes.

**CMP/MCWP**

Case Management Program (CMP) and Medi-Cal Waiver Program (MCWP) provide home- and community-based services for persons with AIDS and symptomatic HIV infection whose cognitive and functional abilities are impaired. For eligibility information, consult the California Office of AIDS at: [http://www.dhs.ca.gov/aids/](http://www.dhs.ca.gov/aids/).

To access the CMP/MCWP screen, from a client’s information screen, click the Program tab from the top tier of tabs. From the second tier of tabs, select the CMP/MCWP tab. The screen is separated into two sections. The top portion shows the client’s program status in a table. Listed are the client’s status, the date of their last program update, the agency that enrolled them, their client ID, and the staff person assigned to them. Also included is the reason for disenrollment, if any.

To enroll a client, click the Enroll button, which takes you to the CMP/MCWP Enrollment screen. Before a client can be enrolled, their Medical information must first be complete (see page 117), including their CDC Disease Stage and viral load. To change
a client’s enrollment status, click the Change Status button, which takes you to the CMP/MCWP Enrollment Change Status screen.

The second half of the screen displays a table of the client’s assessments. CMP and MCWP clients are evaluated every 60 days on their HAART (highly active antiretroviral therapy) adherence. The first column lists the assessment dates; the second column indicates whether the client has not taken the HAART medications in the 48 hours before the assessment. The third column lists the client’s ability to take their HAART medications.

The MCWP Level of Care column lists the acuteness of the client’s condition. This information is collected at enrollment.

To change an assessment, click the Edit button next to the entry. To enter a new assessment, click the New button. Either action takes you to the CMP/MCWP Edit screen.

**CMP/MCWP Enrollment**

In this screen, you can enroll eligible clients into CMP or MCWP. You cannot enroll a client in either program until you have finished entering the client’s Medical information (see page 117), including their CDC Disease Stage and viral load information.

First, from the Program drop-down list select the program you are enrolling the client in. When you first enter a client the client’s Status defaults to “Enroll.”

In the Date text field, enter the date of enrollment. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar.
Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

In the last text field, if the program uses separate IDs from your agency, enter the Client Program ID. You can also select the Auto-generate checkbox and ARIES will create an ID to assign the client.

From the Staff drop-down lists, select the staff persons who are assigned to the client’s CMP or MCWP services. For instance, you may assign the client’s case manager as well as a counselor who specializes in MCWP cases.

When you are finished click the Save button, which takes you to the client’s CMP/MCWP Assessment screen. To return to the CMP/MCWP screen without saving changes, click the Cancel button.

**CMP/MCWP Enrollment Change Status**

A client’s enrollment status in CMP or MCWP can change based on their health status or any variety of reasons. When you change a client’s program status, a new entry will display at the bottom of a table of the programs the client is enrolled in.
From the Status drop-down list, select the client’s new status. A client can be disenrolled or re-enrolled.

From the Reason drop-down list, select the reason for the client’s change in status. If the reason is not listed, select “Other” and enter the reason in the adjacent text field.

Use the Staff drop-down lists if you need to make changes to the client’s staff assignments for this program.

When you have finished entering changes, click Save to return to the CMP/MCWP screen, or click Cancel to return without saving changes.

**CMP/MCWP Edit**

Clients enrolled in CMP or MCWP should be assessed every 60 days for their adherence to their HAART (highly active antiretroviral therapy) medications.

Enter the date of the assessment in the first text field. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar.
Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

From the first drop-down list, indicate if the client has missed any HAART over the previous two days (48 hours). If the client is not on an HAART regime, indicate so.

From the next drop-down, assess the client’s ability to take their HAART medications. If the client is not on an HAART regime, indicate so.

When you have finished, click the Save button to return to the CMP/MCWP screen, or click Cancel to return without saving any changes. Click the Deactivate button to remove the assessment from view.

If this is the client’s first assessment and they have just enrolled, enter the client’s diagnostic information. In the Date of Symptomatic HIV+ Diagnosis, enter the date the client first was diagnosed with symptomatic HIV or AIDS. Enter the earliest date of the two. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005.

Enter the client’s lowest CD4 count prior to or at CMP enrollment. Enter the date of this CD4 count. Next, enter the highest viral load count prior to or at CMP enrollment. Enter
the date of this viral load count. For date, use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005.

If the client is enrolling in MCWP, use the last drop-down list to indicate the client’s level of care. Select either “Acute” or “Nursing Facility.”

When you have finished, click the Save button to return to the CMP/MCWP screen, or click Cancel to return without saving any changes. Click the Deactivate button to remove the assessment from view.

CARE/HIPP

As part of the Ryan White CARE Act, the Health Insurance Premium Payment (CARE/HIPP) program was created. Funded by Title II of the CARE Act and administered by the California Office of AIDS, CARE/HIPP will pay the insurance premium costs for eligible clients with HIV or AIDS. CARE/HIPP cannot be used to purchase a new insurance policy.

To be eligible, clients must be HIV+, they must be Medi-Cal eligible with a share of cost no greater than $200, and they either have a current private health coverage policy or access to health coverage through an employer (includes COBRA and Cal-COBRA, but excludes policies issued through the California Managed Risk Medical Insurance Board (MRMIB)). Their policy must include coverage for the client’s HIV care.

Lastly, clients must not be enrolled in a Medi-Cal managed care plan nor enrolled in a County Organized Health Plan. For more information on eligibility, visit the California Department of Health Services website at: http://www.dhs.ca.gov/.

---

John A Porter

CARE/HIPP  Enroll  Change Status

<table>
<thead>
<tr>
<th>Program</th>
<th>Status</th>
<th>Date</th>
<th>Agency</th>
<th>Client ID</th>
<th>Staff</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CARE/HIPP</td>
<td>Active</td>
<td>10/18/2004</td>
<td>Parkland</td>
<td>1017</td>
<td>ARIES Admin</td>
<td></td>
</tr>
</tbody>
</table>

CARE/HIPP  Edit

Counselor: Helen Jones  (Parkland Health and Hospital System - AIDS Clinic)
650-555-2323, 650-555-1212  (fax)

<table>
<thead>
<tr>
<th>Insurance</th>
<th>Payee</th>
<th>Address</th>
<th>Premium</th>
<th>Client ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medical</td>
<td>Blue Cross</td>
<td>55 Main St. Palo Alto, CA 94301</td>
<td>$300.00</td>
<td>449955</td>
</tr>
<tr>
<td>Dental</td>
<td>Delta</td>
<td>22 State St. San Carlos, CA 94221</td>
<td>$50.00</td>
<td>994455</td>
</tr>
<tr>
<td>Vision</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Medical Pay Tax ID: 95-1234567
Type of Insurance Policy: Individual
To access the CARE/HIPP screen, from a client’s information screen, click the Program tab from the top tier of tabs. From the second tier of tabs, select the CARE/HIPP tab.

The screen is separated into two sections. The top portion shows the client’s program status in a table. Listed are the client’s status, the date of their last program update, the agency that enrolled them, their client ID, and the staff person assigned to them. Also included are any additional notes.

Click the Enroll button to enroll a new client, which takes you to the CARE/HIPP Enrollment screen. To change a client’s enrollment status, click the Change Status button, which takes you to the CARE/HIPP Enrollment Change Status screen.

The second half of the screen contains a table of the client’s HIPP insurance information. Above the table lists the name of the client’s HIPP counselor, the counselor’s agency, and contact number. Clicking the agency name takes you the Agency Detail screen.

The table columns include: insurance type, insurance company and address, monthly premium costs, and client ID number. Beneath the table are the Medical Pay Tax ID and whether the insurance is an individual or family policy.

To change or add insurance information, click the Edit button, which takes you to the CARE/HIPP Edit screen.

**CARE/HIPP Enrollment**

In this screen, you can enroll eligible clients into CARE/HIPP. Clients must have their insurance information entered before they can be enrolled.

To enroll a client, make sure that you have selected CARE/HIPP from the Program drop-down list. When you first enter a client, the client’s Status defaults to “Enroll.”

---

**John A Porter Program Enrollment**

<table>
<thead>
<tr>
<th>Program</th>
<th>Status</th>
<th>Date</th>
<th>Agency</th>
<th>Client Program ID</th>
<th>Auto-generate Client ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>CARE/HIPP</td>
<td>Enroll</td>
<td>10/5/2004</td>
<td>Parkland</td>
<td>1234</td>
<td></td>
</tr>
</tbody>
</table>

Staff 1: Jones, Mary

Staff 2

Staff 3

Staff 4

In the Date text field, enter the date of enrollment. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar.
Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

In the last text field, if the program uses separate IDs from your agency, enter the Client Program ID. You can also select the Auto-generate checkbox and ARIES will create an ID to assign the client.

From the Staff drop-down lists, select the staff persons who are assigned to the client’s CARE/HIPP services. For instance, you may assign the client’s case manager as well as a counselor who specializes in HIPP cases.

When you are finished click the Save button, which takes you back to the CARE/HIPP screen. To return without saving changes, click the Cancel button.

**CARE/HIPP Enrollment Change Status**

A client’s enrollment status in CARE/HIPP can change based on their insurance, financial status, or any variety of reasons. When you change a client’s program status, a new entry displays at the bottom of a table of the programs the client is enrolled in.
From the Status drop-down list, select the client’s new status. A client’s status can either be active or inactive.

From the Reason drop-down list, select the reason for the client’s change in status. If the reason is not listed, select “Other” and enter the reason in the adjacent text field.

Use the Staff drop-down lists if you need to make changes to the client’s staff assignments for this program.

When you have finished entering changes, click Save to return to the CARE/HIPP screen, or click Cancel to return without saving changes.

**CARE/HIPP Edit**

In this screen, enter the client’s HIPP and insurance information.
At the top of the screen, enter the client’s HIPP benefits counselor’s name, phone number, and fax number in the corresponding fields.

From the Agency drop-down list, select which agency the counselor is associated with.

In the table of fields, enter the client’s insurance information for their medical, dental, and vision insurance. For each, enter the insurance company name, the mailing address, the monthly insurance premium cost, and the client ID for the policy. If they do not have vision or dental policies, leave those fields empty.

In the Medical Payee Tax ID field, enter the tax ID of the insurance company.

From the Type of Insurance Policy drop-down list, select whether the client has an individual or family policy.

If the client is no longer active in the program, enter the disenrollment date in the next text field and indicate why from the Reason for Disenrollment drop-down list. If the reason is “Other,” specify why in the adjacent text field.

Months Remaining indicates how many months of CARE/HIPP coverage the client has remaining based on their enrollment date.

When you have finished entering your information, click Save to return to the CARE/HIPP screen, or click Cancel to return without saving changes.
MEDICARE PART D

Agencies can record a client’s Medicare Part D participation.

In California, all Medicare-eligible clients must enroll in Medicare Part D coverage or provide documentation of creditable coverage before enrolling in ADAP. ADAP will be able to help cover some of the out-of-pocket costs associated with Part D coverage. Persons who utilize ADAP to pay their Medicare drug plan costs will be required to apply for, and utilize Medicare’s “Extra Help” subsidy assistance. For more information visit the California Department of Health Services website at: http://www.dhs.ca.gov/. In other states, please contact your state’s ADAP or Medicare office for enrollment requirements.

To access the MEDICARE PART D screen, from a client’s information screen, click the Program tab from the top tier of tabs. From the second tier of tabs, select the MEDICARE PART D tab.

The screen is separated into two sections. The top portion shows the client’s program status in a table. Listed are the client’s status, the date of their last program update, the agency that enrolled them, their client ID, and the staff person assigned to them. Also, included are any additional notes.

Click the Enroll button to enroll a new client, which takes you to the MEDICARE PART D enrollment screen. The client must be HIV+ or have AIDS, and must have a “Medicare D” insurance entry on the Eligibility tab. To change a client’s enrollment status, click the Change Status button, which takes you to the MEDICARE PART D Enrollment Change Status screen.

The second half of the screen contains a table of the client’s MEDICARE PART D insurance information. The table elements include the following: ADAP Client ID, Payee Name, Payee Tax ID, monthly premium costs, client ID number, Type of Insurance and Low Income Subsidy application status.

MEDICARE PART D Enrollment

In this screen, you can enroll eligible clients into MEDICARE PART D. Clients must have their insurance information entered before they can be enrolled.
To enroll a client, make sure that you have selected MEDICARE PART D from the Program drop-down list. When you first enter a client, the client’s Status defaults to “Enroll.”

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

In the last text field, if the program uses separate IDs from you agency, enter the Client Program ID. You can also select the Auto-generate checkbox and ARIES will create an ID to assign the client.

From the Staff drop-down lists, select the staff persons who are assigned to the client’s MEDICARE PART D services.

When you are finished click the Save button, which takes you back to the MEDICARE PART D screen. To return without saving changes, click the Cancel button.

**MEDICARE PART D Enrollment Change Status**

A client’s enrollment status in MEDICARE PART D can change based on their insurance, financial status, or any variety of reasons. When you change a client’s program
status, a new entry displays at the bottom of a table of the programs the client is enrolled in.

From the Status drop-down list, select the client’s new status. A client’s status can either be active or inactive.

From the Reason drop-down list, select the reason for the client’s change in status. If the reason is not listed, select “Other” and enter the reason in the adjacent text field.

Use the Staff drop-down lists if you need to make changes to the client’s staff assignments for this program.

When you have finished entering changes, click Save to return to the MEDICARE PART D screen, or click Cancel to return without saving changes.

**MEDICARE PART D Edit**

In this screen, enter the client’s MEDICARE PART D insurance information.
In the table of fields, enter the client’s ADAP Client ID, Payee Name, Payee Tax ID, monthly premium amount and Client ID. Select the Type of Insurance from the drop down list and enter the client’s application status for Low Income Subsidy.

When you have finished entering your information, click Save to return to the MEDICARE PART D screen, or click Cancel to return without saving changes.

**Medical**

One of the key elements of the client intake process is getting an accurate medical overview of the client. Many programs provide services based on a wide variety of health criteria. Having a full medical background of the client ensures that they receive all the benefits they are eligible for. Also, the information helps clinicians deliver the most effective treatment and care.

From the Client Info screen, click the Medical tab to access the client’s medical information. The Medical screen contains tabs for:

- Basic Medical
- Medical History
- OB/GYN & Pregnancy
Basic Medical

The Basic Medical screen appears first when you click the Medical tab from the Client Detail screen. This screen contains the client’s medical background including their primary healthcare providers and HIV status.

<table>
<thead>
<tr>
<th>primary keys</th>
<th>details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Medical Care/Provider</td>
<td>Where the client receives their basic medical services. Also listed is the date of the client’s last visit, if available.</td>
</tr>
<tr>
<td>Primary HIV Care/Provider</td>
<td>Where the client receives HIV medical services. Also listed is the date of the client’s last visit, if available.</td>
</tr>
<tr>
<td>CDC Disease Stage</td>
<td>The severity of the client’s HIV infection.</td>
</tr>
<tr>
<td>Acuity</td>
<td>Your agency’s assessment of HIV severity. The most current acuity score is shown. To view all acuity score entries, click on the Edit button.</td>
</tr>
<tr>
<td>Medically able to work</td>
<td>If the client is unable to work, they may be eligible for certain benefits.</td>
</tr>
<tr>
<td>Current Weight/Usual Weight</td>
<td>The difference in the client’s usual and current weight is used as an assessment tool. The most current weight is shown. To view all client weights, click on the Edit button.</td>
</tr>
<tr>
<td>AIDS Diagnosis</td>
<td>This indicates whether the client has been diagnosed with AIDS. The date and testing method are also indicated.</td>
</tr>
</tbody>
</table>
Year First Tested HIV+ | The year the client received their first positive HIV test result. If a specific date is available, enter the value in the Date First HIV+ field and ARIES will automatically populate the Year First Tested HIV+ field.

Partner Notification Offered | This indicates whether your agency has offered the client to notify their previous sexual partners of their HIV status. Also listed is the date the service was offered.

# Partners notified to be by client | How many sexual partners the client will inform of their HIV status.

# Partners notified to be by health dept. | Departments of health have partner notification programs where sexual partners of HIV-infected people are notified anonymously. Indicates how many sexual partners the health department will inform of the client's HIV status.

Date health dept. notified | Indicates the date the health department was notified of need to contact the client's partners.

Other Chronic Medical Conditions | Any health conditions the client experiences not listed elsewhere.

Near the bottom of the screen is a table that lists any AIDS defining conditions, when the client was diagnosed with the condition, and when they received treatment for the condition.

Below that is a table that lists the client’s HIV testing history including when and where they received testing, the results of the test, and whether pre- and post-test counseling was offered.

To change or add any basic medical information, click the Edit button.

**Basic Medical Edit**

In this screen, you can change or add any basic medical information about the client. To access this screen, from the Client Detail screen, click the Medical tab from the top row of tabs, then click the Basic Medical tab from the second row of tabs.
At the top of the screen, list the client’s primary medical and HIV care information. Select the type of care facility from the drop-down list:

<table>
<thead>
<tr>
<th>Alternative/complementary care</th>
<th>Clients may use non-traditional therapies as their primary care choice. These choices may include acupuncture, homeopathy, herbal medicine, chiropractic therapy, and aromatherapy.</th>
</tr>
</thead>
<tbody>
<tr>
<td>County medical and DPH Clinics</td>
<td>Publicly funded healthcare including county medical hospitals and department of health clinics.</td>
</tr>
<tr>
<td>Community based clinics, public</td>
<td>Local clinics – publicly funded.</td>
</tr>
<tr>
<td>Community based-clinics, private</td>
<td>Local clinics – privately funded.</td>
</tr>
</tbody>
</table>
HMO hospital/clinics | Health maintenance organizations like Kaiser.
--- | ---
VA hospital, CHAMPUS | Veterans hospitals or Civilian Health and Medical Program of the Uniformed Services (CHAMPUS).
Federally qualified health center/hospital | Health centers and hospitals that have been federally qualified.
Other | The client receives primary care from another type of provider.
Private MD | Private doctors or hospitals.
Emergency room | The client receives emergency room care.
No primary care | The client has no primary care.
Unknown | The client’s primary care provider status is not known.

Enter the location and phone number of the primary provider and the date of the client’s most recent visit. For dates use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.”

From the CDC Disease Stage drop-down list, select the entry that most closely describes the client’s current HIV status:

| HIV Negative | The client tested negative for HIV. |
| HIV positive, disease stage unknown | The client tested positive for HIV and does not know the stage of infection. |
| HIV positive, asymptomatic | The client is HIV+ but experiences no symptoms associated with HIV. |
| HIV positive, symptomatic, not AIDS | The client is HIV+, experiences HIV-related symptoms, but does not meet the CDC definition of AIDS. |
| HIV positive, disabling | The client is HIV+, does not meet the CDC definition of AIDS, but is incapacitated by HIV-related symptoms. |
| CDC-Defined AIDS | The client is HIV+ and matches the criteria for AIDS set by the Centers for Disease Control and Prevention (CDC). |
| Disabling AIDS | The client is HIV+, matches the criteria for AIDS set by the Centers for Disease Control and Prevention (CDC), and is incapacitated by their illness. |
Pediatric indeterminate | A child under age 2 who was born to an HIV-infected mother but whose HIV status is not yet definite.
---|---
Unreported | The client’s HIV status was not assessed.
Unknown | The client’s HIV status is not known.

From the Source drop-down list, choose from where the client’s HIV status was reported. In the Year First HIV+ text field, enter the year the client first tested positive for HIV. If the client has AIDS, indicate the diagnosis date, location, and source of diagnosis in the corresponding text fields. If the client does not have AIDS, leave the fields blank.

**HIV Tests**

The HIV Tests table lists the client’s HIV test results. These results are not client self-reported; documentation must be provided with each test result. To edit an existing entry, click Edit. To enter a new test result, click the New button. If not all information is available in the documentation, fill in as much as possible and leave any missing fields empty.

Enter the date of the test in the first column. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.” You can also use the pop-up calendar.
Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

In the second column, select the test result from the drop-down list. Select either “Positive,” “Negative,” or “Indeterminate.”

Enter the county and state where the test was given in the next two fields. In the Source column, enter the name of the testing facility. In the counseling columns, select whether the client received pre- and post-test counseling. If they received counseling, indicate the date of the test in the accompanying text fields.

Click the Save button when you are finished. Click the Cancel button to return to the Basic Medical Edit screen without saving changes. To remove an entry from view, click the Deactivate button.

**AIDS Defining Conditions**

This table lists any AIDS defining conditions the client has been diagnosed with as they appear in the Centers for Disease Control and Prevention HIV case report form. For more information visit the HIV/AIDS Treatment Information Service (ATIS) website at [http://www.hivatis.org](http://www.hivatis.org).

To edit an existing entry, click the Edit button. To add a new entry, click the New button.

From the first drop-down list, select the AIDS defining condition the client has been diagnosed with.
The drop-down list includes:

- Bacterial infections, multiple or recurrent (<13 only)
- Candidiasis, bronchi, trachea, or lungs
- Candidiasis, esophageal
- Carcinoma, invasive cervical (Adult only)
- Coccidioidomycosis, disseminated or extrapulmonary
- Cryptococcosis, extrapulmonary
- Cryptosporidiosis, chronic intestinal (>1 month duration)
- Cytomegalovirus disease (other than in liver, spleen, or nodes)
- Cytomegalovirus retinitis (with loss of vision)
- HIV encephalopathy
- Herpes simplex: ulcers >1 mo; bronchitis/pneumonitis/esophagitis
- Histoplasmosis, disseminated or extrapulmonary
- Isosporiasis, chronic intestinal (>1 month duration)
- Kaposi’s sarcoma
- Lymph interstitial pneumonia, pulmonary hyperplasia (<13 only)
- Lymphoma, Burkitt’s (or equivalent term)
- Lymphoma, immunoblastic (or equivalent term)
- Lymphoma, primary in brain
- MAC or M. kansasii, disseminated or extrapulmonary
- M. tuberculosis, pulmonary (Adult only)
M. tuberculosis, disseminated or extrapulmonary
Mycobacterium of other/unknown species, dissem. or extrapul.
Pneumocystis carinii pneumonia
Pneumonia, recurrent, in 12-month period (Adult only)
Progressive multifocal leukoencephalopathy
Salmonella septicemia, recurrent (Adult only)
Toxoplasmosis of brain
Wasting syndrome due to HIV

If the condition is not listed, enter the condition in the Other text field.

Enter the date the client was diagnosed with the AIDS defining condition and enter when they received treatment. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.” Click the Save button when you are finished or the Cancel button if you wish to return to the Basic Medical Edit screen without saving changes. If you wish to remove an existing entry from view, click the Deactivate button.

**Additional Basic Medical**

In the lower half of the page, enter additional basic medical information. Fill in as much information that is available. Enter the date the information was recorded in the accompanying text field on the right. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.”

Below are the field descriptions:

<table>
<thead>
<tr>
<th>Partner Notification Offered</th>
<th>If your agency provides a notification service where sexual partners are informed of the client’s HIV status,</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

**ARIES User Manual**

129
<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td># Partners to be notified by client</td>
<td>Indicate how many sexual partners the client will inform of their HIV status.</td>
</tr>
<tr>
<td># Partners notified by health dept.</td>
<td>Departments of health have partner notification programs where sexual partners of HIV-infected people are notified anonymously. Enter how many of the client’s partners will be informed by this method.</td>
</tr>
<tr>
<td>Date health dept. notified</td>
<td>Enter the date the health department was notified of the need to contact the client’s partners.</td>
</tr>
<tr>
<td>Acuity History</td>
<td>Enter your agency’s assessment of client’s HIV severity. If your agency uses an online acuity tool, you can access it by clicking the Acuity Tool link. The acuity History section can keep a running list of all the client’s acuity scores, such as Karnofsky/CFA or Pediatric Scale or any other type of acuity score your agency uses. To enter a new acuity score, click on the New button. When you have finished entering data, click the Save button of the Cancel button if you wish to return to the Basic Medical Edit screen without saving changes.</td>
</tr>
<tr>
<td>Medically able to work</td>
<td>If the client is unable to work, indicate so from the pull-down list.</td>
</tr>
<tr>
<td>Current Weight/Usual Weight</td>
<td>The difference in the client’s usual and current weight is used as an assessment tool. Enter the client’s current weight and their normal weight. To enter a client’s current weight, click on the New button. When you have finished, click the Save button of the Cancel button if you wish to return to the Basic Medical Edit screen without saving changes.</td>
</tr>
<tr>
<td>Other Chronic Medical Conditions</td>
<td>Enter any health conditions the client experiences not listed elsewhere.</td>
</tr>
</tbody>
</table>

When you are finished entering the client’s basic medical information, click the Save + Next button to proceed to the client’s Medical History Edit screen. If you have no more information to enter, click the Save + Done button to return to the client’s Basic Medical screen. Click the Cancel button to return the client’s Basic Medical screen without saving any changes.

**Medical History**

Clicking on the Medical History tab from the Medical screen brings up the client’s HIV-related medical history. To access this screen, from the Client Detail screen, click the
Medical tab from the top row of tabs, then click the Medical History tab from the second row of tabs.

The Medical History information includes:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Most recent CD4</td>
<td>The most current CD4+ T-lymphocyte count including the date of testing and the lymphocyte percentage.</td>
</tr>
<tr>
<td>Lowest CD4</td>
<td>The lowest recorded CD4+ T-lymphocyte count including the date of testing and the lymphocyte percentage.</td>
</tr>
<tr>
<td>Most recent Viral Load</td>
<td>The most recent viral load test (VLT) results including the date of testing and the log value.</td>
</tr>
<tr>
<td>Highest Viral Load</td>
<td>The highest viral load test (VLT) result including the date of testing and the log value.</td>
</tr>
<tr>
<td>TB Test Medically Indicated</td>
<td>The client’s medical condition/history indicate a TB test should be done.</td>
</tr>
<tr>
<td>TB PPD Skin Test</td>
<td>The result of the client’s tuberculosis purified protein derivative (TB PPD) test. The first date indicates when the test was administered; the second date indicates when the skin test was read.</td>
</tr>
<tr>
<td>MDR</td>
<td>If a client tests positive for tuberculosis, tests can be performed evaluating the drug resistance of the mycobacterium strain. This indicates the result of multi-drug resistance (MDR) testing.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Chest X-Ray</td>
<td>Chest X-rays are used to diagnose tuberculosis. This entry indicates the date and result of the X-ray.</td>
</tr>
<tr>
<td>TB Treatment Status</td>
<td>Indicates what steps have been taken for tuberculosis treatment.</td>
</tr>
<tr>
<td>STI/HEP Table</td>
<td>This table lists the types, dates and results of the client’s sexually transmitted infections and hepatitis testing. Also listed is the date of any treatment received and completed.</td>
</tr>
<tr>
<td>Immunization Table</td>
<td>This table lists immunizations the client has received including the date of immunization.</td>
</tr>
<tr>
<td>Hospital Visit Table</td>
<td>This table lists any emergency room or hospital visits the client has had and the dates. The Reason column indicates whether the visit was HIV-related or not. Also, if the client was hospitalized, the number of hospitalization days is listed.</td>
</tr>
</tbody>
</table>

To edit the record or add new information, click the Edit button, which takes you to the Medical History Edit screen.

**Medical History Edit**

This screen allows you to edit existing and enter new information regarding the client’s medical history. It is separated into three sections: Tests, Immunizations, and ER/Hospital Visits.
Tests

The Tests section lists the client’s HIV-related and STI test results.

<table>
<thead>
<tr>
<th>CD4 Date</th>
<th>T Cell Count</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>9/27/2002</td>
<td>400</td>
<td>33%</td>
</tr>
</tbody>
</table>
The first table lists CD4 test results. To change an existing entry click Edit or click the New button to enter a new result.

In the first text field enter the date the CD4 test was administered. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.” You can also use the pop-up calendar.

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

In the second column, enter the client’s T-cell count. In the next column, enter the client’s T-lymphocyte percentage. Click the Save button to return to the Medical History Edit screen. Click Cancel to return to the Medical History Edit screen without saving changes. Click the Deactivate button to remove an entry from view.
The table to the right of the CD4 test results table lists the client’s viral load test (VLT) results. Click the New button to enter a new test result or click the Edit button to change an existing entry.

Enter the date of the test. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.” In the Value column, enter the VLT test result. The number must be between 0 and 2,000,000. If the value is inexact or if it exceeds the range accepted, use the Relation drop-down list. If the VLT is less than the value entered, select “<”. If the VLT is greater than the value entered, select “>”. Otherwise, select “=”.

Select the appropriate viral load Test Type from the drop down list, if known. When you click the Save button, ARIES calculates the log value and enters it in the last column.

To return to the Medical History Edit screen without saving changes, click the Cancel button. To remove an entry from view, click the Deactivate button.

The third table in the Tests section lists the results of any sexually transmitted infections (STI) and hepatitis tests.

To enter a new result, click New, or click Edit to change an existing entry. The table columns headings are as follows:

<p>| STI/Hepatitis | From this drop-down list, select which test the client received: genital herpes, gonorrhea, human papillomavirus (HPV), syphilis, chlamydia, non-specific urethritis, or hepatitis A, B, or C. |</p>
<table>
<thead>
<tr>
<th>Test Date</th>
<th>Enter when the test was given.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnosis</td>
<td>From this drop-down list, select the result of the test: positive diagnosis, negative diagnosis, presumptive, indeterminate, or unknown.</td>
</tr>
<tr>
<td>Lab Value</td>
<td>If the test result includes a lab value, enter the number here.</td>
</tr>
<tr>
<td>Tx Ind?</td>
<td>Use this drop-down list to indicate if a treatment was indicated or not. If the client refused indicated treatment, select “patient refused.”</td>
</tr>
<tr>
<td>Treatment Start Date</td>
<td>If the client tested positive, enter the date they began treatment. If the client tested negative, leave this field empty. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.” You can also use the pop-up calendar.</td>
</tr>
<tr>
<td>Treatment End Date</td>
<td>Enter the date the client completed their treatment. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.” If the client is still undergoing treatment, leave the field empty.</td>
</tr>
<tr>
<td>Completed</td>
<td>From the drop-down list, indicate whether the treatment was finished or not. Or select “Unknown” if the information is unavailable.</td>
</tr>
</tbody>
</table>
Click Save when you are finished or Cancel to return to the Medical History Edit screen without saving changes. To remove an entry from view, click the Deactivate button.

The last form in the Tests section contains the results of the client’s tuberculosis tests. The fields include:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TB Test Medically Indicated</td>
<td>Use the drop-down list to indicate if the client’s PPD/TST was medically indicated or not. If the client refused TB testing, select “Pt Refused.”</td>
</tr>
<tr>
<td>TB Test Medically Indicated Date</td>
<td>Enter the date when the TB test was medically indicated.</td>
</tr>
</tbody>
</table>
**Date PPD/TST Placed**
Enter the date the purified protein derivative tuberculosis skin test (PPD/TST) was placed. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.” You can also use the pop-up calendar.

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

**Date PPD/TST Read**
Enter the date the PPD/TST test was read. This date should be at least 2-3 days after the date the test was placed.

**PPD/TST Result**
Select the PPD/TST result selection from the drop-down list, either reactive or non-reactive.

**Chest X-Ray Date**
Enter the date the client received a chest X-ray.

**Chest X-Ray Result**
Use the drop-down list to select the result of the chest X-ray, either positive or negative.

**TB Diagnosis**
Use the drop-down list to select the tuberculosis diagnosis: none, active, inactive, history of positive PPD, or unknown.

**Date of TB Diagnosis**
Enter the date of the tuberculosis diagnosis.

**Treatment Start Date**
Enter the start of tuberculosis treatment.

**Multi-Drug Resistance**
Use the drop-down list to select the result of any multi-drug resistance (MDR) tests, either yes or no.
### Treatment End Date
Enter the end of tuberculosis treatment. If the client is currently receiving treatment, leave this field blank.

### Treatment Type
Click on the Edit button to edit an existing TB treatment entry or click the New button to make a new TB treatment type and treatment status entry. Use the drop down to select the client’s treatment type. If the client tested negative, select N/A. Otherwise, select treatment, prophylaxis (preventative care), none, or unknown. Use the drop down to select the client’s treatment status. If the client tested negative, select N/A. Otherwise, select treatment, prophylaxis (preventive care), none, or unknown. When you are finished, click the Save button or click the Cancel button to return to the Medical History Edit screen without saving your changes. If you wish to remove an entry from view, click the Edit button and then click the Deactivate button. Deactivating a record removes it from view and future editing.

### Immunizations
The immunization table lists all immunizations the client has received.

<table>
<thead>
<tr>
<th>Immunization Type</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flu</td>
<td>10/28/2003</td>
</tr>
</tbody>
</table>

Click Edit to change an existing entry or click New to create a new entry.

<table>
<thead>
<tr>
<th>Hepatitis B</th>
<th>6/30/2001</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hepatitis A</td>
<td></td>
</tr>
<tr>
<td>Bacille Calmette-Guerin (BCG)</td>
<td></td>
</tr>
<tr>
<td>PCP</td>
<td></td>
</tr>
</tbody>
</table>

From the drop-down list, select which immunization the client received: hepatitis A or B, pneumovax, tetanus, Bacille Calmette-Guerin (BCG), flu, or Pneumocystis carinii.
pneumonia (PCP). Enter the date of immunization in the corresponding Date text field. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.” You can also use the pop-up calendar.

![June 2005 Calendar]

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

Click Save when you are finished or Cancel to return to the Medical History Edit screen without saving changes. To remove an entry from view, click the Deactivate button.

**ER/Hospital Visits**

The bottom of the Medical History Edit screen contains a table of the client’s emergency room and hospital visits. To create a new entry, click the New button. Click the Edit button to change an existing record.

<table>
<thead>
<tr>
<th>Date</th>
<th>ER Visit</th>
<th>Reason</th>
<th>Hospitalized</th>
<th>If hospitalized, # of days</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/10/2004</td>
<td>Yes</td>
<td>OI (HIV/AIDS)</td>
<td>Yes</td>
<td>3</td>
</tr>
<tr>
<td>8/10/2004</td>
<td>Yes</td>
<td>Not HIV/AIDS Related</td>
<td>No</td>
<td>0</td>
</tr>
</tbody>
</table>

In the first column, enter the date of the visit. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.” You can also use the pop-up calendar.
Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

In the ER Visit column, select the checkbox if the visit was to an emergency room. From the reason drop-down, select why the client made the visit:

<table>
<thead>
<tr>
<th>Reason</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HIV Related, no OI</td>
<td>If the client visited the hospital or ER due to an HIV-related condition, but there was no opportunistic infection (OI).</td>
</tr>
<tr>
<td>AIDS Related, no OI</td>
<td>If the client visited the hospital or ER due to an AIDS-related condition, but there was no opportunistic infection (OI).</td>
</tr>
<tr>
<td>OI (HIV/AIDS)</td>
<td>If the visit was prompted by an opportunistic infection.</td>
</tr>
<tr>
<td>Not HIV/AIDS Related</td>
<td>If the visit was not related to HIV or AIDS.</td>
</tr>
<tr>
<td>Other</td>
<td>For all other visits.</td>
</tr>
</tbody>
</table>

Select the Hospitalized checkbox if the client was admitted to the hospital overnight for at least one day. Indicate how many days in the next text field.

Click Save when you are finished or Cancel to return to the Medical History Edit screen without saving changes. To remove an entry from view, click the Deactivate button.
When you are finished entering in Medical History information, click Save + Next at the bottom of the screen to proceed to the ART Medication screen. If the client is female, you will be prompted to continue to the Edit OB/GYN & Pregnancy screen.

Click Save + Done if you are finished entering information. Click Cancel to return to the client’s Medical History screen without saving any changes.

**OB/GYN & Pregnancy**

ARIES maintains obstetric and gynecologic data for female clients. As HIV+ patients are at a higher risk for cervical cancer, this information can be valuable in the client’s treatment. Also, pregnant HIV+ women have a high risk of passing on an infection to their unborn infants. Keeping track of this data is important should the infants require services.

To access the OB/GYN & Pregnancy screen, select the Medical tab from the client’s tab bar and then select OB/GYN & Pregnancy from the lower tab bar.

The screen lists the client’s primary OB/GYN doctor and the results and dates of any pap smear tests or pelvic exams.

The pregnancy history table lists details about all known pregnancies of the client while she was infected with HIV. The table rows include:

<table>
<thead>
<tr>
<th>Pregnancy History</th>
<th>Record #1</th>
<th>Record #2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date first reported pregnant</td>
<td>4/20/1997</td>
<td>6/22/2000</td>
</tr>
<tr>
<td>Approximate Conception Date</td>
<td>2/20/1997</td>
<td>5/1/2000</td>
</tr>
<tr>
<td>Mother’s HIV Diagnosis</td>
<td>HIV positive after conception</td>
<td>HIV positive prior to pregnancy</td>
</tr>
<tr>
<td>Number of Prenatal Care Visits</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>ART Counseling to prevent HIV transmission to infant</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Date Counseling Offered</td>
<td>6/20/1997</td>
<td></td>
</tr>
<tr>
<td>ART Offered</td>
<td>Yes</td>
<td>Unknown</td>
</tr>
<tr>
<td>Date Started ART Treatment</td>
<td>6/15/1997</td>
<td></td>
</tr>
<tr>
<td>Pregnancy Outcome</td>
<td>Live birth</td>
<td>Therapeutic (induced) abortion</td>
</tr>
<tr>
<td>Outcome Date</td>
<td>11/20/1997</td>
<td>6/22/2000</td>
</tr>
<tr>
<td>Newborn HIV Status</td>
<td>Negative</td>
<td></td>
</tr>
</tbody>
</table>

To access the OB/GYN & Pregnancy screen, select the Medical tab from the client’s tab bar and then select OB/GYN & Pregnancy from the lower tab bar.

The screen lists the client’s primary OB/GYN doctor and the results and dates of any pap smear tests or pelvic exams.

The pregnancy history table lists details about all known pregnancies of the client while she was infected with HIV. The table rows include:

<table>
<thead>
<tr>
<th>Date first reported pregnant</th>
<th>The date the client first learned that she was pregnant.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approximate Conception Date</td>
<td>The estimated date of conception.</td>
</tr>
<tr>
<td>Mother’s HIV diagnosis</td>
<td>Indicates whether the mother was HIV+ before pregnancy or was infected after conception.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Prenatal Care First Sought</td>
<td>The date the client first accessed prenatal care.</td>
</tr>
<tr>
<td>Number of Prenatal Care Visits</td>
<td>The number of visits the client made for prenatal care.</td>
</tr>
<tr>
<td>ART Counseling to prevent HIV transmission to infant</td>
<td>Whether or not the client received antiretroviral therapy (ART) counseling regarding HIV transmission and pregnancy.</td>
</tr>
<tr>
<td>Date Counseling Offered</td>
<td>The date the counseling was offered.</td>
</tr>
<tr>
<td>ART Offered</td>
<td>Whether the client was offered antiretroviral therapy (ART).</td>
</tr>
<tr>
<td>Date Started ART Treatment</td>
<td>The date the client started antiretroviral therapy treatment, if applicable.</td>
</tr>
<tr>
<td>Pregnancy Outcome</td>
<td>The outcome of the pregnancy.</td>
</tr>
<tr>
<td>Outcome Date</td>
<td>The date the pregnancy ended.</td>
</tr>
<tr>
<td>Newborn HIV Status</td>
<td>The HIV status of the newborn.</td>
</tr>
</tbody>
</table>

To change or enter new entries, click the Edit button.

**Edit OB/GYN & Pregnancy**

In this screen you can edit and add OB/GYN and pregnancy information for the client.
In the text fields in the upper left corner, enter the client’s primary OB/GYN healthcare provider and their phone number. If the provider is strictly an OB/GYN practitioner, select the checkbox indicating so.

In the upper right of the screen is a table listing the client’s pap smear and pelvic exam results. To change an existing entry, click the Edit button. To enter a new exam result, click the New button.
In the first text field, enter the date of the exam. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.” You can also use the pop-up calendar.

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

In the second text field, enter the result of the exam. When you are finished, click the Save button or click Cancel to return to the OB/GYN & Pregnancy Edit screen without saving changes. Click the Deactivate button to remove an entry from view.

The bottom part of the screen lists a table of the client’s pregnancies. Each column represents one pregnancy. To create a new entry, click the New button. Click the Edit button to change an existing record.
The fields include:

<table>
<thead>
<tr>
<th>Date first reported pregnancy</th>
<th>Enter the date the client first learned that she was pregnant. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approximate Conception Date</td>
<td>Enter the estimated date of conception.</td>
</tr>
<tr>
<td>Mother’s HIV status during pregnancy</td>
<td>Use the drop-down list to indicate whether the mother was HIV+ before pregnancy or was infected after conception.</td>
</tr>
<tr>
<td>Prenatal Care First Began</td>
<td>Enter the date the client first accessed prenatal care.</td>
</tr>
<tr>
<td>Number of Prenatal Care Visits in Reporting Visit</td>
<td>Enter the number of visits the client made for prenatal care.</td>
</tr>
<tr>
<td><strong>ART Counseling to reduce HIV transmission to infant</strong></td>
<td>Use the drop-down list to indicate whether or not the client received antiretroviral therapy (ART) counseling regarding HIV transmission and pregnancy.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>Date Received ART Counseling</strong></td>
<td>Enter the date the counseling was received.</td>
</tr>
<tr>
<td><strong>ART Offered</strong></td>
<td>Use the drop-down list to indicate whether the client was offered antiretroviral therapy (ART).</td>
</tr>
<tr>
<td><strong>Date Started ART Treatment</strong></td>
<td>Enter the date the client started antiretroviral therapy treatment, if applicable.</td>
</tr>
<tr>
<td><strong>Pregnancy Outcome</strong></td>
<td>Use the drop-down list to enter the outcome of the pregnancy.</td>
</tr>
<tr>
<td>Live birth</td>
<td>The infant was born.</td>
</tr>
<tr>
<td>Therapeutic abortion</td>
<td>The client had an induced abortion.</td>
</tr>
<tr>
<td>Spontaneous abortion</td>
<td>The client miscarried.</td>
</tr>
<tr>
<td>Stillbirth</td>
<td>The infant was dead at birth.</td>
</tr>
<tr>
<td>Unknown</td>
<td>The outcome is unknown.</td>
</tr>
<tr>
<td><strong>Outcome Date</strong></td>
<td>The date the pregnancy ended.</td>
</tr>
<tr>
<td><strong>Newborn HIV Status</strong></td>
<td>The HIV status of the newborn.</td>
</tr>
</tbody>
</table>

Click the Save button when you are finished. Or click the Cancel button to return to the OB/GYN & Pregnancy screen without saving any changes. Click the deactivate button to remove any existing entries from view.

When you are finished entering in OB/GYN and pregnancy information, click the Save + Next button to continue to the client’s Medications screen. Click Save + Done if you have no more information to enter. Click Cancel to return to the client’s OB/GYN & Pregnancy screen without saving any changes.

**Medical History Flowsheet**

The Flowsheet is a longitudinal medical history report for a client, over a specified time period. In ARIES, the user may select the medical history elements to include on the Flowsheet from a list of longitudinal data maintained in ARIES. This report allows agency staff to view a client’s medical history over time to evaluate the client’s health progress.
To access the Flowsheet, from the ARIES menu bar at the top of the ARIES screen, choose the Find → Client menu item, which takes you to the Client Search screen. Search for the client you want to create the flowsheet for. After selecting the client, click on the Medical tab on the top tier and then click on the Medical History tab on the lower tier.

![Medical History](image)

**Paula F Bevins**

**Medical History**

- **Most recent CD4**: 700 as of 10/16/2006
- **Lowest CD4**: 700 as of 10/16/2006
- **Most recent Viral Load**: 1,000,000 as of 10/12/2006, 6, Roche PCR Standard
- **Highest Viral Load**: 1,000,000 as of 10/12/2006, 6, Roche PCR Standard
- **TB Test Medically Indicated**: Yes 5/1/2006
- **TB PPD Skin Test**: 5/1/2006, Non-reactive, read 5/22/2006
- **MDR**: No
- **Chest X-Ray**: 6/29/2006, Negative
- **TB Treatment**: (Type: Treatment, Status: In progress, Date: 10/5/2006)

On the Medical History review screen, click on the Flowsheet button to create a new flowsheet.
Use the Date filter to report on a specific time span for the client’s medical history. From the drop-down list, select the type of filter you want to perform. You can search on, before or after a date, or between two dates.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.
Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for records on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all entries before – but not including – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve records dated before midnight on June 22, 2005.

Select “After” to bring up all records dated after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all records from 12:00 AM on the first date to 11:59 PM on the second date. For example, entering 6/23/2005 in the first text field and 6/27/2005 in the second text field and clicking Search will display all records on June 23, 2005 through June 27, 2005.

Select, by checking each box, the medical data elements to include on the flowsheet.

After selecting the Medical data elements, click on the Report button to display the client’s flowsheet on the screen. To display the report in print format, check the Display Print Format box.

The results screen displays a table of the client’s medical data elements by the date filter selected. The first column represents the date of the medical information in ascending date order and the proceeding columns represent the medical data elements that were selected in the flowsheet setup.

To export your flowsheet report, click the Export button
Medications

In order to give clients proper care, it is necessary to know what medications they are taking and what has worked for them in the past. Whether provided by your agency or through other means, a full account of a client’s medications is invaluable to your agency’s clinicians. Redundant prescriptions and hazardous drug interactions can be avoided with careful record keeping. Also, it is important to know how well the client responds to certain therapies and drugs and whether they adhere to the treatments prescribed to them. For instance, if a doctor knows that a client frequently forgets to take medication, they will be more inclined to prescribe a once-daily protease inhibitor over a twice-daily one. Try to be as detailed as possible when you record a client’s medication history.

Clicking the Medications tab from the Client Details screen takes you to the ART medications screen, which lists all of the anti-retroviral therapy drugs the client has been prescribed.

The top of the screen lists the pharmacies used by the client and any known allergies the client has. The “Adherence to ART Medications” indicates how often, over a three-day period, the client followed the prescribed ART medications. If it lists “2 day(s),” that means that the client has taken his ART drugs at the proper time and in the prescribed dosage for two of the three previous days from when they were questioned.

“Adherence to HIV Treatment” lists an estimation of how closely the client has followed the prescribed anti-retroviral therapy for the previous four weeks.

Some HIV+ clients are infected by mutated strains that are resistant to certain anti-retroviral drugs. “Resistance Testing Performed” indicates whether or not the client has received testing for HIV drug-resistance.
The ART Therapy table lists anti-retroviral therapies the client has received and when they were prescribed. The Anti-retroviral Drugs table lists the HIV drugs the client has been prescribed and by which doctor. The table also lists any side effects the client experienced, when they were prescribed the drugs, and in what dosage (total milligrams per day).

To edit or add ART medication information, click the Edit button, which takes you to the ART Edit screen.

**ART Edit**

The ART Edit screen allows you to change and add HIV therapy and medication information for a client.

To edit pharmacy information, enter the name and phone number of the pharmacy. Add any known allergies in the Allergies text box.

**ART Type**

To enter anti-retroviral therapies the client has received, click the New button to the lower right of the ART Type column heading. Click Edit to change information of previously entered therapies.
In the ART Type column, use the drop-down list to enter the ART therapy the client has or is currently receiving. Use the corresponding text fields to enter the dates of the therapy. Use MM/DD/YYYY as the date format, so for January 23, 2005, enter 1/23/2005. You can also use the pop-up calendar.

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

If the client has not completed their therapy, leave the end date field empty. The therapy types include:

<table>
<thead>
<tr>
<th>Therapy Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highly Active Anti-Retroviral Therapy (HAART)</td>
<td>HAART, or highly active anti-retroviral therapy, is a popular treatment of HIV involving three drug therapies: protease inhibitors and two reverse transcriptase inhibitors.</td>
</tr>
<tr>
<td>Combination Anti-Retrovirals but not HAART</td>
<td>Combination or dual therapy usually involving two reverse transcriptase inhibitors.</td>
</tr>
<tr>
<td>Mono therapy</td>
<td>Involves a single ART drug.</td>
</tr>
</tbody>
</table>
Salvage therapy is administered after other therapies have proved to be ineffective.

None/not applicable

The client has received no treatment.

Unknown/Unreported

If the client doesn’t know the type of therapy they have previously received or if the information is unavailable.

Click Save to record your entry or click Cancel to return to the ART Edit screen without saving your changes. After you click Save or Cancel, click the New button to enter other ART types the client has received or click Edit to change an entry. If you wish to remove an entry from view and have the proper permissions, click the Edit button and then click the Deactivate button. Deactivating a record removes it from view and future editing.

**Anti-retroviral Drugs**

With each ART Type, the client will have taken or is taking anti-retroviral drugs. Use the Anti-retroviral Drugs table to enter them and any other ART medications prescribed to the client by clicking the New button to the lower right.

<table>
<thead>
<tr>
<th>Anti-retroviral Drugs</th>
<th>Prescribed by</th>
<th>Side Effects</th>
<th>Start Date</th>
<th>End Date</th>
<th>Dosage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crixivan (Indinavir) (d39885)</td>
<td>Dr. Worther</td>
<td>nausea</td>
<td>9/6/2004</td>
<td></td>
<td>25</td>
</tr>
</tbody>
</table>

Use the drop-down list to select the drug prescribed. The medications are listed alphabetically by their brand name next to their generic drug name and the HRSA drug code. Enter the doctor who prescribed the drug in the next column.

Enter any side effects the client may have encountered from taking the drug. Enter the start date and end date of the drug therapy using the format MM/DD/YYYY, so for January 14, 2006, enter “1/14/2006.” If the client is still currently taking the medication, enter the final date of the prescription in the End Date text field. If this information cannot be validated, leave this field empty.

In the Dosage text field, enter in the total daily dosage in milligrams for the drug. For instance, if a client is prescribed 300 mg of Ziagen twice-daily, enter “600” under dosage.
Adherence

One of the challenges of HIV treatment is therapy compliance. Advanced HIV patients often have memory problems and they forget to take their medications, or an HIV patient might be a substance abuser, which can affect compliance. Understanding how well a client adheres to their ART therapy helps clinicians treat them effectively.

Ask the client how many days over the previous three days (not including today) did they take their ART medication at the proper time and in the proper dosage as prescribed by their doctor. Use the drop-down list to select how many days they were in compliance. For instance, if the client took their medications for two days, but forgot to take their morning medications on the third day, select “2” from the drop-down list. If the client is not currently taking ART medication, select the blank option. Enter the date you asked the question in the text field next to “as of.” Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.” You can also use the pop-up calendar.

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.
Ask the client to estimate how closely they adhered to their HIV treatment for the previous four weeks using a percentage. To enter a new HIV treatment adherence entry, click the New button and select their answer from the drop-down list. If the client cannot remember, select “Unknown,” and enter the date you asked the question. Use the following format: MM/DD/YYYY. For instance, February 15th, 2005 would be “2/15/2005.” You can also use the pop-up calendar. When you are finished, click the Save button or click the Cancel button to return to the ART Edit screen without saving your changes. If you wish to remove an entry from view, click the Edit button and then click the Deactivate button. Deactivating a record removes it from view and future editing.

Genotypic/phenotypic HIV drug resistance testing is performed to gauge if a patient has an HIV virus strain that is resistant to certain drugs. Knowing what drugs are ineffective for a client helps clinicians outline a proper course of action. Use the drop-down list to indicate whether or not a client has received drug resistance testing. Enter the date of the test in the accompanying text field. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.” Enter the type of test and any known results of the test in the Note text field.

If you are finished entering medication data for the client, click the Save + Done button and you will return to the client’s Medication screen. If you wish to return to the client’s Medication screen without saving any changes, click Cancel. Click the Save + Next button to get to the Other Medications Edit screen.

Other Medications

Persons with HIV often experience health complications and symptoms that are treated with non-ART (anti-retroviral therapy) medications. For instance, anti-inflammatories are prescribed for joint pain and sleeping aids are often prescribed for insomnia. Also, a client may be taking medications for conditions completely unrelated to their HIV status.

It is important to know all medications the client is taking as some drugs can interact with and hinder the effects of HIV medications.
The Other Medications screen lists non-ART prescribed medications. To access this screen, from the Client Detail screen, click the Medications tab from the top row of tabs, then click the Other Medications tab from the second row of tabs.

The table is organized in columns for the name of the medication, who prescribed it, for what condition, the dates the client took the medication, and in what dosage.

At the bottom of the screen is adherence information detailing how often over a three-day period the client followed their course of non-ART medications as well as the date the information was recorded.

To change or add medication information, click the Edit button above the table to get to the Edit Other Medications screen.

The Edit Other Medications screen lists the client’s non-ART medications. To change details of a listed medication, click the Edit button next to that line item. To add a new medication, click the New button.

In the first text field, enter the name of the medication. In the next text fields enter the name of the prescribing doctor, what the medication was taken for, and the dates the medication was taken. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.” You can also use the pop-up calendar.
Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

If the client is still taking the medication, enter the last date of the prescription. For example, if the client is 7 days into a 14-day course of Amoxicillin, enter the date 7 days from now in the Ended text field. If the date can’t be validated, leave this field empty.

In the Dosage field, enter the daily amount in milligrams of the medication. For instance, if the client is taking 500 mg of Amoxicillin three times daily, enter 1500. When you have finished editing the medication information, click the Save button. To return to the Other Medications Edit screen without saving changes, click Cancel. To remove a medication from view, click the Deactivate button.

After entering the client’s non-ART medications, ask the client how many days over the previous three days (not including today) did they take their non-ART medication at the proper time and in the proper dosage as prescribed by their doctor. Use the drop-down list to select how many days they were in compliance. For instance, if the client took their medications for two days, but forgot to take their morning medications on the third day, select “2” from the drop-down list. If the client is not currently taking medication, select the blank option. Enter the date you asked the question in the text field next to “as of.” Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.”

If you are finished entering the client’s medications information, click Save + Done to return to their Medications screen. Click the Save + Next button to continue onto the Risk Factors Edit screen. Click the Cancel to return to the Medications screen without saving any changes.

**Risk & Assessments**

The Risk & Assessments screen catalogs the client’s HIV-related behaviors, their substance abuse history, and their mental health history. On the Assessments tab, tools are available to monitor psychosocial factors, the client’s function status, behavioral risks
and potential barriers that may keep a client from receiving the medical care they need. This information is helpful in servicing the client and in understanding HIV epidemiology.

Clinicians can use this information to help counsel clients and advise them to help prevent further infection. Researchers collect aggregate risk factor data to analyze behavior patterns. Also, based on their risk factors, clients may be eligible for certain services.

To access a client’s Risk Factors screen, from the Client Information screen, click the Risk & Assessments tab from the upper row of tabs, and click on the Risk Factors tab on the lower row of tabs.

Near the top of the screen indicates whether or not the client is a pediatric case, i.e., if the client is under 13-years of age.

On the left, under Factors is a checklist listing the high-risk behaviors the client engaged in before they received their first positive HIV test result. These behaviors may or may not have contributed to the client’s HIV infection. A checkmark appears next to each selected factor.

Under Sex Partner Risk Factors, Heterosexual Contact Only, is a checklist regarding the risk factors of the client's heterosexual partners before the client's first positive HIV test result. Note that Heterosexual Contact is a risk factor only if the client's heterosexual partner was known to be at-risk or infected.

Primary HIV Exposure lists the client’s known contact to HIV infection before their first positive HIV test result. For instance, if the client was a heroin user who shared needles with HIV+ persons, “intravenous drug user” will be listed as their primary contact.

Secondary HIV Exposure lists any other known exposure to HIV infection beyond their primary HIV exposure.
To change or edit a client’s risk factors, click the Edit button, which takes you to the Risk Factors Edit screen.

**Risk Factors Edit**

In the Risk Factors Edit screen, use the checkboxes to select the client’s risk factors and high risk behaviors.

If the client is under 13-years of age, select the Pediatric checkbox at the top of the screen.

Use the checkboxes on the left hand column to select the behaviors the client engaged in prior to their first positive HIV test result. Select all the behaviors that apply, not just those the client suspects exposed them to HIV infection. The checklist includes:

<table>
<thead>
<tr>
<th><strong>Sex with Male</strong></th>
<th>If the client had sex with men, whether or not their sexual partner was known to be HIV+.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sex with Female</strong></td>
<td>If the client had sex with women, whether or not their sexual partner was known to be HIV+.</td>
</tr>
<tr>
<td><strong>Injected nonprescription drugs</strong></td>
<td>The client used drugs delivered by needle. For example, if the client injected heroin or methamphetamine.</td>
</tr>
<tr>
<td>Risk Factor</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Received clotting factor for hemophilia/coagulation disorder</td>
<td>HIV can be carried in infected blood products. If the client had or has a coagulation disorder like hemophilia and received clotting factor, select this checkbox.</td>
</tr>
<tr>
<td>Received transfusion of blood/blood components (other than clotting factor), transplant of tissue/organs or artificial insemination</td>
<td>HIV can be transmitted in infected blood products, organs, or any bodily fluid, including semen. If the client has received any such item (excluding clotting factor), select this checkbox.</td>
</tr>
<tr>
<td>Worked in healthcare or clinical lab setting</td>
<td>Those who work in laboratories or in healthcare facilities can be at greater risk of HIV exposure. If the client worked in this type of environment, indicate so.</td>
</tr>
<tr>
<td>Mother HIV infected/Perinatal transmission</td>
<td>This checkbox can only be selected if the client is a pediatric client. HIV+ mothers can potentially infect their unborn child during pregnancy. If the client’s mother was known to be HIV+ while pregnant with the client, select this checkbox.</td>
</tr>
<tr>
<td>Sexual abuse (pediatric only)</td>
<td>This checkbox can only be selected if the client is a pediatric client. If the client was a victim of sexual abuse, select this option.</td>
</tr>
<tr>
<td>Other</td>
<td>If the client engaged in other behaviors considered to be a high risk for HIV exposure, select Other.</td>
</tr>
<tr>
<td>Unknown</td>
<td>Select this checkbox if the client’s risk behavior is unavailable.</td>
</tr>
</tbody>
</table>

Under Sex Partner Risk Factors, Heterosexual Contact Only, is a checklist regarding the risk factors of the client's heterosexual partners before the client's first positive HIV test result. Note that Heterosexual Contact is a risk factor only if the client's heterosexual partner was known to be at-risk or infected. The list includes:

<table>
<thead>
<tr>
<th>Risk Factor</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intravenous/injection drug user</td>
<td>The client’s partner uses drugs delivered by needle. For example, if the client injects heroin or methamphetamine.</td>
</tr>
<tr>
<td>Bisexual Male</td>
<td>If the client’s sexual partner is a male who engages in homosexual and heterosexual sex.</td>
</tr>
<tr>
<td>Person with AIDS or documented HIV</td>
<td>If the client’s sexual partner has AIDS or has ever tested positive for HIV.</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Other (person with hemophilia/coagulation disorder, transfusion recipient with documented HIV infection, Transplant recipient with documented HIV infection)</td>
<td>If the client has received any blood products, tissue, or organs known to have been infected by HIV.</td>
</tr>
<tr>
<td>Unknown</td>
<td>Select this checkbox if the client’s partner’s HIV risk factors are unavailable.</td>
</tr>
</tbody>
</table>

From the Primary HIV Exposure drop-down list, select the client’s risk behavior that was their primary known contact to HIV infection before their first positive HIV test result. For instance, if the client was a heroin user who shared needles with known HIV+ persons, select “Injection drug user” as their primary contact. If the client’s primary exposure to HIV was from a factor or behavior not listed, select “Other.”

If the client engaged in multiple high risk behaviors where they know they were exposed to HIV, but they don’t know which factor was their primary HIV exposure, select “Undetermined.” If the client engaged in high risk behaviors, but does not know how they were infected, select “Unknown.” If the client does not list any risk factors, select “Risk not reported.”

From the Secondary HIV Exposure drop-down list, select any additional risk factors that may have exposed the client to HIV. For instance, if the client has determined that their primary exposure to HIV was from heterosexual sex, but also believes they were exposed to HIV from intravenous drug use, select ”Injection drug user.” If the client had no known secondary HIV exposure, leave this selection blank.

When you have finished editing changes, click the Save + Next button to go to the Substance Abuse Edit screen. If you have no further changes, click the Save + Done button to return to the client’s Risk Factors screen. To return to the Risk Factors screen without saving changes, click Cancel.

**Substance Abuse**

The Substance Abuse screen lists the client’s history with drug and alcohol abuse along with their treatment status. To access a client’s Substance Abuse screen, from their information page, click the Risk & Assessments tab from the top tier of tabs. From the second tier of tabs, select the Substance Abuse tab.
The screen lists whether the client is currently abusing drugs or alcohol, when the information was recorded, and when the client first began using drugs or alcohol. Also listed is the use frequency along with the client’s treatment status.

To edit a client’s substance abuse information, click the Edit button to access the Substance Abuse Edit screen.

Enter the client’s substance abuse history in this form. Substance abuse includes the use of illicit drugs or the abuse of prescription or over-the-counter drugs for recreational use or in a manner other than directed. Substance abuse also includes the habitual or excessive consumption of alcohol and the consumption of non-pharmaceutical chemicals including inhalants and solvents.

Do not include cigarettes on the list of abused substances.
From the Substance Abuse History drop-down list, choose the selection that answers whether or not the client is a substance abuser.

In the Dated text field, enter the date the client was evaluated using the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar.

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

Enter the age the client first began the substance abuse and the frequency of either daily, weekly or monthly.

Click on the New button to enter the client’s current treatment status and the date. From the Treatment Status drop-down list, select the client’s substance abuse treatment status. For instance, if the client was in a rehab facility but did not complete the program, select “Dropped out of treatment.” If the client received treatment not listed, select “Other.” In the Treatment Date text field, enter the date the client’s treatment status changed using the format MM/DD/YYYY.

ARIES will maintain a history of the client’s treatment history. A new Treatment Status entry should be made whenever the client’s status changes.

When you have finished entering the Treatment Status information, click the Save button or the Cancel button to return to the Substance Abuse Edit screen without saving your changes. If you wish to remove an entry from view, click the Edit button and then click the Deactivate button. Deactivating a record removes it from view and future editing.

In the Treatment Start Date text field, enter the date the client began their substance abuse treatment using the format MM/DD/YYYY. If the client has a history of multiple treatment programs, enter the date of the client’s most recent treatment.

In the Treatment End Date text field, enter the date the client completed their substance abuse program using the format MM/DD/YYYY. If the client dropped out of a program,
enter the last date the client was in treatment. If the client is currently enrolled in a treatment program, leave this selection blank.

When you have finished entering the client’s substance abuse information, click the Save + Next button to access the Mental Health Edit screen. If you have no more information to enter, click the Save + Done button to return to the Substance Abuse screen. To return to the Substance Abuse screen without saving changes, click Cancel.

### Mental Health

The Mental Health screen lists the client’s mental health history. To access a client’s Mental Health screen, from their information page, click the Risk & Assessments tab from the top tier of tabs. From the second tier of tabs, select the Mental Health tab.

#### John A Porter

**Mental Health** [Edit]

- **History:** Yes, but not active within the last 3 months
- **Dated:** 10/3/2003
- **Treatment Status:** Refused treatment

Next to History lists whether or not the client has or has had mental illness. Next to Dated lists when the information was recorded. Treatment Status indicates whether or not the client received treatment for their mental illness.

To change a client’s mental health history, click the Edit button, which takes you to the Mental Health Edit screen.

#### Mental Health Edit

In this screen, enter the client’s mental health history.
Use the Mental Health History drop-down list to select whether or not the client has had any mental illness in the past. Mental illness can include: bipolar disorder, schizophrenia, clinical depression, post-traumatic stress disorder (PTSD), panic disorder, eating disorders (bulimia, anorexia), and others.

In the Dated text field, enter the date the client was questioned using the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar.

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

To enter a client’s current treatment status, click the New button. To edit an existing treatment status, click the Edit button. From the Treatment Status drop-down list, select the client’s mental illness treatment status. For instance, if the client was diagnosed with depression, but did not seek treatment, select “No active treatment or counseling.” If the client received treatment not listed, select “Other.” In the treatment date text field enter the date the treatment status changed.
When you have finished entering the client’s treatment status, click on the Save button. Click the Cancel button to return to the Mental Health Edit screen without saving your changes. If you wish to remove an entry from view, click the Edit button and then click the Deactivate button. Deactivating a record removes it from view and future editing.

When you have finished entering mental health information, click the Save + Done button to return to the Mental Health screen. To return to the screen without saving changes, click Cancel.

**Assessments**

In this screen staff can enter a series of client assessments. To access the Assessments screen, from the client’s information page, click the Risk & Assessments tab from the top tier of tabs. From the second tier of tabs, select the Assessments tab.

To view or edit an existing assessment, click the edit button. To enter a new assessment, click the new button.

**Psychosocial Factors**

When a client is first registered at an agency, a baseline assessment of psychosocial status can be conducted. To enter, change or view a client’s baseline assessment, click the Edit button, which takes you to the Psychosocial Factors Edit screens.

The Psychosocial Factors evaluation consists of three screens: History of Abuse, Legal, and Diagnostic Impression and Mental Health History. When performing an evaluation, attention to detail is critical.

**Functional Status**

The purpose of the Functional Status Assessment is to evaluate clients for their functional status and their quality of life. The assessment is separated into two sections: one based on their current state of health, and the other based on the client’s well-being for the previous month.

**Behavioral Assessment**

Clients can be assessed for HIV transmission risk, including sexual and substance abuse behaviors as well as changes in life circumstances or health and mental status that may affect risk behaviors.

**Barriers to Care Assessment**

The Barriers to Care Assessment seeks to identify HIV-positive clients who have never been in care and link them with the appropriate service providers. This assessment also works with clients who have dropped out of care, in an effort to bring them back into care.

**Needs Assessment/Care Plan/Referral Overview**

Case managers routinely perform needs assessments for clients, evaluating what services they require. From this assessment, a care plan can be designed outlining the steps needed
to meet the client's needs. The care plan may require referrals to help clients access services that are unavailable at your agency.

Care plans are valuable organizational tools that will help you manage tasks and resources. Using a care plan to administer services is an asset when managing clients.

To access the Needs Assessment, Care Plan, or Referral screens, from the client's information screen, click the Care Plan tab from the top tier of tabs, then from the second tier of three tabs, click the tab of interest.

When creating an initial care plan for a client, it is recommended that you start by performing a needs assessment of the client.

**Needs Assessment**

Needs assessments are performed during an intake and periodically by case managers. They consist of a brief checklist of general services the client may require.

These assessments are a quick way to get a broad picture of a client’s status. Case managers should use needs assessments as a starting point as ARIES can generate care plan templates for each need. Care plans (see page 167) can be excellent organizational tools for coordinating tasks, referrals, and services for the client.

Also, needs assessment information may be used by researchers and administrative agencies to analyze demographics and assess community needs.

<table>
<thead>
<tr>
<th>Needs</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Management Services; Transportation Services;</td>
<td>10/28/2004</td>
</tr>
</tbody>
</table>

To access the Needs Assessment screen, from a client’s information screen, click the Care Plan tab from the top tier of tabs. Then, from the second tier of tabs, click the Needs Assessment tab.

The Needs Assessment screen displays the client’s previous needs assessment screenings. The left column lists when the needs assessment was performed and the right column lists all the needs the client listed at that time.
Previously recorded needs assessments cannot be edited or deactivated. To record a new needs assessment, click the New button, which takes you to the Needs Assessment Edit screen.

Needs Assessment Edit

The Needs Assessment Edit screen lists general services offered by agencies to clients. Periodically, Needs Assessments are performed by case managers to get an overall view of a client’s status.

<table>
<thead>
<tr>
<th>Source</th>
<th>Need</th>
<th>Don’t Need</th>
<th>Unknown</th>
<th>Create Care Plan</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Management</td>
<td>☒</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Child Care</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Complementary Therapies</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Dental Care</td>
<td>☒</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Emergency Financial Assistance</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Food Services</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>

When performing a needs assessment, use the radio buttons next to each service source to indicate whether or not the client needs services. Select Unknown if the information isn’t available for a specific service.

For instance, if a client needs employment assistance, prescriptions filled, and group therapy, you would select “Work Reentry,” “Pharmacy,” and “Mental Health Counseling” as needs. Select the client’s needs whether or not your agency offers services addressing these needs.

If the client has a need that is not listed, enter it in the Other text field at the bottom of the list.

On the right side of the form, under Create Care Plan, are checkboxes that correspond to each need. If you want ARIES to generate a care plan template for a need, select that checkbox.

When you have finished entering the client’s needs, enter the date the information was recorded in the Dated text field. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar.
Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select
the month and year, and then click the specific date to enter it into the text field. The
calendar window automatically closes.

When you have completed the needs assessment, click the Save + Next button. If you
have selected the Create Care Plan checkbox for any need, you will be taken to the Care
Plan Edit (see page 172) screen for that service source. Otherwise, you will return to the
Needs Assessment screen.

If you wish to return to the Needs Assessment screen without recording the assessment,
click the Cancel button.

**Care Plan**

Case managers routinely perform needs assessments for clients, evaluating what services
they require. From this assessment, a care plan can be designed outlining the steps needed
to meet the client's needs.

These steps can include instructions for caregivers, tasks for staff persons and/or clients,
referrals, and services. With care plans, case managers can track a client's progress,
which helps ensure quality care. Care plans also allow you to list tasks that aren't
classified as services but are still necessary for the client's welfare. For instance, if a
client has memory problems and requires reminder phone calls for appointments, you can
assign this task to a staff person.

Case managers can also use tasks as reminders. For instance, if you know a client has
history of medication adherence problems, you can assign a task to yourself to follow up
with a client's medical provider to see how well they are adhering to their drug course.

Care plans are valuable organizational tools that will help you manage tasks and
resources. Using a care plan to administer services is an asset when managing clients.

To start, perform a needs assessment of the client. From this screen, choose which needs
require care plans and then ARIES generates care plan templates for these needs.
To access the Care Plan screen, from the client's information screen, click the Care Plan tab from the top tier of tabs.

The Care Plan screen lists the client's existing care plans in a table. Each care plan includes the date it was created and who created it in the first two columns. The Program column lists from which program any services may be covered under. For instance, if the care plan is for a client's medical care, "Ryan White" might be listed as the program.

The Need/Subneed column lists for what the care plan was created. For instance, if a client needs dental health services for a root canal, the need would be listed as Dental Care, and the subneed might be Oral Surgery. Subneeds are optional.

The Goal column lists the anticipated outcome of the care plan. For instance, if a client needs employment assistance, their goal would be, "Find client a full-time job."

The Completed column lists when the care plan ended and the Outcome lists whether or not the goal was achieved.

Each care plan includes a list of tasks, referrals, and services listed in a gray table underneath each care plan row. For instance, if a client needed complementary therapies for an anxiety disorder, tasks may include group therapy, pharmaceutical, and transportation services as well as coordinating tasks like reminder phone calls and follow-ups with counselors. All these tasks would be listed under one single care plan.

The tasks table includes:
Task | The task related to the care plan. This includes any individual tasks assigned to staff persons and/or clients. Also, it includes referrals and services for the client.
---|---
Assigned | The person the task is assigned to (staff, client or other, e.g., care giver).
Dt Init. | The date the task was initiated.
Target Dt | The target date of the task’s completion.
F/U Dt | If the case manager has entered follow-up information, when this information was entered.
PSC | Payment source code.
Outcome | The outcome of the given task. If this task has not yet been completed, this entry will be blank.
Out. Dt | When the outcome was achieved. If the outcome has not yet been achieved, the Edit button displays.

Once a care plan outcome has been entered, whether the goal was reached or not, it cannot be edited further.

To edit a care plan, click the Edit button to the right of the care plan entry. To enter a new care plan, click the New button. Both actions take you to the Care Plan Edit screen.

**Care Plan Edit**

From the Care Plan Edit screen, you can outline a care plan for a client’s needs. The simplest way to start is to first begin with a needs assessment (see page 168) of the client. From this screen, you can catalog the client’s needs and ARIES automatically generates care plan templates.

At the top of the screen is a form with the details of the care plan. If you are accessing this screen after a needs assessment, the Date Need Identified field will be prefilled. Otherwise, enter the date the client’s need was identified using the format 9/5/2004. If the task has not yet been completed, the Outcome field will be blank. If the outcome has not yet been achieved, the Edit button displays.
MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar.

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

Leave the Date Completed field empty until the care plan has been completed. This should be entered in a subsequent follow-up.

From the Staff drop-down list, select the staff person who will be managing this care plan. ARIES prefills your name, so if you are performing data entry tasks, make sure you select the proper staff person.

To the right of the Staff drop-down is the Outcome drop-down list. Do not select an option until the care plan is completed. Once you select an outcome, the care plan cannot be edited further. The drop-down list includes:

<table>
<thead>
<tr>
<th>Outcome</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completed</td>
<td>The goal was achieved.</td>
</tr>
<tr>
<td>Pending</td>
<td>The goal has not yet been achieved and the client’s services have not been administered.</td>
</tr>
<tr>
<td>Some Progress</td>
<td>The client has partially achieved the goal and is no longer continuing services.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>The client’s services have been halted and their care plan has been cancelled.</td>
</tr>
<tr>
<td>Unfunded</td>
<td>The client’s services have ended due to lack of funding of the contract or because the contract has expired.</td>
</tr>
<tr>
<td>Not available in area</td>
<td>Services necessary to achieve the goal were not available.</td>
</tr>
</tbody>
</table>
Completed Substance Abuse Program

If the client’s needs are related to substance abuse and the client has completed a rehabilitation program.

From the Program drop-down list, select the program from which the services of the care plan will be covered. For instance, if the client is receiving mental health services under a contract funded by Ryan White funds, select “Ryan White.”

If you are accessing this screen after performing a needs assessment, the Need drop-down list will already be prefilled. Otherwise, select which need most accurately addresses the care plan. If the care plan involves multiple therapies to address the same need, select “Complementary Therapies.” If the need is not listed, select “Other” and enter the need in the text field to the right.

If the care plan involves subneeds, or needs related to the primary need, select from which the program the subneed would be covered and enter the subneed in the text field.

In the Goal text field, enter the overall objective that addresses the client’s need. For instance, if the client’s need is housing, the goal might be “Get the client an apartment,” or if the client had a substance abuse problem, the goal might be “Treat heroin addiction.”

**Interventions**

The lower half of the screen lists the interventions of the care plan. Interventions are steps taken to achieve the client’s care plan goal. They can include tasks performed internally by staff persons, referrals to other agencies, and services administered by your agency.

When you enter a service or referral from this screen, each entry is automatically associated with this care plan.
The first table lists the tasks to be performed. To edit a current task, click the Edit button to the right of a task. To create a new task, click the New button. The task table includes:

<table>
<thead>
<tr>
<th>Tasks</th>
<th>The task to be performed. This could include a follow-up phone call to the client or their clinician, filling out forms, or coordinating appointments and transportation. Tasks can be used as internal reminders that can be assigned to yourself or other staff persons.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned to</td>
<td>To whom the task is assigned. For instance, if a volunteer coordinates all the rides for your agency’s van pool, you can assign that staff person to call the client to arrange a pick-up.</td>
</tr>
<tr>
<td>Date Initiated</td>
<td>The date the task was first assigned. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar icon.</td>
</tr>
<tr>
<td>Target Date</td>
<td>The date the task is to be completed. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar icon.</td>
</tr>
<tr>
<td>Follow-up Date</td>
<td>The date when a task’s status is revisited. For instance, as a case manager you may follow-up on their care plans biweekly. When you check up on a task, enter the date here. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar icon.</td>
</tr>
<tr>
<td>PSC</td>
<td>Enter the payment source code.</td>
</tr>
<tr>
<td>Outcome</td>
<td>Enter the outcome of the task in this text field. For instance, if the task is coordinating a meal delivery, you might enter, “2 weeks of meal delivered.”</td>
</tr>
<tr>
<td>Outcome Date</td>
<td>Enter the date the outcome was achieved.</td>
</tr>
</tbody>
</table>

When you have finished entering in a task, click the Save button. Click Cancel to revert to the Care Plan Edit screen without saving changes.

In the Referrals table, enter any referrals to other agencies necessary to achieve the client’s care plan goal. For instance, if the client needs a medical examination as part of their drug treatment goal and your agency doesn’t staff any medical doctors, enter a referral to an agency that has medical facilities.

To edit an existing referral, click the Edit button. To create a new one, click the New button. Either button takes you to the Referrals Edit screen (see page 177).

After you enter a referral from the Care Plan Edit screen, you will return to the Care Plan Edit screen and the referral you entered displays in the Referrals table.
The third Interventions table lists any services associated with the client’s care plan along with the staff person responsible for the service, the date of the service, the units of service (UOS), and the total cost of the service. For instance, if a client’s goal is to get a treatment plan for their HIV symptoms, their medical services and pharmaceutical services would be listed along with the costs.

To add a service to the care plan, click the Edit button. To edit an existing service, click the Edit button to the right of the service. Either choice accesses the Service Edit screen (see page 186). When you have finished entering a service, you will return to the Care Plan Edit screen.

When you have finished entering care plan information, click the Save + Done screen to return to the Care Plan screen. Click the Cancel button to return to the Care Plan screen without saving your changes. Click the Deactivate button to remove the care plan from view.

**Referrals**

Referrals are used to help clients access services that are unavailable at your agency. For instance, if your agency specializes in psychosocial counseling, but your client needs medical attention, you can enter a referral to a medically based agency. It is important that referrals are recorded, as your agency may be reimbursed for referrals.

To access the Referrals screen, from a client’s information screen, click the Care Plan tab from the top tier of tabs. Then, from the second tier of tabs, click the Referrals tab.

While you can enter in referrals directly from this screen, you may find it more useful to create a care plan for the client starting with a needs assessment (see page 168). From there, you can coordinate your own agency’s services and tasks with the referral based on the client’s overall need.

The screen lists a table of the client’s referrals to other agencies. The first column indicates when the referral was made. The Service column indicates what type of service the client needed. The Referred to column lists to which agency the client was referred. The Target Date column lists the estimated date of when the client was to receive the referred services.
The Outcome column lists the outcome of the referral; whether the client attended their appointment with the other agency or not. It does not tell whether or not the client successfully received services. If the outcome has not been achieved, the Edit button appears.

To create a new referral, click the New button or click the Edit button to change an existing referral. Either action takes you to the Referrals Edit screen.

Referrals Edit

In the Referrals Edit screen, you can enter and edit information for a client referral to another agency. For instance, if your agency handles peer advocacy and a client needs employment assistance, which is handled by another agency, you can create a referral for the client.

Referrals are important for managing a client’s care plan and for referral reimbursements for your agency.

It’s recommended that you first start by creating a needs assessment (see page 168) to better manage all the tasks and services of the client’s needs.

The Referral fields include:
**Referral Date**
Enter the date the referral was made. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar.

Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

**Program**
From the drop-down list, select which program the needed service would be covered under. For instance, if the client requires housing assistance, you might select “HOPWA” from the program list.

The program you choose affects what displays in subsequent drop-down lists. For instance, if you select “Ryan White,” only services covered by the Ryan White program will display in the Primary Service drop-down list.

**Primary Service**
Select which primary service the client needs. What displays in this drop-down list depends on what program was selected. For instance, if the client needs a dental cleaning, select “Oral Health Care.” If you do not see the service listed, make sure you have selected the proper program.

What primary service you select affects what secondary services display in the next drop-down list.

**Secondary Service**
If necessary, select the secondary service the client requires. For instance, if the client needs a dental cleaning, select “Oral Health Care” from the Primary Service drop-down list and “Routine Treatment” from the Secondary Service list.
<table>
<thead>
<tr>
<th><strong>Refer To</strong></th>
<th>From the drop-down list, select the agency the client is being referred to. If the agency is not listed, select “Other.”</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>(other)</strong></td>
<td>If you selected “Other” from the Refer To drop-down list, enter the name of the agency the client is being referred to in the text field.</td>
</tr>
<tr>
<td><strong>Target/Appt. Date</strong></td>
<td>Enter the expected appointment date. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar icon.</td>
</tr>
<tr>
<td><strong>Follow-up Date</strong></td>
<td>If you change information in the referral or enter outcome information, enter the date the follow-up was made. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar icon.</td>
</tr>
<tr>
<td><strong>PSC Code</strong></td>
<td>Enter the payment source code.</td>
</tr>
<tr>
<td><strong>Reason</strong></td>
<td>In this text box, enter why the client was referred to another agency. For instance, if there were no available counselors at your agency, and the client was sent to another agency, indicate so here.</td>
</tr>
<tr>
<td><strong>Outcome Date</strong></td>
<td>When you perform a follow-up to the referral and you have confirmed its outcome, enter the date in this text field using the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar icon.</td>
</tr>
<tr>
<td><strong>Outcome</strong></td>
<td>When you perform a follow-up to the referral and you have confirmed its outcome, select the result of the referral from the drop-down list. Either the client kept the appointment, they were a no show, or the appointment was rescheduled. Once you enter an outcome, you cannot edit the referral further.</td>
</tr>
<tr>
<td><strong>Notes</strong></td>
<td>Enter any additional notes regarding the referral in this text box.</td>
</tr>
</tbody>
</table>

When you have finished entering referral information, click the Save button to return to the Referral screen. To return to the Referral screen without saving changes, click the Cancel button. Click the Deactivate button to remove the referral from view.

**Case Notes**

Client case notes are valuable and flexible tools for agencies. Within case notes, you provide information about a client and their services that can be shared within your agency and, in some cases, with other agencies.

Case notes can be used to track a client’s progress. For instance, if a client had a history of behavior problems with staff persons, a case manager could search their case notes for incidents.
Also, if a client’s notes are shared, other agencies can get an overview of a client’s background if they are a referral. You also have the option to not share case notes with other agencies. By default, legal, substance abuse, and mental health notes are not shared between agencies.

To access the Case Notes screen, from a client’s information screen, click the Case Notes tab on the right of the top tier of tabs.

Case notes are presented in a table. Each row displays information for a paragraph of case notes. The table lists the case note date in the left hand column.

Next to that displays the case note category; whether it’s a service-related note, administrative, or other type of note. The third column displays the note type. A note may be entered as an initial assessment, service assessment, progress report, client update, crisis note, or case conference.

The fourth column lists the staff person who made the case notes. Clicking on their name takes you to their Staff Detail screen (see page 197).

The last column on the right is the “Signed ‘n Sealed” column, which displays the date when the case notes were completed and sealed. When case notes are sealed, they become visible to other agencies with which the client has agreed to share data. Unsealed notes are visible to staff persons within your agency with the proper permissions. If you have not yet finalized a client’s case notes, the Edit button displays. If you want to view a printable version of a particular case note category, click on the Print button next to the Edit button.

Under each table row is the content of the case notes. For instance, in a progress note regarding a client’s housing, the note might explain the client’s current steps in finding housing and assistance they are receiving.
At the bottom of the screen is the View For Printing button, which allows you to filter case notes in a search by date. Use the drop-down list to specify which kind of search you want.

Select “Before” to bring up all case notes before – but not including – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve all case notes dated before midnight on June 22, 2005.

Select “After” to bring up all case notes after a specific date, including case notes on that day. For example, entering 6/23/2005 in the first text field will display all the case notes on June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To search a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field.

The drop-down lists on the right allows you to filter your results by note category, type, or a particular agency staff. Leave the values blank to select by all categories and types, or make the appropriate selection. The Staff drop down defaults to “All” to search the client’s case notes from all agencies. Select “My Agency” to search only the case notes from your agency. To find the notes by a particular staff at your agency, select his/her name from the list.

Click the View For Printing button to perform your search. ARIES displays your results in a screen formatted for printing without the ARIES menu bar. Click the “Return to Case Notes” link in the upper left to return to the previous screen.

To change an unsealed case note, click the Edit button on the right. To create a new case note, click the New button at the top of the screen. Either action takes you to the Case Notes Edit screen.

Case Notes Edit

ARIES offers case managers a lot of flexibility in entering case notes. For instance, in an intake, you can enter case notes about the client’s medical, financial, and substance abuse status all from the same screen. ARIES separates the notes into individual, but linked, entries, which saves time and helps organize case notes more efficiently.
At the top, from the Staff drop-down list, select the staff person who recorded the case notes. ARIES lists whoever is logged in as the default. If you are performing data entry tasks, make sure you select the proper staff person and not yourself.

The Created heading lists the date the case note was created.

From the Type drop-down list, select which kind of a case note you are entering. A note may be entered as an initial assessment, service assessment, progress report, client update, crisis note, or case conference.

To the right of the Type drop-down is the Activity Date text field. Enter the date the note was recorded or updated. Use the format MM/DD/YYYY. For example, for January 12, 2005 enter 1/12/2005. You can also use the pop-up calendar.
Click the calendar icon to bring up the pop-up calendar. Use the drop-down lists to select the month and year, and then click the specific date to enter it into the text field. The calendar window automatically closes.

The case note text box lists all case note entries separated by category. For instance, if the case note is for an initial assessment, it may list any presenting problems, mental health issues, etc. Each entry is preceded by the category type in brackets. If the case note entry is not shared with other agencies, it is also indicated.

To edit or add a case note entry, select which type of case note you want to enter from the Category drop-down list. You can select from service-related categories like “Housing” or “Medical.” You can also enter notes about a presenting problem, general impressions, or an incident report.

Enter the body of the case note for that category in the New Paragraph text box. For example, in an intake, you might first enter any presenting problems. Then, select “Medical” from the Category text field. ARIES enters the presenting problem entry into the case notes text box and creates a blank entry for medical notes.

You can use the “Don’t share” checkbox to prevent other agencies from viewing a client’s notes. If a client has elected not to share their information with other agencies, this will be selected by default. Mental health, substance abuse, and legal case notes cannot be shared with other agencies.

When you are through entering case note information, click the Save button. This will save all your changes and take you back to the Case Notes screen. However, only those within your agency with the proper permissions will be able to view the case notes you entered. To finalize your case notes and make them available to other agencies (if the
client has agreed to share their data), enter your login password in the text field in the bottom and click the “Sign ‘n Seal” button. If case notes are not shared, they can only be viewed within your agency. Once case notes have been sealed, they cannot be edited or deactivated. Click the Cancel button to return to the Case Notes screen without saving your changes.

If you have the proper privileges and a note is not signed and sealed, you can deactivate a case note, removing it from view and future access. Deactivate means the record will be hidden so it is no longer available in ARIES. The data will not be deleted, but it will not be accessible anymore. Only ARIES administrators can reactivate records.

**Services**

Agencies provide services for clients. Services can include medical consultations, meals, housing assistance, psychological counseling, transportation, medication, and even intakes. ARIES manages and tracks services to help automate budgeting, create reports, and provide quality care for clients.

Each service must be entered as a separate service line item. This is done to track individual services for reporting purposes. Wherever possible, ARIES pre-fills text fields to make data entry quick and simple.

Staff persons enter new service line items after a client’s eligibility for services has been verified and the client has been entered into the ARIES system. Staff persons who enter service line items include intake personnel, case managers, support services providers, data entry personnel, and other personnel who have proper permissions.

To access a client’s Services screen click the Services tab at the top right of the Client Details screen. The Services screen lists all the services a client has received in a table.

<table>
<thead>
<tr>
<th>Date</th>
<th>Staff</th>
<th>Category</th>
<th>UOS</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>10/5/2004</td>
<td>William Riker</td>
<td>Ryan White &gt; Transportation &gt; Bus Tokens/Pass</td>
<td>4.00 Item @ $2.00</td>
<td>$8.00</td>
</tr>
<tr>
<td>10/5/2004</td>
<td>ARIES Admin</td>
<td>Ryan White &gt; Mental Health Services &gt; Group &gt; Facilitation</td>
<td>6.00 Hour @ $60.00</td>
<td>$360.00</td>
</tr>
<tr>
<td>10/5/2004</td>
<td>Esther Dyson</td>
<td>Ryan White &gt; Mental Health Services &gt; Psychiatric Evaluation &gt; Chart Review</td>
<td>1.00 Hour @ $10.00</td>
<td>$10.00</td>
</tr>
<tr>
<td>10/5/2004</td>
<td>William Riker</td>
<td>EIP &gt; Psychosocial &gt; Psychosocial Assessment &gt; Psychosocial Assessment</td>
<td>1.00 Hour @ $100.00</td>
<td>$100.00</td>
</tr>
<tr>
<td>9/30/2004</td>
<td>ARIES Admin</td>
<td>Ryan White &gt; Case Management &gt; Diagnosis Management &gt; Consultation</td>
<td>1.00 Hour @ $100.00</td>
<td>$100.00</td>
</tr>
</tbody>
</table>

Use the Date filter to view services for a specific time span. From the drop-down list, select the type of filter you want to perform. You can filter on, before or after a date, or between two dates.
Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and date displays in the text field. The pop-up calendar window closes automatically.

To filter for records on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty. Select “Before” to sort thought all entries before—but not including—that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve records dated before midnight on June 23, 2005.

Select “After” to bring up all records dated after a specific date, including records dated that day. For example entering 6.23.2005 in the first text field clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning of date in the first text field and the ending date in the second text field. Your viewed results will include all records from 12:00 AM on the first date to 11:59 PM on the second date. For example, entering 6/23/2005 in the first text field and 6/27/2005 in the second text field and clicking Search will display all records on June 23, 2005 through June 27, 2005.

Use the drop-down lists to filter the view of services by staff person who provided the services, by program and by primary service category.

The first column in the list of services is the date the service was provided. The second column lists the staff person who provided the service. The third column explains what type of service the client received listed by program, primary service, secondary service, and, if applicable, agency defined subservice. A dental exam might be listed as “Ryan White > Oral Health Care > Routine Treatment” where “Ryan White” is the program, “Oral Health Care” is the primary service, and “Routine Treatment” is the secondary service.
The UOS column lists how many units of service the client has received and how much each unit of service costs. A day’s worth of meals might be listed as “2 meals @ $7.” The Total column lists the total cost of the service.

Limiting the view of services for a client can be done by selecting a date of date range, the staff person who provided the services, the program under which services were provided, and the primary service category of services.

Clicking the Edit button next to a service takes you to the Edit Service screen where you can change any details. To enter a new service line item, click the New button. Click the Deactivate button to remove the service line item from view.

Edit Service

There are two ways to enter new service line items. Each approach has advantages depending on your intention.

If, for example, you are interested in services associated with one particular client, you should access the service screen by first searching for that client. To do this, perform a Client Search (see page 34) to access the Client Details screen. Select the Service tab on the far right of the client tabs to bring up the client’s Services screen. The screen lists all the client’s service line items. Click the New button to bring up the New Service screen pre-filled with the client’s name. This approach allows you to see the client’s service history and enter multiple new services for that client.

Alternatively, you may want to enter services for multiple clients. For example, you may have a stack of client forms with service information on each form. In this case, you should access the Services screen directly. From the ARIES menu bar (see page 15) at the top of the ARIES screen, choose the New → Service menu item. This takes you to the Services screen. The advantage of this approach is that you can enter a service for one client, click the Save button, and enter another service for a completely different client without interruption. This allows you to enter many services in a short amount of time.

You should note some drawbacks associated with accessing the Services screen directly from the menu bar. You will not have any visual verification of the client-to-service relationship making it extra important that you are careful in your data entry. Also, if the client is not found in the ARIES database, you will not be notified until you try to save the service entry. This alternative works well as long as you exercise caution during data entry and know the clients you are entering services for already exist in ARIES. With this method, it is recommended that you contact your administrator or manager after you complete your service entries to find out if there is an ARIES report you can run that shows all newly entered services so you can compare your hardcopies to the services you entered in ARIES.

With either of these methods, service information is entered in the Services screen. On the upper left of the screen is the client identifier drop-down list. If the client’s name is not already pre-filled, use the drop-down list to choose how you want to identify the client. Client name (first and last) is the most common identifier, but you can also use an agency-specific client ID or program client ID. If you use the client’s name, do not enter
their middle initial. Enter the corresponding name or ID in the text field. If you have accessed the screen through a client record, the client’s name is entered by default.

From the Staff drop-down list, select the staff person responsible for the service. Your name is the pre-selected choice, but if you are entering data on behalf of someone else, select the name of the person providing the service.

If your agency has multiple sites, use the Site drop-down list to select the location where the service was provided.

Enter the date the service was administered using the format: MM/DD/YYYY. So for June 22, 2005 you would enter 6/22/2005. You can also use the pop-up calendar by clicking the calendar icon.
Use the drop-down lists to select the month and year, and then click the specific date to enter it into the Date of Service text field. The calendar window automatically closes. If the service spans over multiple days – for instance, a hospital stay or daily transportation – enter the start date of the service. The end date is specified further down in the form.

The Days to Next Service text fields indicate when the client should receive their next service. For instance, if the client needs a follow up visit after three months, enter 90 in the first text field and the date is calculated into the Date field. Likewise, if you enter the date, the number of days is calculated. The days to next service can be used as a reminder or to-do item for this client.

Enter the service type by using the Program, Contract Name, and Services drop-down lists. Your choice from one drop-down list filters what will be in the other drop-down lists. For instance, if a client is eligible for services under your agency’s Medicare contract, select the Medicare contract from the “Contract Name” drop-down list. Only the services available under that contract will be available in the service drop-down lists.
Services are organized in four tiers – program, primary service, secondary service, and agency subservice. The drop-down selection you choose at one tier fills in the available services at lower tiers. For instance, if you wish to see what mental health services your agency provides, choose “Mental Health Services” from the Primary Service drop-down list. The Secondary Service drop-down will list only the mental health services your agency provides. Choosing a secondary service fills the Agency Subservice drop-down with the specialized subservices your agency offers. Again, only those services specified in the contract setup display.

Also, if you choose a service, ARIES selects the corresponding contracts that fund that service. For example, if you choose the secondary service “Speech Therapy,” ARIES lists which contracts cover that service in the “Contract Name” drop-down. If there are multiple contracts listed, make sure that you choose the contract under which the service is to be reimbursed.

If the service line item is medication, the HRSA Drug Code drop-down list appears. Select the code that corresponds to the client’s medication. Each line in the drop-down lists the medication’s brand name, generic name, and HRSA drug code.

When you enter the service type, the Units of Service fields fill in the default values defined by the contract. However, you can change the costs and unit quantities. For instance, an intake, which is measured in quarter hour visits, may normally take 3 hours, or 12 units. When you choose the subservice of intake the units defaults to 12. However, if you have a particularly lengthy intake that takes four hours, you would replace the “12” with “16.” The total recalculates in the Total text field.

Some services are not calculated by units of service. For example, one-way trips might be reimbursed by mileage. The unit of service is 1 but a one-way trip could be several miles. In such cases, leave the cost text field empty and enter the actual cost of the service in the Total text field. For medication, the unit of service is by prescription – a 100-pill prescription is still one unit of service, so enter the cost of the medication in the Total field.

In the Client Payment field, enter the actual dollar amount paid by the client if applicable. In the CARE/HIPP Co-Payment field, enter the amount of the co-payment paid for the CARE/HIPP service.

For certain services, like temporary housing or meals, the Daily Service End Date text field will appear. This makes it easy to enter a number of identical service records over consecutive days. Enter in the last date the service will be provided. When you save the service line item, ARIES creates a separate record for every day of service. For instance,
if a client is to receive meals from 7/14/2005 through 7/21/2005, ARIES creates 8 service line items for every day the client receives meals. Make sure that the time span of the service does not extend beyond the end of a contract. For example, if a client is approved to receive 20 days of hotel stay starting on December 27, 2005 and the contract for that service expired at the end of the year, enter 12/31/2005 in the Daily Service End Date text field. Then enter a new service line item for the hotel stay starting on 1/01/2006 and ending 1/15/2006 under the renewed contract.

In the Actual Minutes Spent text field, enter the amount of time used for an appointment. For instance, if a consultation lasted 35 minutes – even if it was scheduled for an hour – enter “35.” This field is not required nor does it define the UOS. It is used for internal reports and scheduling.

Use the Service Notes text box to enter any other details pertaining to the service line item, including any additional payment sources.

Selecting the Finalize checkbox at the bottom of the screen will protect the service record from further editing once saved.

Click the Save + Done button to return to the client’s Services screen. Click the Save + Another button to enter additional service line items. A new screen appears filled out identically to the one you just saved. This can be a time saver if you are entering multiple service line items for a client or if multiple clients receive the same service. Say you were entering clients for a group therapy session. After entering the first client, click Save + Another and an identical screen comes up. Enter the name of the next client in the group and click Save + Another until all the clients are entered. ARIES will not save the new record unless at least one field has changed from the previously saved record. Clicking the cancel button takes you back to the client’s services list without saving any information entered.
If you have the proper privileges, you can deactivate a service entry. Deactivated services will not be included in reports. Deactivate means the record will be hidden so it is no longer available in ARIES. The data will not be deleted, but it will not be accessible anymore. Only ARIES administrators can reactivate records.

### 3. Staff

All services are administered by staff. Staff persons include clinicians, receptionists, volunteers, administrators, and case managers, to name a few. To change or create staff records other than your own, you must have the proper permissions.

Every staff person at your agency, whether they are full-time, part-time, or volunteer, should be added to ARIES. Once they are in the system you can ascribe services to them, enter case notes for them, and so forth. The staff screens allow you to search for staff at your agency, see all their contact information, and edit their preferences and permissions.

Even if a staff person doesn’t directly use ARIES, it is important that they be included in the system. Their inclusion allows for better tracking of clients and other items.

The most common tasks include:

- Changing Your Preferences
- Changing Your Password
- Adding a New Staff person

The staff screens include:

- Staff Search
- Staff Search Result
- Staff Detail
- Staff Edit
- Staff Permissions
- Editing Permissions

**Working with Staff in ARIES**

When entering new staff information, try to be as complete as possible, which will help others to search the staff records more accurately. Avoid using nicknames and initials for first names.

The most common tasks include:

- Changing Your Preferences
- Changing Your Password
- Adding a New Staff person
Changing Your Preferences

All of the personal information for your account is held in your preferences. You can always change your own preferences. However, if you need to change your permissions to access more capabilities in ARIES, please contact an ARIES administrator. To change your preferences:

1. From the ARIES menu bar at the top of the ARIES screen (see page 15), choose Find → Staff to get to the Staff Search screen.
2. Enter your first and last name in the corresponding text fields.
3. Click the Search button, which will take you either to your Staff Detail screen or the Staff Search Result screen. If you are taken to the Staff Search Result screen, click your name to get to your Staff Detail screen.
4. From the Staff Detail page, click the Edit button.
5. In the Staff Edit screen, enter any new information. For a detailed description of the fields please see page 198.
6. Click the Save button to keep your changes. To start over, click the Cancel button, which will take you back to the Staff Detail screen.

Changing Your Password

To change your password, follow these steps (If you forgot your password, please contact an ARIES administrator to reset it):
1. From the ARIES menu bar at the top of the ARIES screen (see page 15), choose the Find → Staff menu item to get to the Staff Search screen.

2. Enter your first and last name in the appropriate text fields.

3. Click the Search button, which will take you either to your Staff Detail screen or the Staff Search Result screen. If you are taken to the Staff Search Result screen, click your name to get to your Staff Detail screen.

4. From the Staff Detail page, click the Change Password button.

5. From the Staff Change Password screen, enter your original password in the first text field. In the second text field, enter your new password. Reenter your new password in the third text field. Your new password must include at least one number, one lower case, and one uppercase character, and must be 6-12 characters long. For instance, “rover” is not an acceptable password but “roVer82” is.

6. Click the Save button to keep your changes. To start over, click the Cancel button, which will take you back to the Staff Detail screen.

Adding a New Staff person

To add a new staff person, you must have the proper permissions.
1. From the ARIES menu bar at the top of the ARIES screen (see page 15), choose the New → Staff menu item to get to the Staff Search screen.

2. Enter the new staff person’s last name in the text field and click the Search button to check whether they already exist in the ARIES system.

3. If their name does not appear in the Staff Search Result screen, click the New Staff button to get to the Staff Edit screen. This button will only be visible if you have permission to create a new staff person.

4. Enter their first and last names in the corresponding text fields.

5. If applicable, enter the staff person’s title.

6. Next to Employment, use the drop-down list to select whether the staff is Full Time, Part Time or a Volunteer. For full-time staff enter 1 as the Full-Time Equivalent (FTE). For part-time and volunteer staff, enter the proportion of the Full Time Equivalent (FTE) as a number between 0 and 1 in the accompanying text field. For instance, if the staff person works half time, enter “.5” in the text field.

7. Enter the staff’s phone and fax numbers and email address in the corresponding text fields.

8. If your agency has more than one site, use the drop-down list to select which location will be the staff person’s primary work site.

9. In the Initials/Short name text field, enter an abbreviated version of the staff person’s name. For instance, for Mary Jones, you might use, “MJ.” This short name will be used in screens where the staff person’s full name might not fit correctly.

10. Use the Home Page drop-down list to select the screen that will appear when the staff person logs in (see page 14). The default screen is the ARIES welcome screen (see page 15). You should select the home page that the staff person will
visit most frequently. For example, if a staff person primarily enters new service data, then set the home page to the New Service Line Item screen.

11. In the ARIES Login text field, enter the staff person’s login ID. The login ID must be from 8-32 characters in length and must use only letters and numbers. For instance, “maryj” is not an acceptable login but “maryjones” and “maryj222” are.

12. Enter the new staff person’s password in the Password text field. You must reenter the password identically in the Confirm Password text field. The new password must include at least one number, one lower case, and one uppercase character, and must be 6-12 characters long. For instance, “rover” is not an acceptable password but “roVer82” is.

13. Select the appropriate user group for the staff from the drop-down list:
   - Volunteer
   - EIP Team Members
   - Peer Advocate
   - Data Entry
   - Case Manager
   - Agency Management
   - Agency ARIES Administrator
   - Medical
   - Ancillary Services
   - Receptionist

14. Click the Save + Next button to customize the staff person’s permissions on the Staff Permissions screen. Click the Save + Done button to use the standard permissions for the staff person’s user group. Click Cancel to clear all entries without saving, which will take you back to the Staff Search screen.

**Staff Screens**

To access the staff screens, start by accessing the Staff Search screen. Choose the Find → Staff menu item from the ARIES menu bar at the top of the ARIES screen (see page 15). From there, you can access the screens that allow you to search for staff at your agency, see all their contact information, and edit their preferences and permissions.

The staff screens include:

- Staff Search
- Staff Search Result
- Staff Detail
- Staff Edit
- Staff Permissions
Editing Permissions

Staff Search

From the ARIES menu bar at the top of the ARIES screen (see page 15), choose the Find → Staff menu item to get to the Staff Search screen. Also, when you create a new staff person, you will first come to the Staff Search screen.

When entering a new staff person, first search for their name on ARIES to avoid duplicate entries.

Enter the staff person’s last name in the top text field or their first name in the second field. Do not use initials, i.e., “Mary J.” If you are unsure of the spelling of a name, you can try using the wildcard “*.” For instance, if you enter, “Mac*” in the last name field, the search will return all last names and all Also Known As field names that begin with “Mac.”

To narrow your search in a large agency, select the staff person’s primary role from the drop-down list. You can also use the primary role drop-down list without entering any first or last name criteria to find all the staff persons who perform a particular function.

You can specify the number of results to return on your search. The more results you ask for, the longer the search will take. The default is set at 20, which is about what will fill the results screen. You can always narrow your search or increase your search results later.

Click the Search button and you will be taken to the Staff Search Result screen. If there is an exact match, you will be taken to that person’s Staff Detail screen.

If you are having trouble finding a staff person, try reducing your search criteria. The quickest way to get results is to type the first few letters of the staff person's last name followed by “*” and choosing from the resulting matches. Many people use nicknames as first names, so searches using first names are not as reliable.
You may search for any staff person at your agency, but not at other agencies. However, if you are a staff person at an administrative agency, then you may search for staff at all the agencies you administer.

**Staff Search Result**

When you click the Search button on the Staff Search screen, ARIES looks up all the staff persons who match all your criteria and then displays them on the Staff Search Result screen. If there is only a single result for your search, you are taken to the Staff Detail screen.

<table>
<thead>
<tr>
<th>Staff Name</th>
<th>Agency</th>
<th>Title</th>
<th>Phone</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bashir, Julian</td>
<td>Parkland Health and Hospital System - AIDS Clinic</td>
<td>Case Manager</td>
<td>214-590-5647</td>
<td><a href="mailto:testARIES@Parkland.org">testARIES@Parkland.org</a></td>
</tr>
<tr>
<td>Gato, Reese</td>
<td>Dallas County Health and Human Services Department</td>
<td>Case Worker</td>
<td>212-222-3332</td>
<td></td>
</tr>
</tbody>
</table>

Your search results list in a table alphabetically by staff name. Also listed are the staff person’s agency, title, phone number, and email address.

Clicking on a staff name takes you to that individual’s Staff Detail screen (see page 197).

Clicking on an agency takes you to the Agency Detail screen (see page 217).

Clicking on an email address opens a new email addressed to the staff person in your computer’s default email program.

If your search didn't show the staff person you were looking for, you can increase the number of results displayed by entering a new number in the text field and clicking the Display button.

If you still can’t find the staff person you are searching for, try a new search using fewer criteria (try using the last name only). If you have the proper permissions and you want to create a new staff person, click the New Staff button to enter a new staff person, which will take you to the Staff Edit screen.

**Staff Detail**

The staff detail screen contains a staff person’s personal information including their agency, primary site, address, phone number, and email address.
Clicking the agency link takes you to the Agency Detail screen. Clicking the email address opens a new email message addressed to the staff person in your computer’s default email program.

Clicking the buttons underneath the staff details will take you to the **Staff Edit**, the **Staff Permissions**, and the **Staff Change Password** screens. If you do not see the Edit or the Edit Permissions buttons then you do not have the necessary permissions to make changes. You always have permission to change your own preferences, but you can only change some other staff person's preferences if you administer that agency and have the appropriate permissions.

**Staff Edit**

If you are accessing your own profile, you can edit your personal data, such as your contact information or password. To change your Home page, use the Home Page drop-down list to select the screen that will appear when you log in. For example, if you primarily enter new service data, then you can set your home page to the New Service screen.
If you have the proper permissions, you can change other staff person’s information or add new staff in the Staff Edit screen. If a staff person is already entered at another agency, you must enter a new record for them at your agency. If a staff person is reassigned or is working at two different agencies, they must have a separate record at each agency.

When entering a new staff person, all fields with red asterisks must be filled.

Enter their last and first names in the name text fields. Avoid nicknames and initials for first names.

If applicable, enter the staff person’s title.

Next to Employment, use the drop-down list to select whether the staff is Full Time, Part Time or a Volunteer. For full-time staff enter 1 as the Full-Time Equivalent (FTE). For part-time and volunteer staff, enter the proportion of the Full Time Equivalent (FTE) as a number between 0 and 1 in the accompanying text field. For instance, if the staff person works half time, enter .5 in the text field.

Enter the staff’s phone and fax numbers and email address in the appropriate text fields.

If the agency has more than one site, use the drop-down list to select which location will be the staff person’s primary work site.

In the Initials/Short name text field, enter an abbreviated version of the staff person’s name. For instance, for Mary Jones, you might use, “MJ.” This short name will be used in screens where the staff person’s full name might not fit correctly.

Use the Home Page drop-down list to select the screen that will appear when the staff person logs in (see page 14). The default screen is the ARIES welcome screen (see page 15). You should select the home page that the staff person will visit most frequently. For example, if a staff person primarily enters new service data, then set the home page to the New Service screen.

In the ARIES Login text field, enter the staff person’s login ID. The login ID must be from 8-32 characters in length and must use only letters and numbers. For instance, “maryj” is not an acceptable login but “maryjones” and “maryj222” are.

If you are entering a new staff person, you must enter a password. You must reenter the password identically in the “Confirm Password” text field. Your new password must include at least one number, one lower case and one uppercase character, and
must be 6-12 characters long. For instance, “rover” is not an acceptable password but “roVer82” is.

If you are entering a new staff person, you must select which user group they are part of from the drop-down list:

- Volunteer
- EIP Team Members
- Peer Advocate
- Data Entry
- Case Manager
- Agency Management
- ARIES Administrator
- Medical
- Ancillary Services
- Receptionist

Click the Save + Next button to customize the staff person’s permissions. Click the Save + Done button to use the standard permissions for the staff person’s user group. Click Cancel to clear all entries without saving, which will take you back to the Staff Search screen. Click Deactivate to remove the staff person from future access. If you need to reactivate the staff person, contact an ARIES Administrator.

Staff Permissions

ARIES employs extensive security measures to protect client data; administrators have fine-grained control over who has access to which parts of the system. This allows all staff persons to use ARIES while preserving client trust.

Staff persons can view, change, create, and deactivate records in ARIES based on their permissions. ARIES administrators can change these privileges through the Staff Permissions screen. A staff person cannot edit his or her own permissions.

When changing a staff person’s permissions, be sure not to give the individual more permissions than they need. Limiting who can access what will help preserve the integrity and confidentiality of the information stored on ARIES.
To access a staff person’s permissions, start by performing a staff search. From the Staff Detail screen, click the Edit Permissions button.

The Staff Permissions screen displays a table of the staff person’s permissions. A staff person can be granted permission to view, change, create, and deactivate records for major ARIES functions by selecting the corresponding checkbox.

Permission to view allows that person to see the details of a record. For example, a staff person scheduling appointments can search and view details of a client, but they may not be able to edit these records.

Permission to change means they are allowed to edit existing records. For example, a case worker entering in notes for a client would need to search for the client and edit their records.

Permission to create means they can add new records. For example, an agency manager would have permission to enter in new staff persons into ARIES.

Permission to deactivate means they can hide the record so it is no longer available in ARIES. The data will not be deleted, but it will not be accessible anymore. Only ARIES administrators can reactivate records.

For some functions, the checkboxes are faded, which means that certain permissions aren’t applicable to that function. For instance, the ability to perform client searches is unrelated to the ability to change, create, or deactivate client information. Thus, those corresponding checkboxes are inaccessible.

<table>
<thead>
<tr>
<th>Function</th>
<th>View</th>
<th>Change</th>
<th>Create</th>
<th>Deactivate</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPOINTMENTS</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Appointment Outcome</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CLIENT SEARCH</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Social Security Number</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Affected Client</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NEW CLIENT/URN ELEMENTS</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEMOGRAPHICS TAB</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contact by mail, phone, confidential</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Client Identifiers</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sexual Orientation</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Related or Affected Individuals</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>diagnoses, treatment plans</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General group or role: Case Manager</th>
</tr>
</thead>
</table>

Supplement or override group permissions with checkboxes in the following list.
Also, you cannot grant a staff person more permission than you have, so the permission checkboxes that are disabled for you are also disabled for all the staff people you administer.

The most specific permission for a particular function applies. For example the Medical tab contains Basic Medical, Medical History, and OB/GYN subtabs. There are separate permission levels for the first two, but the OB/GYN uses the Medical permissions. Within Medical History there is a separate permission for STI/Hepatitis, but the CD4 and Viral Load use the Medical History permission.

**Editing Permissions**

When a staff person is entered into the ARIES system, they are assigned an initial role or group, which determines their default permissions. The default permissions for the groups or roles are created by the ARIES Administrator. They may or may not be appropriate for the staff people at your agency, so you can add to or remove from the default permissions with this screen. For instance, volunteers are typically not allowed to create or edit case notes for a client. However, if you have a volunteer at an agency who is allowed to work with case notes, then you can add checkboxes for those permissions.

There will be many cases where individuals need more or fewer permissions than the default for their group. For instance, a peer advocate might need to enroll new clients and create reports.

You can customize an individual’s permissions two ways. First, you can use the “General group or role” drop-down list, to assign the staff person to a different group. Then all the permissions are changed to the default values for the new group. You can also customize individual permissions by selecting and deselecting the checkboxes for each function.

For instance, if a volunteer were promoted to do case management work at your agency, they would initially be entered into ARIES with only volunteer permissions. In the Staff Permissions screen, you can grant them the broader permissions of a case manager by assigning them to the “Case Manager” role. ARIES will prompt you if you want to change the individual’s permissions. Click OK.
Suppose there is a peer advocate at your agency who is assigned to enroll new clients. Their initial permissions as a Peer Advocate would not allow them to create New Client records. But by selecting the view and create New Client checkboxes, they would have the ability to enter new client information.

When you have finished customizing the staff person’s permissions, click the Save button at the bottom of the screen. Click the Cancel button to undo any changes and return to the Staff Detail screen.

4. Agencies

Agencies are organizations that administer services. Agencies that manage other agencies are known as administrative agencies. Administrative agencies are allowed to report on their client and service data. Administrative agencies also administer subagency information.

The agency screens in ARIES allow you to search for agencies, view agency addresses, manage agency contracts, and produce CADR reports. A search for agencies by services provided can be helpful if you need to find referrals for services such as housing, food banks, or transportation.

If you have the proper permissions, you can edit agency information, including agency sites, funding, contracts, and services provided. You can also create new agencies after first performing an agency search. If your agency has permission to create new agencies, then you are automatically an administrative agency. You automatically administer every agency you create. An ARIES administrator can change or remove the agencies administered by using ARIESAdmin.

When entering agency information, it is important to be as accurate and complete as possible. The more complete the information you enter, the easier it will be for staff to enter services for your agency and the better the tracking of contracts at your agency.

The most common tasks include:

Changing Your Agency Information
Adding or Editing a Site
Creating or Changing Contracts

Creating an Agency

The agency screens include:

Agency Search
Agency Search Result
Agency Detail
  Funding & Contracts
  Services Provided
  CADR
Agency Edit
  Agency Sites
  Funding Sources
  Contracts
  Primary Services
  Subservices

Working with Agencies in ARIES

If you have the proper permissions, you can edit and add new agency information. When doing so, it is important to be as accurate and complete as possible. The more complete the information you enter, the easier it will be for others to enter services and generate reports for your agency.

The most common tasks include:

Changing Your Agency Information

Adding or Editing a Site

Creating or Changing Contracts

Creating an Agency

Changing Your Agency Information

Editing your agency's basic information is a quick and easy task. If you need to edit funding, contract and services information for your agency, which is more involved, go to the Agency Edit help (see page 220).
1. From the ARIES menu bar at the top of the ARIES screen (see page 15), choose the Find → Agency menu item.

2. Enter the name of your agency in the Agency text field. As a shortcut, you can enter the first few letters of the agency and use the “*” wildcard. For instance, if you wanted to find the Ryan White Center, you would enter “ryan*” and click the Search button.

3. If you are taken to the Agency Search Result screen, click on the name of your agency to get to Agency Detail screen.

4. In the Agency Detail screen, click the Edit button, which will take you to the Agency Edit screen. All text fields with red asterisks must be filled out.

5. Enter the agency’s entire name in the Agency Full Name text field.

6. In the Agency Short Name text field, enter an abbreviated version of the agency name. For instance, for the San Francisco AIDS Foundation, you might use “SFAF.” This short name will be used in screens and reports where the full agency name might not format correctly.

7. If the agency has a website, enter it in the Website text field. When entering the website name, include “http://” at the beginning. For instance, if the website is www.ryanwhitecenter.org, you would enter “http://www.ryanwhitecenter.org” in the text field.

8. Acuity tools are used to measure the severity of a disease. As different agencies employ different acuity systems, it is important that the tool each agency uses is available to help standardize case management services. Enter the agency’s link including “http://” at the beginning. For instance, if the website is www.ryanwhitecenter.org/acuity, you would enter “http://www.ryanwhitecenter.org/acuity” in the text field.
9. In the Taxpayer ID text field, enter the nine-digit taxpayer ID using the following format: 99-1234567. For some smaller agencies, you can enter a social security number using the format: 123-45-6789.

10. In the Agency Provider ID text fields, enter any identification codes provided by the agency’s administrative agency.

11. Each agency must have an individual contact person for financial and contract matters. This is often the director or financial officer. Enter their name, title and contact information in the corresponding text fields.

12. Each agency must have an Eligible Metropolitan Area (EMA) number.

13. If your agency is a HRSA (Health Resources and Services Administration) grantee, select the “HRSA” checkbox.

14. Enter any extra agency information in the Notes text box.

15. If no additional changes are required, click the Save + Done button. Clicking the Cancel button will clear any changes made and take you back to the Agency Detail screen.

Adding or Editing a Site

Agencies can have multiple sites from where they can provide services. To add or edit a site:

<table>
<thead>
<tr>
<th>Site Name *</th>
<th>Main</th>
<th>3rd Mission</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Code</td>
<td>Main</td>
<td>3M</td>
</tr>
<tr>
<td>Street 1 *</td>
<td>1119 Montgomery St.</td>
<td>123 Clear View Dr.</td>
</tr>
<tr>
<td>Street 2 *</td>
<td>Suite 400</td>
<td>Suite 300</td>
</tr>
<tr>
<td>City *</td>
<td>La Jolla</td>
<td>Walnut Creek</td>
</tr>
<tr>
<td>State &amp; ZIP</td>
<td>CA 90111</td>
<td>CA 94118</td>
</tr>
<tr>
<td>County *</td>
<td>Riverside</td>
<td>Yolo</td>
</tr>
<tr>
<td>Geo Area/HSDA</td>
<td>South</td>
<td>South</td>
</tr>
<tr>
<td>Phone 1 *</td>
<td>912-444-3333 (Main)</td>
<td>960-444-4444 (Main)</td>
</tr>
<tr>
<td>Phone 2 *</td>
<td>405-322-3333 (Fax)</td>
<td>212-333-2222 (Fax)</td>
</tr>
</tbody>
</table>

1. From the ARIES menu bar at the top of the ARIES screen (see page 15), choose the Find → Agency menu item.
2. Enter the name of your agency in the “Agency” text field. As a shortcut, you can enter the first few letters of the agency and use the “*” wildcard. For instance, if you wanted to find the Ryan White Center, you would enter “ryan*” and click the Search button.

3. If you are taken to the Agency Search Result screen, click on the name of your agency to get to Agency Detail screen.

4. From the Agency Detail screen, click the Edit button, which takes you to the Agency Edit screen.

5. Click the Save + Next button, which takes you to the Agency Sites screen. Here, your agency’s sites will be displayed in columns.

6. To create a new site for an agency, click the New button. To change information for an existing site, click the Edit button. When you are editing or adding an agency site, all text fields with red asterisks must be filled out.

7. Enter the site name.

8. If available, enter the site code.

9. Enter the address in the appropriate fields. Use the drop-down lists to enter the state and county information.

10. Use the drop-down list to enter the site’s geographic area or their Health Services Delivery Area (HSDA).

11. Enter the site’s phone numbers. Use the drop-down lists to identify the phone number as the main number, a fax number, or a telecommunications device for the hearing impaired (TTY).

12. When you are finished, click the Save button. Clicking the Cancel button clears any changes made.

13. After you have completed your changes, click the Done button, which will take you back to the Agency Details screen.

Creating or Changing Contracts

Services are reimbursed based on contracts with funding sources. You can use ARIES to track your funding sources, contracts, and services. Before creating new contracts, make sure all funding sources information has been added (see page 224). When you are entering or editing contract information, be as accurate and complete as possible. Accurate and complete information will help facilitate budgeting and tracking.
1. From the ARIES menu bar at the top of the ARIES screen (see page 15), choose the Find → Agency menu item.

2. Enter the name of your agency in the “Agency” text field. As a shortcut, you can enter the first few letters of the agency and use the “*” wildcard. For instance, if you wanted to find the Ryan White Center, you would enter “ryan*” and click the Search button.

3. If you are taken to the Agency Search Result screen, click on the name of your agency to get to the Agency Detail screen.

4. From the Agency Detail screen, click the Funding and Contracts tab. Then click the Edit button, which will take you to the Agency Funding Sources screen. Make sure all your funding sources, including federal, state, county, city, and private sources are entered on this screen.

5. Click the Next button, which will take you to the Agency Contracts screen.

6. To change existing contract information, click the Edit button. To list a new contract, click the New button.
7. Enter the contract name in the first text field. Choose the funding source from the drop-down list. If the funding source is not listed, you can add it in the Agency Funding Sources screen.

8. Enter the contract number followed by the start and end date of the contract. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.” Enter the dollar amount of the contract in the last text field.

9. When you are finished, click the Save button to save the contract general information. Next you have to enter the services provided under that contract. Click the “Edit Services” button to go to the Agency Services screen (see page 226).

10. If you are finished entering contracts for your agency, click the Done button.

Creating an Agency

If you are part of an administrative agency or partner and you have the proper permissions, you can create an agency.

1. From the ARIES menu bar at the top of the ARIES screen (see page 15), choose the Find → Agency menu item, which takes you to the Agency Search screen.

2. Enter the name of the agency you wish to create and click the Search button.
3. If the agency name is not found, click the New Agency button, which takes you to the Agency Edit screen.

4. Enter the agency’s entire name in the Agency Full Name text field.

5. In the “Agency Short Name” text field, enter an abbreviated version of the agency name. For instance, for County Medical Center, you might use “County.” This
short name is used in screens and reports where the full agency name might not format correctly.

6. If the agency has a website, enter it in the “Website” text field. When entering the website name, include “http://” at the beginning. For instance, if the website is www.ryanwhitecenter.org, enter “http://www.ryanwhitecenter.org” in the text field.

7. Acuity tools are used to measure the severity of a disease. As different agencies employ different acuity systems, it is important that the tool each agency uses is available to help standardize case management services. Enter the agency’s link including “http://” at the beginning. For instance, if the website is www.ryanwhitecenter.org/acuity, you would enter “http://www.ryanwhitecenter.org/acuity” in the text field.

8. In the Taxpayer ID text field, enter the nine-digit taxpayer ID using the following format: 99-1234567. For some smaller agencies, you can enter a social security number using the format: 123-45-6789.

9. In the Agency Provider ID text fields, enter any identification codes provided by the agency’s administrative agency or partner.

10. Each agency must have an individual contact person. Enter their name, title and contact information in the corresponding text fields.

11. Enter the agency’s Eligible Metropolitan Area (EMA) number.

12. If your agency is a HRSA (Health Resources and Services Administration) grantee, select the HRSA checkbox.

13. Enter any additional agency information in the Notes text box.

14. Click the Save + Next button which takes you to the Agency Sites screen.

15. Click the New button, which brings up a form to enter in new site information.
16. Enter the site name.

17. If available, enter the site code.

18. Enter the address in the appropriate fields. Use the drop-down lists to enter the state and county information.

19. Use the Geog Area/HSDA drop-down list to enter the site’s geographic area or their Health Services Delivery Area (HSDA).

20. Enter the site’s phone numbers. Use the drop-down lists to identify the phone number as the main number, a fax number, or a telecommunications device for the deaf (TTY).

21. Click the Save button.

22. If you have additional sites to enter, click the New button. Otherwise, click the Done button, which takes you to the Agency Info screen. You can add contract information later (see page 207).
23. In this screen, ARIES prompts you to create an ARIES administrator account. Click the Create Admin Acct button. The administrator you assign should be someone responsible for the agency’s advanced ARIES functions. For instance, if you were creating an administrative agency, they would be responsible for creating new agencies.
24. Enter their first and last names in the corresponding text fields.

25. If applicable, enter the administrator’s job title.

26. Next to Employment, use the drop-down list to select whether the administrator is Full Time, Part Time or a Volunteer. For full-time staff enter 1 as the Full-Time Equivalent (FTE). For part-time and volunteer staff, enter the proportion of the Full Time Equivalent (FTE) as a number between 0 and 1 in the accompanying text field. For instance, if the administrator works half time, enter .5 in the text field.

27. Enter the administrator’s phone and fax numbers and email address in the corresponding text fields.

28. Use the drop-down list to select which location is the administrator’s primary work site.

29. In the Initials/Short name text field, enter an abbreviated version of the administrator’s name. For instance, for Mary Jones, you might use, “MJ.” This short name will be used in screens where their full name might not fit correctly.

30. Use the Home Page drop-down list to select the screen that will appear when the staff person logs in (see page 14). The default screen is the ARIES welcome screen (see page 15). You should select the home page that the administrator will visit most frequently.
31. In the ARIES Login text field, enter the administrator’s login ID. The login ID must be from 8-32 characters in length and must use only letters and numbers. For instance, “maryj” is not an acceptable login but “maryjones” and “maryj222” are.

32. Enter the administrator’s password in the Password text field. You must reenter the password identically in the Confirm Password text field. The new password must include at least one number, one lower case, and one uppercase character, and must be 6-12 characters long. For instance, “rover” is not an acceptable password but “roVer82” is.

33. From the User Group drop-down list, select Agency ARIES Administrator. If you are creating an administrative agency, select Administrative Agency ARIES Administrator.

34. Click the Save + Next button to customize the staff person’s permissions on the Staff Permissions screen. Click the Save + Done button to use the standard administrator permissions.

**Agency Screens**

The agency screens in ARIES allow you to search for agencies, view agency addresses, manage agency contracts, and produce CADR reports. A search for agencies by services provided can be helpful if you need to find referrals for services such as housing, food banks, or transportation.

Most agency information will be entered and maintained by administrative agencies or ARIES Administrators in conjunction with a representative of the agency. When you are entering or editing agency information, be as accurate and complete as possible. Accurate and complete information will help facilitate budgeting and tracking.

The agency screens include:

- **Agency Search**
- **Agency Search Result**
- **Agency Detail**
  - **Funding & Contracts**
  - **Services Provided**
  - **CADR**
- **Agency Edit**
  - **Agency Sites**
  - **Funding Sources**
  - **Contracts**
  - **Primary Services**
  - **Subservices**
Agency Search

You can use the Agency Search screen to find a specific agency by name. You can also use this screen to access agencies that provide specific services, which can be helpful in finding referrals. From the ARIES menu bar at the top of the ARIES screen (see page 15), choose the Find → Agency menu item, which takes you to the Agency Search screen.

To find a specific agency, enter the name of the agency you wish to find in the Agency text field. As a shortcut, you can enter the first few letters of the agency and use the "*" wildcard. For instance, if you wanted to find the Ryan White Center, you would enter "ryan*" and click the Search button.

To find agencies that provide specific services, use the Services drop-down list, which lists all available services. Select the service or class of services and click the Search button to get to the Agency Search Results screen. For instance, if you need to give an oral healthcare referral, choose the dental service you are searching from the drop-down list. ARIES will search for all agencies that provide this service.

You can control the number of agencies listed in the Agency Search Results screen with the Display text field. The default is set at 20, which is about what will fill the results screen. You can always narrow or increase your search results later.
Agency Search Result

When you click the Search button on the Agency Search screen, ARIES looks up all the agencies that match your criteria and then displays them on the Agency Search Result screen. If there is only one agency found in your search, you will be taken directly to the Agency Detail screen.

<table>
<thead>
<tr>
<th>Name</th>
<th>Phone</th>
<th>Website</th>
</tr>
</thead>
<tbody>
<tr>
<td>County Administrative Agency</td>
<td>555-555-1212</td>
<td><a href="http://www.countyaa.gov">http://www.countyaa.gov</a></td>
</tr>
<tr>
<td>County Hospital</td>
<td>555-555-1212</td>
<td><a href="http://www.hospital.gov">http://www.hospital.gov</a></td>
</tr>
<tr>
<td>Partner</td>
<td>555-555-1212</td>
<td><a href="http://www.partner.gov">http://www.partner.gov</a></td>
</tr>
<tr>
<td>Ryan White Center</td>
<td>415-777-1234</td>
<td><a href="http://www.ryanwhitecenter.org">http://www.ryanwhitecenter.org</a></td>
</tr>
</tbody>
</table>

Agency search results are listed in a table, alphabetically by agency name. Clicking on an agency name will take you to that agency’s Agency Detail screen. Clicking on an agency’s website link will open a new browser window for that agency’s website.

If you’re having trouble finding the agency you’re looking for, try a new search and double-check your spelling. The quickest way to get results is to type the first few letters of the agency name followed by “*” and choosing from the resulting matches.

If you wish to change the number of agency listings on a page, you can increase or decrease the number in the Display text field.

If you have the proper permissions and you want to create a new agency, click the New Agency button at the bottom of the screen.

Agency Detail

The Agency Detail screens contain information about an agency, including contact and site information, funding sources, services provided, and CADR information. Use the tabs at the top of the window to toggle between the screens.

If you have the proper permissions, edit agency information by clicking the Edit button on any of the screens.
The Agency Info screen contains the contact information for an agency including all the agency’s sites.

Clicking the contact email link will open a new email message addressed to the contact person.

Clicking the “Find Staff” link will take you to a Staff Search Result screen (see page 197) that contains all the staff persons employed by that agency.

Clicking the Edit button will take you to the Agency Edit screen.

Funding & Contracts

The Funding & Contracts screen displays a table of an agency’s contracts and their funding sources. The table columns include the contract name, the source of the funding, the contract number, the term of the contract, and the amount of funding.
Clicking the Edit button will take you to the Agency Funding Sources screen.

Services Provided

The Services Provided screen displays a table of all the services provided by an agency. The services are broken down by contract, program, primary service category, and secondary service category.

The table columns include:

<table>
<thead>
<tr>
<th>Service</th>
<th>Unit</th>
<th>Default Quantity</th>
<th>Default Price</th>
<th>UOS Goal</th>
<th>UOC Goal</th>
<th>Budget</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Health Education Assessment</td>
<td>Visit</td>
<td>1</td>
<td>$15.00</td>
<td>200</td>
<td>200</td>
<td>$3,000.00</td>
<td>Volunteers reimbursed for mileage and meals.</td>
</tr>
<tr>
<td>Nutrition Information Session</td>
<td>Hour</td>
<td>2</td>
<td>$20.00</td>
<td>100</td>
<td>50</td>
<td>$2,000.00</td>
<td>Session takes two hours per client.</td>
</tr>
</tbody>
</table>
Default Quantity | The standard number of units provided for a client. For instance, if a standard nutrition information session took two hours to give, the default quantity would be “2.” When entering a service line item in an Edit Service screen (see page 186) the staff person enters the actual number of units supplied.

Default Price | The cost per unit of service. For instance, meals might cost $5.00 per unit.

UOS Goal | The Units of Service Goal. This refers to the total number of units planned for this service under this contract. For instance, if bus tokens were the service provided, the UOS Goal might be 10,000 bus tokens during the contract year.

UDC Goal | The Unduplicated Clients Goal. This refers to the number of discrete clients expected to receive this service during the contract year. Using the previous bus token example, if each client were eligible for 10 bus tokens, the UDC Goal would be 1,000.

Budget | The money available in the contract for this subservice.

Notes | Any additional information regarding the service.

Clicking the Edit button will takes you to the Agency Contracts screen.

**CADR**

All CARE Act funded grantees are required to complete the CARE Act Data Report (CADR) to collect data on all services funded by HRSA’s HIV/AIDS Bureau. ARIES includes a CADR wizard to help automate the CADR process.

The CADR wizard implements the 2005 CADR. For instructions on completing the wizard, consult section 0 (see page 291).

**Agency Edit**

The Agency Edit screens can only be accessed if you have the proper permissions. Within them, you can edit an agency’s contact and site information, funding sources, and services provided.
In the first screen you can edit an agency’s contact information. All text fields with red asterisks must be filled out.

Enter the agency’s entire name in the Agency Full Name text field.

In the “Agency Short Name” text field, enter an abbreviated version of the agency name. For instance, for County Medical Center, you might use “County.” This short name is used in screens and reports where the full agency name might not format correctly.

If the agency has a website, enter it in the Website text field. When entering the website name, include “http://” at the beginning. For instance, if the website is www.ryanwhitecenter.org, you would enter “http://www.ryanwhitecenter.org” in the text field.

Acuity tools are used to measure the severity of a disease. As different agencies employ different acuity systems, it is important that the tool each agency uses is available to help standardize case management services. Enter the agency’s link including “http://” at the beginning. For instance, if the website is www.ryanwhitecenter.org/acuity, you would enter “http://www.ryanwhitecenter.org/acuity” in the text field.

In the Taxpayer ID text field, enter the nine-digit taxpayer ID using the following format: 99-1234567. For some smaller agencies, you can enter a social security number using the format: 123-45-6789.

In the Agency Provider ID text fields, enter any identification codes provided by the agency’s administrative agency.

Each agency must have an individual contact person. Enter their name, title and contact information in the corresponding text fields.

Enter the agency’s Eligible Metropolitan Area (EMA) number.
If your agency is a HRSA (Health Resources and Services Administration) grantee, select the HRSA checkbox.

Enter any extra agency information in the Notes text box.

Click the Save + Next button to edit agency site, funding and services information. If no additional changes are required, click the Save + Done button. Clicking the Cancel button will clear any changes made and take you back to the Agency Detail screen.

If you have the proper privileges, you can deactivate an agency, removing the agency from future access. To reactivate an agency, contact an ARIES administrator.

**Agency Sites**

The Agency Sites screen lists an agency’s location and any additional sites. Each site is displayed in a column listing their location and contact information.

### Ryan White Center Sites

<table>
<thead>
<tr>
<th>Site Name</th>
<th>Main</th>
<th>3rd Mission</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Code</td>
<td>Main</td>
<td>3M</td>
</tr>
<tr>
<td><strong>Street 1</strong></td>
<td>1119 Montgomery St.</td>
<td>123 Clear View Dr.</td>
</tr>
<tr>
<td><strong>Street 2</strong></td>
<td>Suite 400</td>
<td>Suite 300</td>
</tr>
<tr>
<td>City</td>
<td>La Jolla</td>
<td>Walnut Creek</td>
</tr>
<tr>
<td>State &amp; ZIP</td>
<td>CA 90111</td>
<td>CA 94118</td>
</tr>
<tr>
<td>County</td>
<td>Riverside</td>
<td>Yolo</td>
</tr>
<tr>
<td>Geog Area/HSDA</td>
<td>South</td>
<td>South</td>
</tr>
<tr>
<td><strong>Phone 1</strong></td>
<td>912-444-3333 (Main)</td>
<td>950-444-4444 (Main)</td>
</tr>
<tr>
<td><strong>Phone 2</strong></td>
<td>405-322-3333 (Fax)</td>
<td>212-333-2222 (Fax)</td>
</tr>
</tbody>
</table>

Click the Edit button to change a site’s information. To enter a new site for an agency, click the New button.
When you are editing or adding an agency site, all text fields with red asterisks must be filled out.

Enter the site name.

If available, enter the site code.

Enter the address in the appropriate fields. Use the drop-down lists to enter the state and county information.

Use the drop-down list to enter the site’s geographic area or their Health Services Delivery Area (HSDA).

Enter the site’s phone numbers. Use the drop-down lists to identify the phone number as the main number, a fax number, or a telecommunications device for the deaf (TTY).

When you are finished, click the Save button. Clicking the Cancel button will clear any changes made.

If you have the proper privileges, you can deactivate a site, removing it from future access. To reactivate a site, contact an ARIES administrator.

When you are finished editing the Agency Sites information, click the Done button if you are finished editing the agency information or click the Next button to edit the agency’s funding sources.
Agency Funding Sources

The Agency Funding Sources screen displays a table of the agency’s funding sources, including the grantee number and any notes.

Click the Edit button to make any changes to a funding source or click the New button to list an additional funding source.

When you are editing or adding grant information, use the Funding Source drop-down list to choose the grantor. If the grantor is not listed – for instance, if it is a private donor – enter the funding source name in the “If Other” text field.

Enter the grantee number in the middle text field. This is usually an internally administered number. Enter any additional information in the Notes text box.

When you are finished, click the Save button. Clicking the Cancel button will ignore any changes made.

If you have the proper privileges, you can deactivate a funding source, removing it from future access. To reactivate a funding source, contact an ARIES administrator.
When you are finished editing the Agency Funding Sources information, you can either click the Done button to return to the Funding & Contracts screen or click the Next button to edit the agency’s contracts and services.

**Agency Contracts**

In the Agency Contracts screen, you can edit an agency’s contracts and services as well as add new ones. The contracts are displayed in a table containing the contract name, the funding source, contract number, the term of the contract, and the grant amount. Make sure you enter all funding sources in the Funding Sources screen (see page 224) before you start to enter contract information.

### Ryan White Center Contracts

*Please enter all the contracts for this agency.*

*For each contract, you will be asked to define the services provided under the contract.*

<table>
<thead>
<tr>
<th>Contract Name</th>
<th>Funding Source</th>
<th>Contract #</th>
<th>Start Date</th>
<th>End Date</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dental Services</td>
<td>Irvine Foundation</td>
<td>1444</td>
<td>1/1/2004</td>
<td>12/31/2004</td>
<td>$500,000.00</td>
</tr>
<tr>
<td>Hotline 04-05</td>
<td>Title 1</td>
<td>1234</td>
<td>1/1/2004</td>
<td>12/31/2004</td>
<td>$100,000.00</td>
</tr>
<tr>
<td>Primary Care</td>
<td>State GF</td>
<td>4566</td>
<td>5/1/2004</td>
<td>4/30/2005</td>
<td>$500,000.00</td>
</tr>
</tbody>
</table>

To change contract information, click the Edit button. To list a new contract, click the New button.

When you are editing or adding new contract information, enter the contract name in the first text field. It is useful to include the contract year in the contract name to distinguish renewals of contracts, e.g. “Dental Services 05” for the contract in fiscal year 2005.

Choose the funding source from the drop-down list. If the funding source is not listed, you can add it in the Agency Funding Sources screen.

Enter the contract number followed by the start and end date of the contract. Use the following format: MM/DD/YYYY. For instance, February 15, 2005 would be “2/15/2005.” Enter the dollar amount of the contract in the last text field.
When you are finished, click the Save button. Clicking the Cancel button will clear any changes made.

If you have the proper privileges, you can deactivate a contract, removing it from future access. To reactivate a contract, contact an ARIES administrator.

When you are finished entering contract information, click the Edit Services button to enter services information for a contract. If you are finished entering contracts and services information for an agency, click the Done button.

**Agency Primary Services**

In the Agency Primary Services screen, all the services provided under a contract should be indicated. Check all the services associated with the contract and click the Save + Next button, which will take you to the Agency Subservices screen. Clicking the Cancel button will clear any changes made and take you back to the Agency Contracts screen.

**Ryan White Center Primary Services for Dental Services**

*Please check each category of service your agency provides for the contract. In the next screen you will be able to add custom categories.*

*RYAN WHITE*
- Ambulatory/Outpatient Medical Care
  - Dermatology
  - Infectious Diseases
  - Neurology
  - Ob/Gyn
  - Oncology
  - Ophthalmology
  - Other Specialty
  - Radiology
- Mental Health Services
  - Individual
  - Group
  - Psychiatric Evaluation
  - Psychiatric Follow-up
- Oral Health Care
  - Routine Treatment
  - Prophylaxis
- Specialties

*TMP*
- Lab Tests
  - Viral Load
  - Phenotype
  - Genotype

*EIP*
- Medical
  - Medical/Health Assessment
  - Laboratory Specimen Collection
  - Medical Follow-up/Consultation
  - Minor Medical Treatment
  - HIV Transmission Risk Reduction Session: Medical
- Psychosocial
  - Psychosocial Assessment
  - Psychosocial Counseling (One-on-One)
  - Psychosocial Counseling (Group)
  - Peer Counseling
  - Substance Use Counseling/Intervention
  - HIV Transmission Risk Reduction Session: Psychosocial

If you need to define a subservice within a particular service – for instance, if you needed to distinguish between walk-in clients and those who made appointments – you can create and edit subservices in the next screen.

**Agency Subservices**

The Agency Subservices screen displays a table of the services provided under a contract. Each subservice is listed by program, primary service, and secondary service category. The columns are listed as follows:
Unit: The quantifiable unit of service. For instance, if the service were nutritional education, the units might be hours, or if it were food service being provided, the units might be meals.

Default Quantity: The standard number of units provided for a client. For instance, if a standard nutrition information session took two hours to give, the default quantity would be “2.” When entering a service line item in an Edit Service screen (see page 186) the staff person enters the actual number of units supplied.

Default Price: The cost per unit of service. For instance, meals might cost $5.00 per unit.

UOS Goal: The Units of Service Goal. This refers to the total number of units planned for this service under this contract. For instance, if bus tokens were the service provided, the UOS Goal might be 10,000 bus tokens during the contract year.

UDC Goal: The Unduplicated Clients Goal. This refers to the number of discrete clients expected to receive this service during the contract year. Using the previous bus token example, if each client were eligible for 10 bus tokens, the UDC Goal would be 1,000.

Budget: The money available in the contract for this subservice.

Notes: Any additional information regarding the service.

Click the Edit button to make any changes to a subservice, or you can click the New button to create a new subservice under a category. When entering new information, it is important to be as accurate as possible. The more complete your information, the easier it will be to enter new service line items, and the easier it is to track and budget services.
When you are editing or adding a subservice, you can edit the subservice name in the Service text box. Defining specific subservices can be helpful in tracking and budgeting. For instance, if you were administering a health education assessment test and you needed to distinguish between walk-in clients and those who made appointments, you could create two subservices - one for walk-ins and one for appointments. Then you would run reports to determine which approach clients prefer and allocate staff time and availability to match client preferences.

When you are finished entering information for a service or subservice, click the Save button. Clicking the Cancel button will ignore any changes made.

When you have finished entering and editing services information, click the Done button at the bottom of the screen, which will take you to the Agency Contracts screen.

5. Reports

ARIES allows users with the proper permissions to generate reports on your agency’s records. For instance, you can generate reports on clients’ needs assessments or mailing labels for your clients.

Reports are used for summarizing services, managing clients, planning work in your agency, and for financial analysis. Data collectors and researchers also use reports for demographics analyses. ARIES includes a selection of commonly used reports, but advanced users with access to the ARIESReportExport application can create customized ad hoc reports.

Reports can be printed directly from the ARIES screens, or you can export your report for better control over layout and formatting. You export data as comma-separated values, tab-separated values, or an XML file, which you can then import into other applications, like a spreadsheet or word-processing program, for post-processing.

Generating reports in ARIES

ARIES allows those with the proper permissions to run reports in a few quick steps. After you run a report, you can print directly from the ARIES screen or you can export your data to other applications for post-processing.
To access ARIES reports, from the menu bar, choose the Reports menu. A drop-down lists the different reports screens.

The Reports screens include:

- **Client Reports**
- **Services Reports**
- **Finance Reports**
- **Management Reports**
- **Cross Tab Wizard**
- **Compliance Reports**

Select the report screen you want to access, which takes you to a list of available reports.

**Client Reports**

- **Pending Eligibility Documents**: Displays client, staff, document, intake date, and client contact information for each eligibility document whose status is pending. Filter by intake date.

- **Client Status**: Displays client name, current status, previous status, date of last change, reason, and staff person for clients with selected status values over a range of dates.

- **Active Client Roster by Staff**: Display staff person, client, and phone number for active clients. Filter by staff person.

Click on a name to access that report’s **Filter Values** screen, where you can narrow the scope of your report.

**Filter Values**

The Filter Values screen displays all the filter criteria for a report. For instance, you may want to search the incomplete tasks of a specific staff person or you might want immunization information only for a given month.
ARIES uses a series of drop-down lists and text fields to define the parameters of your report. Each report has a separate set of filters that pertain to the information you are reporting on.

**Dates and Numbers**

Filters for fields that are dates or numbers allow you to match a specific value of a range of values. For example, for a follow-up date, you can filter on, between, before or after dates. From the drop-down list, select what type of filtering you wish to do. Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for records on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all entries before – but not including – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve records dated before midnight on June 22, 2005.
Select “After” to bring up all records dated after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all records from 12:00 AM the first date to 11:59 PM the second date. For example, entering 6/23/2005 in the first text field and 6/27/2005 in the second text field and clicking Search will display all records on June 23, 2005 through June 27, 2005.

You can also select “Is Null” or “Is Not Null” from the drop-down lists. Selecting “Is Null” will sort through all records that have no date entered. This can be helpful in searching for incomplete or missing information. Selecting “Is Not Null” will only include the records that have a date.

**Strings**

For alphabetical entries like names, you can use the Equals filter to report on records that match that name exactly. For instance, selecting Equals and entering “Smith” in the first text field reports on all the entries whose name is Smith.

You can also use the “Like” filter to choose entries that match a string containing wildcards. Wildcards are characters that substitute for a character or string of characters. For instance, if you were filtering for a name you weren’t sure the spelling of, you could use the “_” wildcard, which substitutes for a single character. So if a client were named either Smith or Smyth, you would enter “Sm_th.” The filter will look for every five-letter entry whose first two letters were “Sm” and whose last two letters were “th.”

The “%” wildcard substitutes for a string of characters of any length. For instance, if you wanted to search through all names that began with the letter M, you would enter “M%.”

You can also filter on an alphabetical range of entries. For instance, to report on records from A through L, select “Before” from the drop-down list and enter “m” in the first text box. To report on records from M through Z, select “After” from the drop-down list and enter “m” in the first text box.

To select a range of letters, select “Between” from the drop-down list and enter the alphabetical range you wish to report on. For instance, to search records from D through K, enter “D” and “L” in the two text fields. ARIES searches all entries from D up to, but not including, L.

You can also select “Is Null” or “Is Not Null” from the drop-down lists. Selecting “Is Null” will sort through all records that have no data entered. This can be helpful in searching for records with incomplete or missing information. Selecting “Is Not Null” will include only the records that contain data in that field.

**Drop-down list Entries**

To filter through entries that use drop-down lists like gender, ethnicity, etc., select the entry you wish to filter through. To filter through multiple entries, hold down the control...
key (Ctrl) on your keyboard and click the entries you wish to select. For instance, if you wanted to include clients who were born genetically male, under Client.gender, you would control-click “Male” and “Transgender MTF.”

At the bottom of the screen, next to Display, is the default maximum number of results that will be included in your result. Increasing this number will display more results, but will take longer to generate. You can change this value to customize your report length.

Selecting the “Display print format” checkbox displays your report without the ARIES menu bar at the top of the screen or other navigation buttons. This is better for printing.

Click the Report button to display the Report Results. Or click the Export button to export your data to a file to import into another application (see page 233).

Report Results

ARIES publishes your report results based on the filters you set in the previous screen and displays the results in a table.
The table lists the column names in the first row with the values published underneath. If no columns display, ARIES found no records that matched your criteria. Click the Back button from the ARIES menu bar to reenter your filter criteria.

Underneath the report results table, ARIES displays how many records were found and when the report was generated, along with the filter criteria you specified.

Click the Export button to export the results of your report.

**Exporting Reports**

If you want to have more control over the formatting of your reports, you can export your report results for use in other applications for post-processing. For instance, you may want to format names and addresses to fit on adhesive mailing labels. In that case, you would export your mailing labels to Microsoft Word. You can export directly from the Filter Values screen, or if you want to view your data first, you can generate a report, view the results, then click the Export button at the bottom of the screen.
When you click the Export button from the Report Results screen, you are taken to back to the report’s Filter Values screen (see page 229). This is done so that you can increase the Display number to include records that might not have been included in your original report.

If you are returning to the Filter Values screen from the Report Results screen, your search criteria are preserved in the text fields, but for any drop-down list items, you will have to re-select your choices. If your original report produced the maximum number of records in the Display field, you may want to increase the value to include all records in your export file. You can enter any value up to 100,000.

Click the Export button, which takes you to the Export Format screen.
From the Export Format drop-down list, select the file format of your export file. XML is the default choice as it is the most reliable in preserving your report’s data. If you are exporting to Microsoft Excel 2003 or XP, you should always export in XML.

Older applications may not be compatible with XML. In this case, export your file as “Text, tab-delimited.” If you are still encountering problems importing data into your application, try “Text, comma-separated.”

ARIES generates a file based on your format choice and creates a link so that you can download it to your computer. With your mouse, click on the link and choose the “Save Target As…” option to save the file to your computer.

When you save your file, a window opens where you can rename it for your own filing purposes. For instance, if your report is your monthly client roster, you might name it “client_roster_June2004.xml”
The file can then be imported into another application.

If you are exporting a report with multiple tables like some cross-tab reports, it is best to export your reports in XML. If the application you are exporting to does not support XML, export your data as text, either comma- or tab-separated.

Export Report: Crosstab Results for Services

Export Format: Text, comma-separated

Please right-click on the link below and choose "Save Target As..." to save the file to your computer. Then open it with your application. If you used the Table option, there will be a separate link for each table within your report, and you must download each one separately. This export is stored on the server for 10 minutes.

CrosstabResultsforServicesExport_Results--ZIPCodesbyService-PrimaryCategorywithGender=Male_1500000012175964945.csv
CrosstabResultsforServicesExport_Results--ZIPCodesbyService-PrimaryCategorywithGender=Other_15000000121139124855.csv
CrosstabResultsforServicesExport_Results--ZIPCodesbyService-PrimaryCategorywithGender=Female_15000000121139124855.csv
The Export screen displays multiple links – one for each table generated by your report. Right click and select “Save Target As” for each separate link to include the full cross tab report.

**Printing Reports**

To print your reports, in the Filter Values screen, select the “Display print format” checkbox before clicking the Report button.

This generates a report without the ARIES menu bar on top or buttons the bottom. To print your report, select the Print option from the Internet Explorer File menu. Consider printing in landscape format if the report table is very wide.

After you print your report, click the text link at the bottom of the screen to return to the report screen.

**Change Display Order**

If you are an ARIES administrator and you have the proper permissions, you can change the display order for the Client, Services, Finance, and Management reports screens.

At the bottom of the reports screens is a Display Order button. If you do not see it, then you do not have the proper permissions to change the reports display order.

Clicking the button brings up the Change Display Order screen where the preconfigured reports included with ARIES are listed in the order they display in the reports screen.
To change the placement of a report, select it in the list box and click the up or down buttons on the left to move it up or down the list.

To hide a report from view, select it and click the Hide button. The report name moves to the Hidden Reports list. To unhide a report, select it from the Hidden Reports list and click the Show button. The report name moves back to the Shown Reports list.

Customized ad-hoc reports do not display in this screen.

When you have finished configuring the report display order, click the Save button, which takes you back to the reports screen. To return to the reports screen without saving changes, click the Cancel button.

**Client Reports**

The Client reports screen contains reports directly pertaining to clients and client management. For instance, you can run a report that displays your agency’s active clients.

To access the Client Reports screen, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Client menu item.
The screen displays the name of the report along with a brief description of the report’s function. To generate a report, click its name.

If you are an ARIES administrator and you want to change the order in which the reports are listed, click the Display Order button at the bottom of the screen, which takes you to the Change Display Order screen (see page 237).

The client reports include:
- Pending Eligibility Documents
- Client Status
- Active Client Roster by Staff
- Referrals
- Needs Assessment
- Immunizations
- Disease Management

### Pending Eligibility Documents

The Pending Eligibility Documents report generates a list of all client eligibility documents that have not been validated by your agency. Upon intake, clients may not have all the necessary documents necessary to enroll with your agency, so periodically you may want to run this report and follow up with the clients with incomplete documentation.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Client menu item to get to the Client Reports screen. Click the “Pending Eligibility Documents” link.
This brings up the filter screen where you can define the parameters of your report. For instance, you can run a report on the previous six months.

From the Intake Date drop-down list, select “After” and enter a date in the first text field using the format MM/DD/YYYY. For example, if you wanted to search for all missing eligibility documents for clients who enrolled after October 1, 2004, enter 10/1/2004. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To search all missing eligibility documents, from the Intake Date drop-down list, choose the blank selection and leave the text fields empty.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have entered your filter parameters, click the Report button.
The report results display in a table arranged by client name. From left to right the table lists the client name, the staff person who performed the intake, the missing document, the date of the intake, and the client’s contact information.

If the client contact info lists “Do not phone,” the client does not want to be contacted by telephone. “No messages” means the client does not want any message left on voicemail or with other persons. “Be anonymous” means you can leave a phone message but do not mention the name of the agency with the message.

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To **export your report**, click the Export button (see page 233).

**Client Status**

The Client Status report allows you to generate reports based on a client’s status with your agency. In the report filter, you can specify the status of the clients. For instance, if you wanted to generate a list of clients who became inactive in 2004 or if you want a list of current, active clients, the Client Status report can be configured to do either.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Client menu item to get to the **Client Reports** screen. Click the “Client Status” link.
This takes you to the report filter screen where you can narrow the scope of your report. In the first line you can specify your report by the date a client’s agency status changed. For instance, you could search clients who were disenrolled after a certain date. From the drop-down list, select the type of filter you want to perform. You can search on, before, or after a date, or between two dates.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To report on clients whose status changed on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.
Select “Before” to sort through all entries before – but not including – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve records dated before midnight on June 22, 2005.

Select “After” to bring up all client status records dated after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all records from 12:00 AM on the first date to 11:59 PM on the second date. For example, entering 6/23/2005 in the first text field and 6/27/2005 in the second text field and clicking Search will display all clients whose status changed from June 23, 2005 through June 27, 2005.

In the Status scroll list, select which client status type you wish to report on.

To filter through multiple types, hold down the control key (Ctrl) on your keyboard while clicking the entries you wish to select. For instance, if you wanted to report on the clients who were inactive, discharged, or disenrolled, click on each selection while holding down the control key and each will be highlighted.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have entered your filter parameters, click the Report button.

<table>
<thead>
<tr>
<th>ID</th>
<th>Client Name</th>
<th>Prev Status</th>
<th>Cur Status</th>
<th>Change Date</th>
<th>Reason</th>
<th>Staff</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dick</td>
<td>Active</td>
<td>Active</td>
<td>10/17/2004</td>
<td>New Enrollment</td>
<td>ARIES Admin</td>
<td></td>
</tr>
<tr>
<td>Janet</td>
<td>Active</td>
<td>Active</td>
<td>10/17/2004</td>
<td>New Enrollment</td>
<td>ARIES Admin</td>
<td></td>
</tr>
<tr>
<td>Lee</td>
<td>Active</td>
<td>Active</td>
<td>10/17/2004</td>
<td>New Enrollment</td>
<td>ARIES Admin</td>
<td></td>
</tr>
<tr>
<td>Jo</td>
<td>Active</td>
<td>Active</td>
<td>10/17/2004</td>
<td>New Enrollment</td>
<td>ARIES Admin</td>
<td></td>
</tr>
<tr>
<td>Kate</td>
<td>Active</td>
<td>Active</td>
<td>10/17/2004</td>
<td>New Enrollment</td>
<td>ARIES Admin</td>
<td></td>
</tr>
<tr>
<td>Lee</td>
<td>Active</td>
<td>Active</td>
<td>10/17/2004</td>
<td>New Enrollment</td>
<td>ARIES Admin</td>
<td></td>
</tr>
<tr>
<td>Moan</td>
<td>Active</td>
<td>Active</td>
<td>10/17/2004</td>
<td>New Enrollment</td>
<td>ARIES Admin</td>
<td></td>
</tr>
<tr>
<td>Eliz</td>
<td>Active</td>
<td>Active</td>
<td>10/17/2004</td>
<td>New Enrollment</td>
<td>ARIES Admin</td>
<td></td>
</tr>
</tbody>
</table>

The report results display in a table that lists from left to right: the client’s agency ID, the client name, their previous status, their current status, the date of the status change, the reason for the status change, and the name of the staff person who changed their status. Clicking the staff person’s name takes you to their contact info screen.
At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To export your report, click the Export button (see page 233).

Active Client Roster by Staff

The Active Client Roster by Staff report generates a list of active clients at your agency and sorts them by the staff person. This report can give you a quick overview of your agency’s clients. You can also filter by staff name. So if you wanted to access a case manager’s client load, you can quickly run a report filtering out their last name.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Client menu item to get to the Client Reports screen. Click the “Active Client Roster by Staff” link.

This takes you to the report filter screen where you can narrow the scope of your report. Next to Staff Last Name, you can filter by staff person by selecting “Equals” from the drop-down list and entering their last name in the first text field. For instance, selecting “Equals” and entering “Jones” in the first text field filters out the clients assigned to any staff person whose last name is Jones.

To search a range of letters, select “Between” from the drop-down list and enter the alphabetical range you wish to report on. For instance, to search records from D through K, enter “D” and “L” in the two text fields. ARIES searches all entries from D up to, but not including, L.

You can also select “Is Null” or “Is Not Null” from the drop-down lists. Selecting “Is Null” will sort through all records that have no data entered. This can be used to search
for any clients who have not yet been assigned to a staff person. Selecting “Is Not Null” will include only the clients who have been assigned to any staff person.

To skip this filter, select the blank option from the drop-down list.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have entered your filter parameters, click the Report button.

<table>
<thead>
<tr>
<th>Staff</th>
<th>Client Name</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>James Biggs</td>
<td>Janet Bonds</td>
<td>Do not phone</td>
</tr>
<tr>
<td>James Biggs</td>
<td>Suzanne Chan</td>
<td>619-969-9134</td>
</tr>
<tr>
<td>James Biggs</td>
<td>Anne Garcia</td>
<td>619-892-7958 No messages</td>
</tr>
<tr>
<td>James Biggs</td>
<td>Amy Hicks</td>
<td>Do not phone</td>
</tr>
<tr>
<td>James Biggs</td>
<td>Liz Roberts</td>
<td>Do not phone</td>
</tr>
<tr>
<td>James Biggs</td>
<td>Jean Slackman</td>
<td>510-640-3364 No messages</td>
</tr>
</tbody>
</table>

The report results display in a table that lists from left to right: the staff person, the client name, and the client’s phone number. Clicking on a staff person’s name takes you to their contact info screen.

If the client contact info lists “Do not phone,” the client does not want to be contacted by telephone. “No messages” means the client does not want any message left on voicemail or with other persons. “Be anonymous” means you can leave a phone message but do not mention the name of the agency with the message.

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To export your report, click the Export button (see page 233).

**Referrals Report**

Clients often receive referrals to other agencies (see page 176). Staff persons who enter referrals enter in a target date for the client to meet with the other agency. In subsequent follow-ups, the outcome of the referral is recorded.

The Referrals Report helps track referrals and their outcomes. For instance, before performing referrals follow-ups, you can run a report on referrals that have not yet had outcomes entered.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Client menu item to get to the Client Reports screen. Click the “Referrals” link.
This brings up the filter screen where you can narrow the scope of your report with various criteria. Selecting the blank option from a drop-down list will skip that filter.

Next to Staff Last Name, you can filter by the staff person who made the referral. Select “Equals” from the drop-down list and enter their last name in the first text field. For instance, selecting “Equals” and entering “Jones” in the first text field filters out the clients assigned to any staff person whose last name is Jones.

To filter by a range of letters, select “Between” from the drop-down list and enter the alphabetical range you wish to report on. For instance, to search records from D through K, enter “D” and “L” in the two text fields. ARIES searches all entries from D up to, but not including, L.

You can also search by service type using the Primary Service filter. Select “Equals” from the drop-down list and enter their primary service in the first text field. To search for referrals where no service was entered, select “Is Null.” To search for referrals where any service was entered, select “Is Not Null.”

Use the Referral Date filter to search a specific time span when the referral was made. From the drop-down list, select the type of filter you want to perform. You can search on, before, or after a date, or between two dates.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.
Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for referrals made on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all referrals from before – but not including – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve referral records dated before midnight on June 22, 2005.

Select “After” to bring up all records dated after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all records from 12:00 AM on the first date to 11:59 PM on the second date. For example, entering 6/23/2005 in the first text field and 6/27/2005 in the second text field and clicking Search will display all records on June 23, 2005 through June 27, 2005.

The Outcome Date filter can be used to search a range of dates of outcomes of the referrals. Outcome dates are recorded after a follow-up has been made on the referral. You can also select “Is Null” or “Is Not Null” from the drop-down lists. Selecting “Is Null” sorts through all referrals where an outcome date hasn’t been recorded. Selecting “Is Not Null” reports on all referrals where an outcome date has been recorded.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have entered your filter parameters, click the Report button.
The report results display in a table sorted by client name. The table lists from left to right: the client name, their referral date, the agency who referred them, their target referral appointment date, the date of the referral outcome, the staff person who made the referral, and the client’s contact information. Clicking a staff or agency will take you to their contact info screen.

If the client contact info lists “Do not phone,” the client does not want to be contacted by telephone. “No messages” means the client does not want any message left on voicemail or with other persons. “Be anonymous” means you can leave a phone message but do not mention the name of the agency with the message.

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To export your report, click the Export button (see page 233).

Needs Assessment

Case managers routinely perform needs assessments for clients, evaluating what services they require (see page 168). Agency managers and administrators can track the number of needs assessments performed by an agency by region, date, and assessment type.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Client menu item to get to the Client Reports screen. Click the “Needs Assessment” link.
This takes you to the report filter screen where you can narrow the scope of your report.

In the first line you can specify your report by client assessment date. From the drop-down list, select the type of filter you want to perform. You can search on, before, or after a date, or between two dates.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.
Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for needs assessments on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all assessments from before – but not including – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve records for needs assessments dated before midnight on June 22, 2005.

Select “After” to bring up all records dated after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all records from 12:00 AM on the first date to 11:59 PM on the second date. For example, entering 6/23/2005 in the first text field and 6/27/2005 in the second text field and clicking Search will display all records on June 23, 2005 through June 27, 2005.

From the Geographic Area/HSDA scroll box, select which regions you wish to search. If your agency’s region doesn’t use HSDAs or to include all areas, select “All” or leave the selection blank.

To report on multiple areas, hold down the control key (Ctrl) on your keyboard while clicking the entries you want to select. For instance, if you wanted to report on needs assessments in Lubbock and Arlington, select the names while holding down the control key and each will be highlighted.

From the Categories scroll box, select which types of needs assessments you want to include in your report. To include multiple categories, use the control key to select your choices. To include all categories, select “All”.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button.
The Needs Assessment Report results display in a table listed in order of geographic area. The table lists from left to right the geographic area, the category of needs assessment, whether services were needed, and how many services were needed.

<table>
<thead>
<tr>
<th>Geographic Area</th>
<th>Category</th>
<th>Needed</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Lubbock</td>
<td>Case Management</td>
<td>Needed</td>
<td>2</td>
</tr>
<tr>
<td>1-Lubbock</td>
<td>Complementary Therapies</td>
<td>Not Needed</td>
<td>1</td>
</tr>
<tr>
<td>1-Lubbock</td>
<td>Complementary Therapies</td>
<td>Unknown</td>
<td>1</td>
</tr>
<tr>
<td>1-Lubbock</td>
<td>Dental Care</td>
<td>Not Needed</td>
<td>1</td>
</tr>
<tr>
<td>1-Lubbock</td>
<td>Dental Care</td>
<td>Needed</td>
<td>1</td>
</tr>
<tr>
<td>10-El Paso</td>
<td>Case Management</td>
<td>Needed</td>
<td>1</td>
</tr>
</tbody>
</table>

35 records, generated 10/22/2004 11:02:30 AM
Criteria: NeedsAssessment.needsAssessmentDate > '1/1/2004' AND Address.geographicArea IN ('1-Lubbock', '2-Arlington', '4-Tyler')

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To export your report, click the Export button (see page 233).

Immunizations

Immunizations Reports display client names and immunizations they have received. You can filter these reports by date of immunization and immunization type. For instance, you may want to generate a list of all clients who received hepatitis immunizations in a given year.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Client menu item to get to the Client Reports screen. Click the “Immunizations” link.
This takes you to the report filter screen where you can narrow the scope of your report. From the Test Type scroll box, you can select which immunization types you want to report on. To report on multiple immunizations, hold down the control key (Ctrl) on your keyboard while clicking the entries you wish to select. For instance, if you wanted to report on all hepatitis immunizations, select “Hepatitis A” and “Hepatitis B” while holding down the control key and each will be highlighted. To include all immunizations, select “All”.

In the Test Date filter, you can specify a range of immunization dates. From the drop-down list, select the type of filter you want to perform. You can search on, before, or after a date, or between two dates.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.
Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for immunizations on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all entries before – but not including – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve records dated before midnight on June 22, 2005.

Select “After” to bring up all immunization records dated after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all records from 12:00 AM on the first date to 11:59 PM on the second date. For example, entering 6/23/2005 in the first text field and 6/27/2005 in the second text field and clicking Search will display all immunizations from June 23, 2005 through June 27, 2005.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button.

---

<table>
<thead>
<tr>
<th>Client Name</th>
<th>Immunization Date</th>
<th>Immunization</th>
<th>Client Contact Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anthony Abara</td>
<td>06/28/2004</td>
<td>Hepatitis B</td>
<td>312-792-4077 No messages</td>
</tr>
<tr>
<td>Anthony Abara</td>
<td>06/28/2004</td>
<td>Hepatitis B</td>
<td></td>
</tr>
<tr>
<td>Benjamin Acalotto</td>
<td>07/30/2004</td>
<td>Hepatitis A</td>
<td>Do not phone</td>
</tr>
<tr>
<td>Carissa Agazzi</td>
<td>07/14/2004</td>
<td>Hepatitis A</td>
<td>312-426-1410</td>
</tr>
<tr>
<td>Dory Ahart</td>
<td>10/06/2004</td>
<td>Hepatitis A</td>
<td>Do not phone</td>
</tr>
<tr>
<td>Kevin Alaniz</td>
<td>09/01/2004</td>
<td>Hepatitis A</td>
<td>Do not phone</td>
</tr>
<tr>
<td>Martin Amanson</td>
<td>10/05/2004</td>
<td>Hepatitis A</td>
<td>214-858-5807</td>
</tr>
<tr>
<td>Samuel Aratunian</td>
<td>08/04/2004</td>
<td>Hepatitis A</td>
<td>409-410-6229</td>
</tr>
<tr>
<td>Timothy Araujo</td>
<td>09/02/2004</td>
<td>Hepatitis B</td>
<td>936-596-8784 No messages</td>
</tr>
<tr>
<td>John Paul</td>
<td>09/17/2004</td>
<td>Hepatitis B</td>
<td></td>
</tr>
</tbody>
</table>

10 records, generated 10/22/2004 11:09:17 AM
Criteria: Immunization.immunization IN ('Hepatitis A', 'Hepatitis B') AND Immunization.immunizationDate > '6/22/2004'
The Immunizations Report results display in a table sorted by client name. From left to right, the table lists client name, immunization date, immunization type, and client contact information.

If the client contact info lists “Do not phone,” the client does not want to be contacted by telephone. “No messages” means the client does not want any message left on voicemail or with other persons. “Be anonymous” means you can leave a phone message but do not mention the name of the agency with the message.

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To export your report, click the Export button (see page 233).

**Disease Management**

Two of the ways HIV+ status is monitored is by CD4 lymphocyte count and viral load test results. The Disease Management Report allows you to compare clients’ test results over two time periods. This can give a broad view of your agency’s clients’ progress.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Client menu item to get to the Client Reports screen. Click the “Disease Management” link.

This takes you to the report filter screen where you can narrow the scope of your report.

You can report on CD4 lymphocyte testing and viral load testing by entering initial and final testing dates. The report will include all clients who received testing within those two time spans. For instance, you can compare the viral loads of clients from two different years.

Use the date filters to specify a time span. From the drop-down list, select “Between.”

Enter the dates you wish to filter by in the text fields using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.
Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

Enter the beginning date in the first text field and the ending date in the second text field. Your report results will include all clients who received testing from 12:00 AM on the first date to 11:59 PM on the second date. For example, entering 6/23/2005 in the first text field and 6/27/2005 in the second text field and clicking Search will display all clients who received testing from June 23, 2005 through June 27, 2005.

Most likely, you will enter the same time spans for both CD4 and viral load testing.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the "Display print format" checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button.

The Disease Management Report results display a table sorted by client name. From left to right, the table lists the client name, the staff person assigned to them, their CD4 lymphocyte count from the first time span, their count from the second time span, and the
percentage difference between the two values. Next to that, the client’s viral load test results are compared. Each value of the CD4 and viral load tests has an associated date of the test.

<table>
<thead>
<tr>
<th>CD4 Initial</th>
<th>CD4 Final</th>
<th>CD4 Date</th>
<th>Viral Load Initial</th>
<th>Viral Load Final</th>
<th>Viral Load Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>499</td>
<td>499</td>
<td>20340</td>
<td>5482</td>
<td>5482</td>
<td>16278</td>
</tr>
<tr>
<td>361</td>
<td>361</td>
<td>54941</td>
<td>54941</td>
<td>54941</td>
<td>16278</td>
</tr>
<tr>
<td>480</td>
<td>480</td>
<td>14041</td>
<td>14041</td>
<td>14041</td>
<td>14041</td>
</tr>
</tbody>
</table>

34 records, generated 10/22/2004 11:15:01 AM
Criteria: CD4 Initial, CD4 Date IS NOT NULL AND CD4 Initial, CD4 Date IS NOT NULL AND Viral Load Initial, Viral Load Date IS NOT NULL

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To export your report, click the Export button (see page 233).

**Services Reports**

The Services reports screen displays reports that are associated with services for clients. For instance, you can generate mailing labels for sending reminders to clients for upcoming services.

**Services Reports**

Mailing Labels

Displays client name, address, city, state, Zip, anonymous, and whether to send mail with filters on client ID, Program, Date of Service, Agency Status, and Gender

If you are an ARIES administrator and you want to change the order in which the reports are listed, click the Display Order button at the bottom of the screen, which takes you to the Change Display Order screen (see page 237).

The Services Report screen includes:

**Mailing Labels**

The Mailing Labels Report allows you to search out clients by program, agency status, gender, and date of service and it outputs a report including client name and mailing address. This can be useful in sending out reminders or notices.

To print out mailing labels, export the report into an application where you can format the labels properly like Microsoft Word or Access.
To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Services menu item to get to the Services Reports screen. Click the “Mailing Labels” link.

This takes you to the report filter screen where you can narrow the scope of your report.

The Client ID filter allows you to search by the ID assigned by your agency. To search all clients, choose the blank selection from the drop-down list.

From the Program scroll box, you can report on clients receiving services from a specific program by clicking on the program name. To select multiple programs, hold down the control (Ctrl) key on your keyboard while selecting the program names. For instance, to select EIP and HOPWA, hold the control key down while clicking the names and both choices will be highlighted.

The Date of Service filter allows you to report on clients scheduled to receive services over a specific time period. From the drop-down list, select the type of filter you want to perform. You can search on, before, or after a date, or between two dates.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.
Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for clients receiving services on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all entries before – but not including – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve records dated before midnight on June 22, 2005.

Select “After” to bring up all clients receiving services after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all records from 12:00 AM on the first date to 11:59 PM on the second date. For example, entering 6/23/2005 in the first text field and 6/27/2005 in the second text field and clicking Search will display all clients receiving services from June 23, 2005 through June 27, 2005.

From the Status scroll box, select the client status you want to report on. For instance, to search out clients who are inactive or disenrolled, hold the control key down and click “Inactive” and “Disenrolled.” To skip this filter, select “All.”

From the Gender scroll box, select the client gender you want to report on. For instance, if you want to send letters to all genetically female clients, hold the control key down and click “Female” and “Transgender FTM.” To skip this filter, select “All.”

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.
When you have finished entering your filter parameters, click the Report button.

![Mailing Labels Table]

The report results display a table arranged by client name. From left to right the report includes client last name, client first name, and their mailing address. If the client lists “Yes” in the Anon column, this means that all mail should be delivered in an envelope that does not list the agency name. If the client lists “No” in the Mail column, do not send them mail.

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To export your report, click the Export button (see page 233).

### Finance Reports

The Finance reports screen contains reports pertaining to budgeting and financial information. For instance, you can generate a report on services spending for an individual contract.

![Finance Reports]

If you are an ARIES administrator and you want to change the order in which the reports are listed, click the Display Order button at the bottom of the screen, which takes you to the Change Display Order screen (see page 237).

The Finance Reports screen includes:

- **Financial**
Financial

The Financial Report allows you to report on your agency’s contract usage. You can filter your results by contract name, service type, and service dates. For instance you can report on how much in Medicare services your agency administered in a given quarter.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Finance menu item to get to the Finance Reports screen. Click the “Financial” link.

This takes you to the report filter screen where you can narrow the scope of your report.

From the Contract scroll box, select which contract you want to report on. To select multiple contracts, hold down the control (Ctrl) key from your keyboard while making your selections. For instance, to report on your Medicaid and Medicare contracts, hold the control key down while clicking “Medicaid” and “Medicare” and both selections will be highlighted. To report on all contracts, select “All.”

From the Service scroll box, select which types of services you want to report on. For instance, if you wanted to report on housing related services, select “HOPWA.” To report on multiple service types, hold the control key down while making your selections. To report on all services, select “All.”

Use the Service Date filter to report on a specific time span. From the drop-down list, select the type of filter you want to perform. You can search on, before or after a date, or between two dates.
Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

To filter for records on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all entries before – but not including – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve records dated before midnight on June 22, 2005.

Select “After” to bring up all records dated after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all records from 12:00 AM on the first date to 11:59 PM on the second date. For example, entering 6/23/2005 in the first text field and 6/27/2005 in the second text field and clicking Search will display all records on June 23, 2005 through June 27, 2005.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button.
The report results display in a table listed by agency and contract. If you are an administrative agency, subagencies are included in the report.

From left to right, the table lists: agency name, contract name, service type, and the total service costs for the specified time period.

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To export your report, click the Export button (see page 233).

**Management Reports**

The management reports screen contains reports that center around your agency and its staff. You can run reports on ARIES usage or on incomplete tasks in your agency.
# Management Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Missing HRSA Data</td>
<td>Shows clients with missing HRSA data, by the staff who was responsible for completing the client's enrollment</td>
</tr>
<tr>
<td>Staff User</td>
<td>Displays staff person, role, and last login with filters on role and last login.</td>
</tr>
<tr>
<td>Care Plan Incomplete Tasks</td>
<td>Displays client, staff, client contact, assigned to, task, and follow-up date with filters for follow-up date and staff person last name.</td>
</tr>
<tr>
<td>Unsigned Case Notes</td>
<td>Displays client, staff person, and data of note for all unsigned case notes with a filter on staff person last name.</td>
</tr>
<tr>
<td>Staff Listing</td>
<td>Listing of Staff with contact info</td>
</tr>
<tr>
<td>List of Agency, Sites, and Staff with Staff contact info</td>
<td>Line list of all staff and sites within an Agency. Also lists the phone, email, and login for all staff.</td>
</tr>
</tbody>
</table>

If you are an ARIES administrator and you want to change the order in which the reports are listed, click the Display Order button at the bottom of the screen, which takes you to the Change Display Order screen (see page 237).

The Management Reports screen includes:

- **Missing HRSA Data**
- **Staff User**
- **Care Plan Incomplete Tasks**
- **Unsigned Case Notes**

## Missing HRSA Data

The Missing HRSA Data report searches ARIES records for incomplete client information required by HRSA (Health Resources and Service Administration). When entering client data, ARIES frequently displays red asterisks next to certain fields indicating that it is HRSA-required information. Incomplete or missing fields may present problems when completing CADRs (see page 291). It is recommended that you run this report before using the CADR wizard.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Management menu item to get to the Management Reports screen. Click the “Missing HRSA Data” link.
Use the Service Date filter to report on a specific time span when services were provided. From the drop-down list, select the type of filter you want to perform. You can search on, before or after a date, or between two dates.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for records on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all entries before – but not including – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve records dated before midnight on June 22, 2005.

Select “After” to bring up all records dated after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your
report results will include all records from 12:00 AM on the first date to 11:59 PM on the second date. For example, entering 6/23/2005 in the first text field and 6/27/2005 in the second text field and clicking Search will display all records on June 23, 2005 through June 27, 2005.

The Display text field at the bottom of the screen allows you to control the maximum number of entries that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

The results screen displays a table of clients who received services during the reporting period and their missing HRSA-required information.

The first column displays the client’s name. The second column displays the staff name. The last column displays all incomplete or missing fields from the client’s record.

Beneath the table, the time span of the report displays. Beneath that, the total number of clients included in the report displays.

To export your report, click the Export button (see page 233).
Staff User

The Staff User report tracks when staff persons most recently accessed ARIES. You can sort by staff role and last sign on date. For instance, you can run a report to see which volunteers most recently logged on to ARIES.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Management menu item to get to the Management Reports screen. Click the “Staff User” link.

This takes you to the report filter screen where you can narrow the scope of your report. From the Role scroll box, select which category of staff person you wish to report on. To choose multiple staff roles, hold down the control (Ctrl) key on your keyboard as you make your selections. For instance, holding the control key down while clicking “Volunteer,” “Peer Advocate,” and “Data Entry” will highlight all three options.

You can also search by last sign on date. For instance, you can report on which staff persons last signed onto ARIES over the past month.

From the drop-down list, select the type of filter you want to perform. You can search before or after a date, or between two dates.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.
Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for records on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all staff persons whose last logon was before – but not on – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve staff persons whose most recent logon was before midnight on June 22, 2005.

Select “After” to bring up all staff persons who most recently logged on after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all staff persons whose last logon occurred from 12:00 AM on the first date to 11:59 PM on the second date.

If a staff person who may have logged in during the period you specify has logged on more recently, they will not be included in the report.

To include all dates, leave the Last Signon Date select the blank option from the drop-down list.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button.
The report results display a table listed by staff name. From left to right the report lists the staff person, their role, and their last logon date.

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To export your report, click the Export button (see page 233).

**Care Plan Incomplete Tasks**

Case managers routinely perform needs assessments for clients, evaluating what services they require. From these assessments, care plans are constructed outlining tasks necessary to meet the client’s needs (see page 167). Tasks are given target dates and assigned to staff persons. With a Care Plan Incomplete Tasks report, agency managers can track unfinished tasks.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Management menu item to get to the Management Reports screen. Click the “Care Plan Incomplete Tasks” link.

This takes you to the report filter screen where you can narrow the scope of your report. Use the Follow-Up filter to specify a range of dates for your report. For instance, you can report on unfinished tasks from the previous six months. From the drop-down list, select the type of filter you want to perform. You can search before or after a date, or between two dates.
You can also select “Is Null” or “Is Not Null” from the drop-down lists. Selecting “Is Null” will sort through all data that has no date entered. Use this option to report on all care plans that have not yet had a follow-up. Selecting “Is Not Null” will report on care plans that have had a follow-up at any time.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for follow-ups on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all entries before – but not including – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve records for follow-ups dated before midnight on June 22, 2005.

Select “After” to bring up all records dated after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all records for follow-ups from 12:00 AM on the first date to 11:59 PM on the second date. For example, entering 6/23/2005 in the first text field and 6/27/2005 in the second text field and clicking Search will display all records from June 23, 2005 through June 27, 2005.

Using the Staff Last Name filter, you can report on a specific staff person. Select “Equals” from the drop-down list and enter their last name in the first text field. For instance, selecting “Equals” and entering “Jones” in the first text field filters out the incomplete tasks assigned to any staff person whose last name is Jones.
To filter by a range of letters, select “Between” from the drop-down list and enter the alphabetical range you wish to report on. For instance, to search records from D through K, enter “D” and “L” in the two text fields. ARIES searches all entries from D up to, but not including, L.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button.

The report results display in a table listed by client name. From left to right, the table lists the client name, the staff person assigned to them, the client’s phone number, the staff person the task was assigned to, the task, and the follow-up date. Clicking on a staff person’s name takes you to their contact info screen.

If the client contact info lists “Do not phone,” the client does not want to be contacted by telephone. “No messages” means the client does not want any message left on voicemail or with other persons. “Be anonymous” means you can leave a phone message but do not mention the name of the agency with the message.

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.
To export your report, click the Export button (see page 233).

Unsigned Case Notes

Staff persons enter case notes for clients (see page 179), which can be helpful to track client progress and for other staff persons. To make them accessible to others, the case notes must be complete and signed. Case managers or agency managers can run Unsigned Case Notes reports to generate a list of unfinished case notes.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Management menu item to get to the Management Reports screen. Click the “Unsigned Case Notes” link.

This takes you to the report filter screen where you can narrow your report by staff name.

Next to Staff Last Name, you can filter by staff person by selecting “Equals” from the drop-down list and entering their last name in the first text field. For instance, selecting “Equals” and entering “Jones” in the first text field reports any unsigned case notes of any staff person whose last name is Jones.

To search a range of letters, select “Between” from the drop-down list and enter the alphabetical range you wish to report on. For instance, to search records from D through K, enter “D” and “L” in the two text fields. ARIES searches all entries from D up to, but not including, L.

To report on all staff persons, select the blank option from the drop-down list.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button.
The report results display in a table sorted by client name. From left to right, the table lists client name, the staff person working on the case notes, and the date the case notes were most recently edited. Clicking on the staff person’s name takes you to their contact info screen.

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To export your report, click the Export button (see page 233).

**Cross Tab Wizard**

The Cross Tab Wizard allows users with the proper permissions to generate reports that count service or client data and then compare them in a table. For instance, you can generate a cross tab report on secondary services by zip code. The report counts the number of services administered by your agency and separates them in a table by zip code. For reports on clients, only clients who receive services are included in your results.

You can also generate multiple tables to compare your data using a third variable. For instance, you could generate a count of secondary services by zip code and separate them into discrete tables for each month.

Once you generate your report, you can export your data for post-processing. You can also save the parameters of your report for future use.

Below are steps for creating cross tab reports:

- Cross Tab Reports Counting Distinct Clients
- Cross Tab Reports Counting Services
- Cross Tab Reports by Table

The Cross Tab Wizard screens include:

- Cross Tab Wizard Parameters
- Cross Tab Results
- Save Report
Cross Tab Reports Counting Clients Served

This type of cross tab report counts the number of distinct clients who received a service between a range of dates. For instance, if you wanted to compare the number of primary services to client gender, your report will count the number of clients who received primary services and separate them into columns by gender. Even if a client received multiple primary services within the time span you define, they are only counted once.

These reports are useful in analyzing the number of individuals who receive your agency’s services.

To access the Cross Tab Wizard, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Cross Tab Wizard menu.

From the “Data to Summarize” drop-down list select “Count Clients Served.”

If you want to specify a time span for your report, use the Service Start Date and End Date text fields. Enter the dates using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.
Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

Leaving these fields empty reports on all your agency’s clients who have ever received a service.

Use the Row drop-down list to select which data types you want displayed in the rows of your report. For instance, selecting “Gender” will display all of the clients’ gender types in the rows of your table. Selecting “Services – Secondary Category” will list all the secondary services provided by your agency.

Use the Column drop-down list to select which data types you want displayed in the columns of your report. For instance, selecting “Service Date – YYYY/MM” will display columns by month and will calculate the number of distinct clients served for that month.

Optionally use the Table drop-down to generate multiple tables for the data type you specify. See the Cross Tab Reports by Table help for more details (see page 284).

Select the “Display print format” checkbox to generate your report without the ARIES menu bar or buttons for printing purposes.

Click the Report button to access the Report Results screen.

**Cross Tab Reports Counting Clients Served Results**

The results of your report display in a table tabulating the clients who received services based on your filters. The row and column criteria for your report display above the table. Within the table, the row and column headings correspond to the data types specified in the wizard. For instance, if you chose “Service – Secondary Category” for your rows, each separate secondary service type provided by your agency would have a separate row. If you chose “Service Date yyyy/mm” for your columns, each column represents a month.
If there is no data for a given row or column, it will not display. For instance, if your agency does not provide residential services, ARIES will not display a row for any residential services. Or, if your agency didn’t provide services for the month of May, 2004, ARIES will not display a column for May, 2004.

The values in each cell represent the number of distinct clients who received services. For instance, if a client received 20 services in a given month, they would still only count once in a given month.

At the far right of the table is the number of unduplicated clients (UDC) who received services over the entire time span of your report. Therefore, the sum of the columns may not equal the total numbers. For instance, if clients receive services in multiple months, they still only count once in the UDC column. The bottom row of the table lists the number of unduplicated clients (UDCs) for each column.

Beneath the table is date and time the report was generated and the range of service dates.

To **export your report**, click the Export button (see page 233). To **save the parameters** of your query, click the Save button (see page 288).

**Cross Tab Reports Counting All Clients**

This type of cross tab report counts the number of distinct active clients who exist in your agency, regardless of whether they received services. The report is not dependent on services, so consequently the textboxes for entering the range of service dates are disabled when you select this option. For instance, if you wanted to know the number of clients who opted to share by gender, your report will count the number of clients who shared and those who did not share and separate them into columns by gender. Each client is counted only once.

These reports are useful in analyzing the number of client records at your agency without regards to actual services.

To access the Cross Tab Wizard, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Cross Tab Wizard menu.
From the “Data to Summarize” drop-down list select “Count All Clients.”

The date options are not available for this report.

Use the Row drop-down list to select which data types you want displayed in the rows of your report. For instance, selecting “Client – Shares Data” will display all the share status values for the system, which is Share or Not Shared.

Use the Column drop-down list to select which data types you want displayed in the columns of your report. For instance, selecting “Gender” will display columns for each of the gender types.

Optionally use the Table drop-down to generate multiple tables for the data type you specify. See the Cross Tab Reports by Table help for more details (see page 284).

Select the “Display print format” checkbox to generate your report without the ARIES menu bar or buttons for printing purposes.

Click the Report button to access the Report Results screen.

Cross Tab Reports Counting All Clients Results

The results of your report display in a table tabulating the active clients in the system for your agency. The row and column criteria for your report display above the table. Within the table, the row and column headings correspond to the data types specified in the wizard. For instance, if you chose “Service – Secondary Category” for your rows, each separate secondary service type provided by your agency would have a separate row. If you chose “Service Date yyyy/mm” for your columns, each column represents a month.
The values in each cell represent the number of distinct clients for two axes. For instance, for the sample report above, 21 Transgender MTF clients opted to shared their data with other ARIES agencies.

At the far right of the table is the number of unduplicated clients (UDC). The bottom row of the table lists the number of unduplicated clients (UDCs) for each column.

To export your report, click the Export button (see page 233). To save the parameters of your query, click the Save button (see page 288).

Cross Tab Reports Counting Service Records

This type of cross tab report counts the number of services provided by your agency based on your table criteria. For instance, if you wanted to compare the number of primary services to client gender, your report will count the number of primary services provided by your agency and separate them into columns by client gender.

These reports are useful in analyzing your agency’s service data.

To access the Cross Tab Wizard, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Cross Tab Wizard menu.
From the “Data to Summarize” drop-down list select “Count Service Records.”

If you want to specify a time span for your report, use the Service Start Date and End Date text fields. Enter the dates using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

Leaving these fields empty reports on all your agency’s service records.
Use the Row drop-down list to select which data types you want displayed in the rows of your report. For instance, selecting “Gender” will display all of the clients’ gender types in the rows of your table. Selecting “Services – Secondary Category” will list all the secondary services provided by your agency.

Use the Column drop-down list to select which data types you want displayed in the columns of your report. For instance, selecting “Residence – ZIP Code” will display all the zip codes of the clients serviced by your agency.

Use the Table drop-down to generate multiple tables for the data type you specify. See the Cross Tab Reports by Table help for more details (see page 282).

Select the “Display print format” checkbox to generate your report without the ARIES menu bar or buttons for printing purposes.

Click the Report button to access the Report Results screen.

**Cross Tab Reports Counting Service Records**

The results of your report display in a table. Above the table displays the row and column criteria for your report. Within the table, the row and column headings correspond to the data types specified in the wizard. For instance, if you chose “Service – Secondary Category” for your rows, each separate secondary service type provided by your agency would have a separate row. If you chose “Service Date yyyy/mm” for your columns, each column would represent a month.

If there is no data for a given row or column, it will not display. For instance, if your agency does not provide residential services, ARIES will not display a row for any residential services. Or, if your agency didn’t provide services for the month of May, 2004, ARIES will not display a column for May, 2004.

The values in each cell represent the number of services distributed. At the far right of the table is the total number of services distributed by your agency over the entire time span of your report for that row. The bottom row of the table displays the total number of services for each column.

Beneath the table is date and time the report was generated.

To export your report, click the Export button (see page 233). To save the parameters of your query, click the Save button (see page 288).
Cross Tab Reports Counting Service Units

This type of cross tab report sums the units of services provided by your agency based on your table criteria. For instance, if you wanted to compare the number of primary services to client gender, your report will count the number of units of services provided by your agency and separate them into columns by client gender.

These reports are useful in analyzing your agency’s service data.

To access the Cross Tab Wizard, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Cross Tab Wizard menu.

From the “Data to Summarize” drop-down list select “Count Service Units.”

If you want to specify a time span for your report, use the Service Start Date and End Date text fields. Enter the dates using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.
Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically. Leaving these fields empty reports on all your agency’s service records.

Use the Row drop-down list to select which data types you want displayed in the rows of your report. For instance, selecting “Gender” will display all of the clients’ gender types in the rows of your table. Selecting “Services – Secondary Category” will list all the secondary services provided by your agency.

Use the Column drop-down list to select which data types you want displayed in the columns of your report. For instance, selecting “Residence – ZIP Code” will display all the zip codes of the clients serviced by your agency.

Use the Table drop-down to generate multiple tables for the data type you specify. See the Cross Tab Reports by Table help for more details (see page 282).

Select the “Display print format” checkbox to generate your report without the ARIES menu bar or buttons for printing purposes.

Click the Report button to access the Report Results screen.

**Cross Tab Reports Counting Service Units**

The results of your report display in a table. Above the table displays the row and column criteria for your report. Within the table, the row and column headings correspond to the data types specified in the wizard. For instance, if you chose “Service – Secondary Category” for your rows, each separate secondary service type provided by your agency would have a separate row. If you chose “Service Date yyyy/mm” for your columns, each column would represent a month.
If there is no data for a given row or column, it will not display. For instance, if your agency does not provide residential services, ARIES will not display a row for any residential services. Or, if your agency didn’t provide services for the month of May, 2004, ARIES will not display a column for May, 2004.

The values in each cell represent the unit of services distributed. At the far right of the table is the total unit of services distributed by your agency over the entire time span of your report for that row. The bottom row of the table displays the total unit of services for each column.

Beneath the table is date and time the report was generated.

To export your report, click the Export button (see page 233). To save the parameters of your query, click the Save button (see page 288).

### Cross Tab Reports for Services by Table

This type of cross tab report counts the number of distinct clients or services provided by your agency and compares them based on three criteria. For instance, if you wanted to compare the number of primary services to client gender and then compare them by month, your report will generate separate tables for every month. Each table would count the number of primary services provided by your agency and separate them into columns by client gender.

To access the Cross Tab Wizard, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Cross Tab Wizard menu.
From the “Data to Summarize” drop-down list select “Count Services.”

If you want to specify a time span for your report, use the Service Start Date and End Date text fields. Enter the dates using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically. Leaving these fields empty reports on all your agency’s service records.
Use the Row drop-down list to select which data types you want displayed in the rows of your report. For instance, selecting “Gender” will display all of the clients’ gender types in the rows of your table. Selecting “Services – Secondary Category” will list all the secondary services provided by your agency.

Use the Column drop-down list to select which data types you want displayed in the columns of your report. For instance, selecting “Service – yyyy/mm” displays the month and year of the service date in the columns.

From the Table drop-down list, select the criterion for the different table values. ARIES will generate separate tables based on the criterion you select. For instance, selecting “Residence – ZIP Code” will display a table for each zip code serviced by your agency.

Select the “Display print format” checkbox to generate your report without the ARIES menu bar or buttons for printing purposes.

Click the Report button to access the Report Results screen.

**Cross Tab Reports by Table**

The results of your report display in a series of tables. The row and column criteria for your report display above each table, along with the table criterion defined in the cross tab wizard. For instance, if you chose “Residence – ZIP Code” for your table criterion, each table represents a different ZIP code of clients who are serviced by your agency.

Within each individual table, the row and column headings correspond to the data types specified in the wizard. For instance, if you chose “Service – Secondary Category” for your rows, each separate secondary service type provided by your agency would have a separate row. If you chose “Service Date yyyy/mm” for your columns, each column represents a month.

If there is no data for a given row or column, it will not display. For instance, if your agency does not provide residential services, ARIES will not display a row for any residential services. Or, if your agency didn’t provide services for the month of May, 2004, ARIES will not display a column for May, 2004.

The values in each cell represent the number of services provided. At the far right of the table is the total number of services delivered, for each row, over the entire time span of
your report. The bottom row displays the total number of services provided for each column.

Beneath the table is date and time the report was generated.

To export your report, click the Export button (see page 233). To save the parameters of your query, click the Save button (see page 288).

**Cross Tab Wizard**

In the Cross Tab Wizard screen, you define the parameters for your cross tab report. ARIES totals either the number of distinct clients or the number of services provided based on the criteria of your report. For instance, you could create a report that counts how many services your agency provided based on client CD4+ count and gender. You could also add a third parameter of ZIP code and ARIES would generate separate tables for every ZIP code serviced by your agency.

To access the Cross Tab Wizard, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Cross Tab Wizard menu.

![Crosstab Wizard](image)

From the “Data to Summarize” drop-down list select whether you want to count service records, service units, clients served or a count of all clients with or without service. If you choose clients served, ARIES will count the number of individual clients receiving services, so if a client receives 5 services within these dates, they will still only count as a single client.
If you want to specify a time span for your report, use the Service Start Date and End Date text fields. Enter the dates using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

Leaving these fields empty reports on all your agency’s service records.

Use the Row drop-down list to select which data types you want displayed in the rows of your report. For instance, selecting “Gender” will display all of the clients’ gender types in the rows of your table. Selecting “Services – Secondary Category” will list all the secondary services provided by your agency.

Use the Column drop-down list to select which data types you want displayed in the columns of your report. For instance, selecting “Service – yyyy/mm” displays the month and year of the service date in the columns.

From the Table drop-down list, you can third dimension to your report by generating multiple tables. Select how you want your tables sorted by. ARIES will generate separate tables based on the criterion you select. For instance, selecting “Residence – ZIP Code” will display separate tables for each zip code serviced by your agency.

Select the “Display print format” checkbox to generate your report without the ARIES menu bar or buttons for printing purposes.

Click the Report button to access the Cross Tab Results screen. Or click the Export button to export your results to a file.

**Cross Tab Results**

The results of your report display in a table or series of tables, depending on your report parameters. The row and column criteria for your report display above each table. If you included a table criterion in the cross tab wizard, the results are displayed in multiple tables.
The row and column headings of the table correspond to the data types specified in the wizard. For instance, if you chose “Service – Secondary Category” for your rows, each separate secondary service type in the date range would have a separate row. If you chose “Service Date yyyy/mm” for your columns, each column would represent a month.

If you included table parameters in your report, each separate table represents an entry. For instance, if you chose “Residence – ZIP Code” for your table criterion, each table represents a different ZIP code of clients who are serviced by your agency.

If there is no data for a given row or column, it will not display. For instance, if your agency does not provide residential services, ARIES will not display a row for any residential services. Or, if your agency didn’t provide services for the month of May, 2004, ARIES will not display a column for May, 2004.

The values in each cell represent the number of clients who received services, the number of clients, the number of services provided or the number of units of service, depending on the selection made in the wizard. At the far right of the table is the total number of services delivered or the number of unduplicated clients (UDC) who received services, for each row over the entire time span of your report.

If your report is on distinct clients served, the sum of the columns may not equal the UDC value. For instance, if clients receive services in multiple months, they still only count once in the UDC column.

The bottom row of a table displays either the total services or number of UDCs for each column, depending on your cross tab type.

Beneath the table is date and time the report was generated.

To export your report, click the Export button (see page 233). To save the parameters of your query, click the Save button (see page 288).
Save Report

The Save Report screen allows you to configure how your cross tab report can be accessed.

In the first text field, enter a name for your report. Use a name that informs other staff persons of the report’s function. If you are editing an existing report, entering a new name will change the name of the existing report, not create a new report.

In the Report Description text box, give a brief summary of what the function of your report is.

From the “Who can run this report?” section, specify which user or agency should be allowed to run the report. If you are not an administrative user, the system will automatically select “Myself Only,” which is the only selection you can make. If you are an administrator of your agency or other agencies, you can make the report viewable by all users within a specific agency, your entire administrative area or by an individual user. To permit the report to be viewed by anyone within an agency, select “An Agency” and choose the agency from the “Select Agency” drop-down. To permit the report to be viewed by anyone within your administrative area, select “An Admin Agency” and choose the name of the administrative agency in the “Select Admin Agency” drop-down. To permit the report to be viewed by an individual user, select “A user” and the user’s name from the “Select User” drop-down. If you want everyone to see the report, check “Everyone.” Checking this will permit only the users within your administrative jurisdiction the rights to view the report. If you administer only your agency, then only the users within your agency will see the report.

“Action when Report button is clicked” offers two choices: “Display report parameters page” takes users to the Cross Tab Wizard parameters screen (see page 229), so they can
refine their report. For instance, if an agency manager performs the report monthly, they will need to be able to enter in dates when they run the report.

If you select “Immediately display results using stored parameter values” users will not be able to define filters and they will go directly to the report results.

Selecting the “Display print format” radio button generates the report directly into a screen that has no menu bar. This is useful for reports that are printed directly from ARIES without any post-processing.

The “Report menu” drop-down list allows you to specify where your report can be accessed. There are report screens for Client, Services, Finances, Management, and Compliance. Select the screen that most accurately describes your report and gives the appropriate people access to it. For instance, if your report counts unduplicated clients, it would probably belong in the Client reports screen.

When you are finished, click the Save button which will take you to the report screen listing your saved report.

Your report lists with the name and description. To access it, click the report name link. If your report is accessible to others in your agency, it will list when they access that report menu. To remove it from view, click the corresponding Deactivate button.

**Services Reports**

<table>
<thead>
<tr>
<th>Mailing Labels</th>
<th>Displays client name, address, city, state, Zip, anonymous, and whether to send mail with filters on clientID, Program, Date of Service, Agency Status, and Gender</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Services by ZIP Code</td>
<td>Catalogs the number of secondary services provided and lists them by client zip code.</td>
</tr>
</tbody>
</table>

**Compliance Reports**

Programs that fund specialized services require compliance reports as part of the reimbursement process. ARIES helps automate the process with preconfigured reports. The reports allow you to control date parameters and then outputs the required compliance information in a table.

From the report results, you can use copy and paste ARIES data directly into your documents and reports edited with Microsoft Word (version 2000 or later).

Use your cursor to highlight the text you wish to copy. From the Internet Explorer Edit menu, select “Copy.” Bring up your Microsoft Word document and select “Paste” from the Edit menu.

The ARIES information displays, retaining its formatting and table structure. You can use Word’s document tools to format your data further.
The Compliance Reports include:

**CARE Act Data Report**

**Care Services Report**

**WICY**

**Ryan White Cross Titles Data Summary**

**HOPWA Reports**

- **HOPWA Progress Report**
- **HOPWA TDH Housing Assistance Program**

**MCWP Reports**

- **AIDS Medi-Cal Waiver Enrollment/Disenrollment Form**
- **Last Date of MCWP Services Compliance Report**
- **Last Date of MCWP Case Management Compliance Report**
- **Missing MCWP Required Data Compliance Report**
- **Number of MCWP Clients Served Compliance Report**

**EIP Reports**

- **Office of AIDS Summary Service Data Report for EIP**
- **Office of AIDS Summary Referral Data Report for EIP**
- **Contact History Report**
- **Active EIP Clients by PF Order**
- **Active EIP Clients with dates of most recent Major Assessment**
- **EIP Overall Summary**
- **EIP Compliance Report**
CMP Reports

**Last Date of CMP Services Compliance Report**

**Last Date of CMP Case Management Compliance Report**

**Missing CMP Required Data Compliance Report**

**Number of CMP Clients Served Compliance Report**

**CARE Act Data Report**

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “Care Act Data Report” link, which takes you to the report wizard.

The Ryan White Comprehensive AIDS Resources Emergency (CARE) Act provides funding to States, cities and public or private nonprofit entities to improve the quality and availability of care for low-income and medically underserved individuals and families affected by HIV/AIDS.

Grantees and providers funded by the CARE Act are required to submit a completed CADR on an annual basis. Using this wizard generates a report in compliance with the 2005 CADR guidelines. For more information about the Ryan White CARE Act, visit the HIV/AIDS Bureau at [http://hab.hrsa.gov](http://hab.hrsa.gov). For information about completing CADR, visit the support site at: [http://www.careactdatasupport.hrsa.gov/](http://www.careactdatasupport.hrsa.gov/).
The top part of the screen displays the navigation tabs for your agency. If you are accessing the CADR wizard from the Agency Detail screen (see page 219), you can use the tabs to navigate through the agency’s information screens.

<table>
<thead>
<tr>
<th>Grantee</th>
<th>Grantee ID or Grant #</th>
<th># of Providers</th>
<th># CADRs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title I</td>
<td>22-22222</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Title II</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title III</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title IV</td>
<td>33-33333</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Title IV Adolescent Initiative</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Total Number of Unduplicated CARE Act Providers: 1

Number of CADR Submitted: 2

Name of Grantee Rep Responsible for QA: Mary Jones

Grantee Contact Email Address: MJones@parkland.org

EMA or Grant Number: 55555
In the EMA Information section, enter the grantee name for the CADR and the taxpayer ID. Use the checkboxes to select the CARE Act titles under which your agency provides services or contracts.

In the grantee table, list the corresponding grantee ID for each CARE Act title and indicate the number of providers and CADRs.

Under “Total Number of Unduplicated CARE Act Providers” enter the number of unduplicated CARE Act providers. For instance, if your agency receives multiple grants from a single provider, they are counted once.

In the next text field, enter the number of CADRs submitted.

Next, enter the name of the grantee representative responsible for quality assurance.

Next enter the grantee’s eligible metropolitan area (EMA) or grant number.

In Section 1 of the wizard, enter the address and city of the provider. Use the drop-down list to select the state. Enter the provider’s five-digit zip code in the next text field.
Next to “Calendar year for reporting,” enter the start and end dates of the reporting year using the format: MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

<table>
<thead>
<tr>
<th>Sun</th>
<th>Mon</th>
<th>Tue</th>
<th>Wed</th>
<th>Thu</th>
<th>Fri</th>
<th>Sat</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>29</td>
<td>30</td>
<td>31</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
</tr>
<tr>
<td>12</td>
<td>13</td>
<td>14</td>
<td>15</td>
<td>16</td>
<td>17</td>
<td>18</td>
</tr>
<tr>
<td>19</td>
<td>20</td>
<td>21</td>
<td>22</td>
<td>23</td>
<td>24</td>
<td>25</td>
</tr>
<tr>
<td>26</td>
<td>27</td>
<td>28</td>
<td></td>
<td>29</td>
<td>30</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
</tr>
</tbody>
</table>

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

Next to Reporting Scope, use the drop-down list to select the scope of the CADR.

Use the next drop-down list to select your agency’s provider type.

Use the next drop-down list to indicate whether or not your agency received funding from Section 330 of the Public Health Service Act.

In the next drop-down list, select the ownership status of your agency. If your agency is a private non-profit, use the next drop-down list to indicate whether or not your agency is faith-based.

Use the next drop-down list to indicate whether or not your agency received any Minority AIDS Initiative (MAI) funding during the reporting period.
Under “Source of Ryan White CARE Funding,” use the check boxes to indicate under which titles funding is granted. Under each checked title, use the text fields to list the grantee(s).
In the funding section, use the corresponding text field to enter the total amount of funding granted under each title. Also, enter any MAI funding granted, if any, in the adjacent text fields.

In the “Amount of Titles I-IV…” text field, enter the total amount expended on oral health care under all titles.

Next, use the checkboxes to indicate the support provided to grantees.

Use the next drop-down to indicate the AIDS Drug Assistance Program (ADAP) administered by your agency. If your agency does not provide one, indicate so by selecting “Agency does not administer ADAP”.

Use the next drop-down to indicate the Health Insurance Program (HIP) administered by your agency. If your agency does not provide one, indicate so by selecting “Agency does not administer HIP”.

**PLEASE NOTE:**
- The Funding Total for Title I is set to 20000.
- The Funding Total for Title II is set to 0.
- The Funding Total for Title III is set to 0.
- The Funding Total for Title IV is set to 30000.
- The Amount of Titles I-IV expended on oral health care is set to 0.
- The Total Minority AIDS Initiative is set to 0.

**During the reporting period, did you provide the grantee with support in ...? (Check all that apply.)**

- Planning or Evaluation
- Administrative or technical support
- Fiscal intermediary services
- Technical assistance
- Capacity development
- Quality management
- You provided only the services above under CARE Act funding.

**AIDS Drug Assistance Program (ADAP)**

- State ADAP

**This agency provides a Health Insurance Program (HIP)**

- Agency does not administer HIP
Under “Target populations for outreach,” use the checkboxes to select the groups targeted by your agency. If your agency targets groups not listed, check the “Other” box and specify the target population in the text field.

Under “Target populations for outreach,” use the checkboxes to select the groups targeted by your agency. If your agency targets groups not listed, check the “Other” box and specify the target population in the text field.

Use the checkboxes to answer the question, “Which of the following categories describe your agency?”

In the text field next to “Total paid staff,” enter the number of staff in full-time employees (FTEs) funded by the CARE Act.

In the text field next to “Total volunteer staff,” enter the number of volunteer staff, in FTEs, dedicated to HIV care.
In Section 4, use the drop-down lists to answer the questions regarding your agency’s HIV testing and counseling services.

In Section 5 use the drop-down list to answer the question regarding your agency’s quality management program.

Next to the first question in Section 6, use the drop-down list to indicate whether or not Early Intervention Services (EIS) were provided during the reporting period.

If yes, enter the number of sites EIS services were provided at in the next text field.
Next, use the corresponding drop-down lists to select the primary services availed to HIV+ clients.

In the last text field, indicate the number of unduplicated HIV+ clients referred from outside the EIS program for health services not available within the EIS program. For instance, if a client receives multiple services, they are only counted once.

When you have finished entering information in the form, click the Report button to generate the completed CADR. If you want to display your results without the ARIES menu bar (for printing purposes), select the “Display print format” checkbox.

To export your results for further post-processing, click the Export button.
The published report displays the completed CADR based on the information you entered in the wizard. The report may require you to enter additional information, so check the form to make sure it is completely filled out.

To copy this report into a word processor for formatting and printing, choose Edit → Select All from the Internet Explorer menu and then choose Edit → Copy. Then, from within your word processor, choose Edit → Paste. Here, you can edit, format, and print your report.

Care Services Report

The Care Services Report is used to give an overall view of your agency’s contracts and expenditures. The report compares expenditures to amounts budgeted and also breaks down service costs by women, infants, children, and youth.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “Care Services Report” link, which takes you to the report’s filters screen.
From the Date of Service drop-down list, select the type of filter you want to perform. You can search before or after a date, or between two dates.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for records on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all services before – but not on – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve service records before midnight on June 22, 2005.

Select “After” to bring up all services after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all services occurred from 12:00 AM on the first date to 11:59 PM on the second date.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button. You can also click the Export button to export your report, but it is recommended that you first proof the report results before exporting them.
The report displays two tables underneath a heading that lists the reporting period, the agency name, the total grant money of the agency, and the agency’s contract number.

The first table displays your agency’s contracts. The columns list as follows: the name of the contract, the total grant amount of the contract, the amount expended to date, the available balance on the contract, the percentage of the contract expended, and the number of unduplicated clients served by the contract. In the Balance column, if the amount expended exceeds the amount of the contract, the exceeded amount displays in parentheses. Unduplicated clients served refers to the number of individual clients receiving services. A client who received multiple services under a contract is counted only once.

The bottom row of the table displays the totals of each column. For Unduplicated Served, the number reflects the total number of individual clients for all contracts. A client who receives services under multiple contracts is counted only once so the total number may not equal the sum of the rows.
The second table displays contract expenditures for clients who are: women (25 years of age and older), infants (0-1 years of age), children (1-12 years of age), and youth (13-24 years of age).

The columns, from left to right, list as follows: the name of the contract, the amount of the contract grant, the service expenditures under the contract for women, and the balance of the contract relative to women’s service expenditures. The value does not account for service expenditures for other clients. The last four columns list the service expenditures under the contract for infants, children, youth, and the total of all three client types. The last line of the table lists the total expenditures for all the contracts combined.

To export your report, click the Export button (see page 233).

**WICY**

The WICY report generates service data on your agency’s women, infants, children, and youth, and displays the unduplicated client totals by gender and ethnicity.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “WICY” link, which takes you to the report’s filters screen.
From the Date of Service drop-down list, select the type of filter you want to perform. You can search before or after a date, or between two dates. The report will generate results for clients who have received services during that period. If a client registered with your agency has not received services, they are not counted.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for records on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all services before – but not on – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve service records before midnight on June 22, 2005.

Select “After” to bring up all services after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will
display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all services that occurred from 12:00 AM on the first date to 11:59 PM on the second date.

The Limit Program to Ryan White drop down allows you to limit the results of the report to services assigned to the program “Ryan White.” Select Yes to do this.

The Limit Funding Source to Ryan White drop down allows you to limit the results of the report to services whose contract has Ryan White Titles I-IV as the funding source. Select Yes to accomplish this.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button.

The report results display in four tables; one each for infants (0-1 years of age), children (1-12 years of age), youth (13-24 years of age), and women (25 years of age and older).

Each table displays rows based on primary service category. The rows only display if a client received services from that primary service category, so if no infant clients received mental health services, that row will not display.

The first column of each table lists the service category. The subsequent columns count the number of clients who received that category of service. From left to right, they
include: male, female, unknown gender, white, black, Hispanic, Asian, American Indian or Native Alaskan, Pacific Islander, those of mixed race (more than one), clients whose race is unknown, and the total number of clients who received that service type. If a client received multiple services within a category, they are still only counted once.

The last column lists the total expenditure for that service type.

The last row of each table lists the total number of unduplicated clients for each gender and ethnicity. As clients receive services from multiple categories and are only counted once, the sum of the rows may not equal the total listed.

<table>
<thead>
<tr>
<th>Service Primary Category</th>
<th>Male/Female</th>
<th>Unknown Gender</th>
<th>White (not Hispanic)</th>
<th>Black or African American (not Hispanic)</th>
<th>Hispanic or Latino (s)</th>
<th>Asian</th>
<th>Native Hawaiian or Other Pacific Islander</th>
<th>American Indian or Alaskan Native</th>
<th>More than one race</th>
<th>Unknown/Unreported</th>
<th>Total Number Clients</th>
<th>Total Expenditure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambulatory/Outpatient Medical Care</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>9</td>
<td>5,392.00</td>
</tr>
<tr>
<td>Developmental Assessment/Early Intervention Services</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>282.00</td>
</tr>
<tr>
<td>Early Intervention Services for Titles I and II</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>160.00</td>
</tr>
<tr>
<td>Home Health: Para-Professional Care</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>794.00</td>
</tr>
<tr>
<td>Other Services</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>319.00</td>
</tr>
<tr>
<td>Psychosocial Support Services</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>425.00</td>
</tr>
<tr>
<td>Substance Abuse Services Outpatient</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>54.00</td>
</tr>
<tr>
<td>Total</td>
<td>0</td>
<td>14</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>14</td>
<td>7,810.00</td>
</tr>
</tbody>
</table>

Total WICY Expenditure: $49,435.00

Generated 5/26/2005 4:28:49 PM
Criteria: Services between '1/1/2005' and '1/31/2005'

Underneath the last table lists the total service expenditures for all women, infants, children, and youth for that time period. Beneath that, is the date and time the report was generated along with the filter parameters.

To include these tables in a report document, click and drag your mouse to highlight the tables and select Edit → Copy from the Internet Explorer menu. Then, from within your report document, select Edit → Paste from the menu to insert your table. In applications like Microsoft Word and Excel, the table formatting is preserved.

**Ryan White Cross Titles Data Summary**

The Ryan White Cross Titles Data Summary displays counts of your agency’s clients based on a variety of demographic information.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “Ryan White Cross Titles Data Summary” link, which takes you to the report’s filters screen.
In the Service Date Between text fields, enter the range of dates you wish to report on. Enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include results for clients who received services that occurred from 12:00 AM on the first date to 11:59 PM on the second date. If a client registered with your agency has not received services, they are not counted.

Use the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

In the Agency or Administrative Agency drop-down, select which agency you wish to report on. Administrative agencies can report on any of their subagencies. If you are not an administrative agency, only your agency will display.

If you wish to report only on a specific funding source, make the appropriate selection in the Funding Source dropdown.
Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window. Click the Report button to access the Data Summary.

### Cross Titles Data Summary

**Agency**

**Reporting Period:** 1/1/2004 to 4/30/2004

<table>
<thead>
<tr>
<th>Unduplicated number of clients served:</th>
<th>1617</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of new clients served:</td>
<td>1617 100.00 %</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Age</th>
<th>Number</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Under 2</td>
<td>0</td>
<td>0.00 %</td>
</tr>
<tr>
<td>2-12</td>
<td>0</td>
<td>0.00 %</td>
</tr>
<tr>
<td>13-24</td>
<td>83</td>
<td>5.13 %</td>
</tr>
<tr>
<td>25-44</td>
<td>1092</td>
<td>67.53 %</td>
</tr>
<tr>
<td>45-64</td>
<td>424</td>
<td>26.22 %</td>
</tr>
<tr>
<td>Over 64</td>
<td>18</td>
<td>1.11 %</td>
</tr>
<tr>
<td>Unknown</td>
<td>0</td>
<td>0.00 %</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Gender</th>
<th>Number</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Male</td>
<td>1201</td>
<td>74.27 %</td>
</tr>
<tr>
<td>Female</td>
<td>405</td>
<td>25.05 %</td>
</tr>
<tr>
<td>Other</td>
<td>0</td>
<td>0.00 %</td>
</tr>
</tbody>
</table>

In this screen, your report results include the name of the agency and the reporting dates at the top of the screen. The first line of the table underneath lists the total number of unduplicated clients who received services at your agency. If a client received multiple services, they are counted only once. The second line lists the total number of new clients who registered at your agency during the time period specified.

The table then displays the breakdown of client numbers based on the following criteria:

<table>
<thead>
<tr>
<th>Age</th>
<th>The age of the client.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gender</td>
<td>The gender of the client.</td>
</tr>
<tr>
<td>Ethnicity</td>
<td>The ethnicity of the client.</td>
</tr>
<tr>
<td>Below 300% Federal Poverty Level</td>
<td>The number of clients living below 300% of the federal poverty level.</td>
</tr>
<tr>
<td>Private Insurance Status</td>
<td>The number who have private health insurance.</td>
</tr>
<tr>
<td>Medicaid Insurance Status</td>
<td>The number of clients receiving Medicaid insurance.</td>
</tr>
<tr>
<td>Other Public Insurance Status</td>
<td>The number of clients receiving public insurance from a source other than Medicaid.</td>
</tr>
</tbody>
</table>
To include this table in a report document, click and drag your mouse to highlight the table and select Edit → Copy from the Internet Explorer menu. Then, from within your report document, select Edit → Paste from the menu to insert your table. In applications like Microsoft Word and Excel, the table formatting is preserved.

**HOPWA Progress Report**

This report generates the HOPWA-required progress report pre-filled with your agency’s HOPWA information. You can print the form directly out of ARIES or you can export it into a word processing program for further revisions.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “HOPWA Progress Report” link, which takes you to the report’s filters screen.

From the Reporting Period box, select which time span you wish to report on. To report on an entire year, select “All.”

From the Year drop-down list, make sure “=” is selected from the drop-down list. Enter the year you wish to report on in the first text field.

Click the Report button, which takes you to the progress report form.
The report displays with all the relevant HOPWA data from ARIES pre-filled based on your filters. You can print this report directly from the browser by selecting File → Print from the Internet Explorer menu. The report may require you to enter additional information after printing, so check the form to make sure it is completely filled out.

To insert this report into a word processor for post-processing, choose Edit → Select All from the Internet Explorer menu and then choose Edit → Copy. Then, from within your word processor, choose Edit → Paste. Here, you can edit and format your report further.

When you are finished, click the link at the bottom of the screen to return to the Compliance Reports screen.

**HOPWA TDH Housing Assistance Program**

The HOPWA TDH Housing Assistance Program report generates the data for the Texas Department of Health HOPWA (Housing for Persons With AIDS) project report and incorporates it into report form.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “HOPWA TDH Housing Assistance Program” link, which takes you to the report’s filters screen.
Project reports are submitted semi-annually based on a fiscal year that starts February 1. From the Reporting Period box, select which portion of the year you wish to report on. Select “All” to report on the entire year.

From the Year drop-down list, make sure “=” is selected from the drop-down list. Enter the year you wish to report on in the first text field.

Click the Report button, which takes you to the project report form.

The report displays with all the relevant HOPWA data from ARIES pre-filled based on your filters. You can print this report directly from the browser by selecting File → Print from the Internet Explorer menu. The report may require you to enter additional information after printing, so check the form to make sure it is completely filled out.

To insert this report into a word processor for post-processing, choose Edit → Select All from the Internet Explorer menu and then choose Edit → Copy. Then, from within your word processor, choose Edit → Paste. Here, you can edit and format your report further.

When you are finished, click the link at the bottom of the screen to return to the Compliance Reports screen.
AIDS Medi-Cal Waiver Enrollment/Disenrollment Form

The AIDS Medi-Cal Waiver Enrollment/Disenrollment Form generates an MCWP enrollment form that may be printed and completed for program enrollment.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “AIDS Medi-Cal Waiver Enrollment/Disenrollment Form” link.

Last Date of MCWP Services Compliance Report

The Last Date of MCWP Services Compliance report generates a table of all the clients at your agency enrolled in MCWP (Medi-Cal Waiver Program). The report also lists services funded by MCWP and then lists the most recent date a client received that service.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “Last Date of MCWP Services Compliance Report” link, which takes you to the report’s filters screen.

From the Date of Service drop-down list, select the type of filter you want to perform. You can search before or after a date, or between two dates.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.
Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for records on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all services before – but not on – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve service records before midnight on June 22, 2005.

Select “After” to bring up all services after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all services that occurred from 12:00 AM on the first date to 11:59 PM on the second date.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button. You can also click the Export button to export your report, but it is recommended that you first proof the report results before exporting them.
The report results display in a table where each row represents an MCWP-enrolled client. The columns display from left to right the MCWP Waiver ID number, the client’s URN, their name, and then the dates they last received MCWP funded services. These services include: psychosocial counseling, attendant care, homemaker services, skilled nursing, durable medical equipment, food assistance, nutritional counseling, transportation assistance, and foster care. If a cell is empty, the client did not receive that service during the time period specified.

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To export your report, click the Export button (see page 233).

**Last Date of MCWP Case Management Compliance Report**

The Last Date of MCWP Case Management Compliance report generates a table of all the clients at your agency enrolled in MCWP (Medi-Cal Waiver Program). The report also lists the most recent dates when the client received case management services.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “Last Date of MCWP Case Management Compliance Report” link, which takes you to the report’s filters screen.

From the Date of Service drop-down list, select the type of filter you want to perform. You can search before or after a date, or between two dates.
Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

<table>
<thead>
<tr>
<th>Sun</th>
<th>Mon</th>
<th>Tue</th>
<th>Wed</th>
<th>Thu</th>
<th>Fri</th>
<th>Sat</th>
</tr>
</thead>
<tbody>
<tr>
<td>29</td>
<td>30</td>
<td>31</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
</tr>
<tr>
<td>12</td>
<td>13</td>
<td>14</td>
<td>15</td>
<td>16</td>
<td>17</td>
<td>18</td>
</tr>
<tr>
<td>19</td>
<td>20</td>
<td>21</td>
<td>22</td>
<td>23</td>
<td>24</td>
<td>25</td>
</tr>
<tr>
<td>26</td>
<td>27</td>
<td>28</td>
<td>29</td>
<td>30</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
</tr>
</tbody>
</table>

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for records on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all services before – but not on – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve service records before midnight on June 22, 2005.

Select “After” to bring up all services after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all services that occurred from 12:00 AM on the first date to 11:59 PM on the second date.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button. You can also click the Export button to export your report, but it is recommended that you first proof the report results before exporting them.
The report results display in a table where each row represents an MCWP-enrolled client. The columns display from left to right the MCWP Waiver ID number, the client’s URN, their name, and then the dates they last received face-to-face and non face-to-face case management services. If a cell is empty, the client did not receive case management services during the time period specified.

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To **export your report**, click the Export button (see page 233).

### Missing MCWP Required Data Compliance Report

The Missing MCWP Required Data Compliance Report displays your agency’s clients enrolled in MCWP (Medi-Cal Waiver Program) and lists any missing documentation or information necessary for MCWP compliance.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “Missing MCWP Required Data Compliance Report” link, which takes you to the report’s filters screen.

**Missing MCWP Required Data Compliance Report**

```
Date of Service  Between  1/1/2004 & 11/17/2004
Display  200 results
```

From the Date of Service drop-down list, make sure “After” is selected. Enter the date you wish to report on in the first text field. The report will include all clients enrolled in CMP after that date. Use the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.
The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button. You can also click the Export button to export your report, but it is recommended that you first proof the report results before exporting them.

The results screen displays the dates of your report at the top of the screen. Underneath, the number of MCWP clients enrolled during that period displays.

The report table rows correspond to clients. The columns display from left to right: the client’s MCWP waiver ID number, their URN, their name, any missing demographic data, their enrollment date, any missing service data, and their last assessment date.

If a client’s missing demographic data and service data cells are blank, their records are up to date.

To export your report, click the Export button (see page 233).
Number of MCWP Clients Served Compliance Report

The Number of MCWP Clients Served Compliance report totals the number of clients enrolled in MCWP (Medi-Cal Waiver Program) who receive services at your agency per month. It does not tally the total number of services, but the clients who received them. So a client who receives multiple services in a single month is counted once.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “Number of MCWP Clients Served Compliance Report” link, which takes you to the report’s filters screen.

From the Date of Service drop-down list, select the type of filter you want to perform. You can search before or after a date, or between two dates.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for records on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.
Select “Before” to sort through all services before – but not on – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve service records before midnight on June 22, 2005.

Select “After” to bring up all services after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all services that occurred from 12:00 AM on the first date to 11:59 PM on the second date.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button. You can also click the Export button to export your report, but it is recommended that you first proof the report results before exporting them.

The report results display in a table where the first column lists the month and the second column lists the total number of unduplicated MCWP-enrolled clients who received services. The report tallies the total number of clients in a given month who receive services; even if a client receives multiple services, they are only counted once.

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To export your report, click the Export button (see page 233).

Office of AIDS Summary Service Data Report for EIP

The Contact Office of AIDS Summary Service Data Report for EIP displays by year the number of EIP related services administered by your agency.
To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “Office of AIDS Summary Service Data Report for EIP” link, which takes you to the report’s filters screen.

![Office of AIDS Summary Service Data Report for EIP](image)

From the Year drop-down list, make sure that “=” is selected. Enter the year you wish to report on in the first text field. Ignore the second text field.

Ignore the Display text field. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button. You can also click the Export button to export your report, but it is recommended that you first proof the report results before exporting them.

![EIP Site: Parkland Health and Hospital System - AIDS Clinic Office of AIDS Summary for 1/1/2004 thru 12/31/2004 Service Data](image)

The report displays a table of the EIP service data for the year specified in the previous screen where each row represents a month. If a month does not display, no EIP services
were administered in that month. The top of the screen lists the agency name and the year of the report.

The table displays columns for each category of EIP service: medical, psychosocial, health education, transmission risk reduction, case management, and financial eligibility and other. The number of services administered by your agency in that month displays underneath each service type. To the right, the percentage value of that service type relative to all EIP services displays. So if 20 EIP services were administered and 4 of them were medical, the percentage value would be 20%.

The Monthly Total column lists the sum of all EIP services for that month. The percentage value to the right represents the percentage value of that month relative to services for the entire year.

The bottom row of the table totals the service numbers of each type for the entire year.

To **export your report**, click the Export button (see page 233).

**Office of AIDS Summary Referral Data Report for EIP**

The Contact Office of AIDS Summary Referral Data Report for EIP displays by year the number of EIP referrals made by your agency.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “Office of AIDS Summary Referral Data Report for EIP” link, which takes you to the report’s filters screen.

![Office of AIDS Summary Referral Data Report for EIP](image)

From the Year drop-down list, make sure that “=” is selected. Enter the year you wish to report on in the first text field. Ignore the second text field.

Ignore the Display text field. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button. You can also click the Export button to export your report, but it is recommended that you first proof the report results before exporting them.
The report displays a table of the EIP referral data for the year specified in the previous screen where each row represents a month. If a month does not display, no EIP referrals were made in that month. The top of the screen lists the agency name and the year of the report.

The table displays columns for each category of EIP referral: medical, mental health, basic living, dental, recovery programs, health enhancements, benefits and health insurance, partner notification & PCRS (Partner Counseling & Referral Services), and other. The number of referrals administered by your agency in that month displays underneath each referrals type. To the right, the percentage value of that referral type relative to all EIP referrals displays. So if 20 EIP referrals were made and 4 of them were medical, the percentage value would be 20%.

The Monthly Total column lists the sum of all EIP referrals for that month. The percentage value to the right represents the percentage value of that month relative to referrals for the entire year.

The bottom row of the table totals the referral numbers of each type for the entire year.

To export your report, click the Export button (see page 233).

**Contact History Report**

The Contact History Report allows you to generate a report on individual EIP (Early Intervention Program) clients. The report details every visit the client made and whether services were administered and referrals were made.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “Contact History Report” link, which takes you to the report’s filters screen.
From the Date of Service drop-down list, select the type of filter you want to perform. You can search before or after a date, or between two dates.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for records on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all services before – but not on – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve service records before midnight on June 22, 2005.

Select “After” to bring up all services after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your
report results will include all services that occurred from 12:00 AM on the first date to 11:59 PM on the second date.

Next to EIP Client ID, select “Equals” from the drop-down list and enter the client’s EIP client ID in the first text field.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button. You can also click the Export button to export your report, but it is recommended that you first proof the report results before exporting them.

The report generates a table with the client’s EIP ID number and name at the top. Beneath that, the time span of the report lists.

The table displays every contact the client with your agency during the time period along with the details of the contact. Each entry includes which services were administered, which referrals were made, the location of the contact, and which agency the client met with.
The bottom of the screen displays how many contacts made during the time period along with the total number of services and referrals the client received.

To export your report, click the Export button (see page 233).

Active EIP Clients by Program ID Order

With the Active EIP Clients by Program ID Order report, you can access clients enrolled in EIP (Early Intervention Program) and view their most recent service activity displayed in order of their EIP program ID number (Program ID #).

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “Active EIP Clients by PF Order” link, which takes you to the report’s filters screen.

From the Date of Service drop-down list, select the type of filter you want to perform. You can search as of a given date.
Enter the date you wish to filter by in the text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

![June 2005 Calendar](image)

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button. You can also click the Export button to export your report, but it is recommended that you first proof the report results before exporting them.
The report results display in a table listing in columns from left to right: Program ID #, client name, date they enrolled in EIP, their EIP status including “as of” date, and the date of their most recent service.

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To export your report, click the Export button (see page 233).

Active EIP Clients with dates of most recent Major Assessment

The Active EIP Clients report displays a list of active EIP (Early Intervention Program) clients along with the dates of their most recent assessments. EIP participants must be assessed at regular intervals; this report flags any overdue assessments.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “Active EIP Clients with dates of most recent Major Assessment” link, which takes you to the report’s filters screen.
From the Status drop-down list, select “As Of.” Enter the date you want to report on. The report will include all the active EIP clients as of that date and their assessment status as of that date. If the client received assessments after that date, they will not be included in the report. Use the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button. You can also click the Export button to export your report, but it is recommended that you first proof the report results before exporting them.

A table of your results display with the name of your agency at the top of the screen.
From left to right, the columns of the table display the clients EIP ID, their name, their program status, and then the dates of their most recent EIP assessments. The assessments include medical, psychosocial, health education, HIV transmission, and case management. If a date is missing, the client has not yet received that assessment. If the entry is surrounded by “>><<”, the assessment is overdue. So if an entry under “Case Mgmt” displays “>6/2/2004<<” it means the client received a case management assessment on June 2, 2004, but is overdue for another assessment.

To export your report, click the Export button (see page 233).

EIP Overall Summary

The EIP Overall Summary report displays your agency’s EIP service and client information in a series of tables. You can then export your data for use in EIP reports or print it directly from the ARIES screen.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “EIP Overall Summary” link, which takes you to the report’s filters screen.

From the Date of Service drop-down list, select the type of filter you want to perform. You can search before or after a date, or between two dates.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.
Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for records on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all services before – but not on – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve service records before midnight on June 22, 2005.

Select “After” to bring up all services after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all services that occurred from 12:00 AM on the first date to 11:59 PM on the second date.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button. You can also click the Export button to export your report, but it is recommended that you first proof the report results before exporting them.
The report displays a series of tables with the name of the agency and the time span of the report at the top of the screen. The tables listed include:

<table>
<thead>
<tr>
<th>Status at Start of Reporting Period</th>
<th>Clients</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>3</td>
</tr>
<tr>
<td>Disenrolled</td>
<td>1</td>
</tr>
<tr>
<td>Medically Reactivated</td>
<td>3</td>
</tr>
<tr>
<td>Transitioned</td>
<td>1</td>
</tr>
<tr>
<td>Total</td>
<td>8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status Change</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>1</td>
</tr>
<tr>
<td>Disenrolled</td>
<td>0</td>
</tr>
</tbody>
</table>

- **Status at Start of Reporting Period** lists the status of all EIP-enrolled clients at the first date of the time span specified in the previous screen.
- **Status Change** displays any changes in EIP status of clients during the reporting period.
- **Status at End of Reporting Period** lists the status of all EIP-enrolled clients at the end date of the time span specified in the previous screen.
- **Unique Clients Served** displays the number of distinct clients who received EIP services during the reporting period. If a client received multiple services, they are still only counted once.
- **Gender** displays the gender breakdown of EIP clients by number and percentage.
- **Age** displays the age breakdown of EIP clients by number and percentage.
- **HIV/AIDS** displays the HIV status of EIP clients as well as the number of clients diagnosed with AIDS.
Services | Displays the type of EIP services administered during the time period as well as the number of contacts for each service type and the number of unique clients served. The last row displays the total number of contacts and unique clients served. If a client receives multiple EIP services, they are still only counted once so the unique clients total may not equal the sum of the rows.

| Referrals | Displays the type of EIP referrals administered during the time period as well as the number of contacts for each referral type and the number of unique clients referred. The last row displays the total number of contacts and unique clients referred. If a client receives multiple referrals, they are still only counted once so the unique clients total may not equal the sum of the rows.

| Financial Assistance | 1 | 1 |
| Food/Meals Assistance | 2 | 1 |
| Hospice Services | 2 | 1 |
| Legal Assistance | 2 | 2 |
| Mental Health Services (not HIV related) | 1 | 1 |
| Needle Exchange Program | 2 | 2 |
| Psychosocial Support Group (HIV related) | 1 | 1 |
| Total for All Referrals | 25 | 7 |

To **export your report**, click the Export button (see page 233). Click the link at the bottom of the screen to return to the Compliance Reports screen.

**EIP Compliance Report**

The EIP Compliance Report displays your agency’s EIP clients, the dates of their EIP assessments, and a list of any missing information. This report is helpful in ensuring full EIP compliance.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “EIP Compliance Report” link, which takes you to the report’s filters screen.
From the Status drop-down list, select “As Of” and enter the date you want to report on. The report will display EIP clients’ status as of that date. If they have received assessments after that date, they will not be listed in the report. Enter the date using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button. You can also click the Export button to export your report, but it is recommended that you first proof the report results before exporting them.
The report displays in rows, each EIP client. The columns list the client’s EIP ID number and their name. Then, the columns display from left to right the dates of their most recent EIP assessments for: medical, psychosocial, health education, HIV transmission, and case management. If a cell is empty, the client has not received that assessment.

The Major Asmt column indicates whether the client is current or overdue on their assessments. The Last Contact column indicates the agency’s most recent contact with the client. The Missing EIP Date displays any critical EIP information missing from the client’s records.

To export your report, click the Export button (see page 233). Click the link at the bottom of the screen to return to the Compliance Reports screen.

**Last Date of CMP Services Compliance Report**

The Last Date of CMP Services Compliance report generates a table of all the clients at your agency enrolled in CMP (Case Management Program). The report also lists services funded by CMP and then lists the most recent date a client received that service.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “Last Date of CMP Services Compliance Report” link, which takes you to the report’s filters screen.
From the Date of Service drop-down list, select the type of filter you want to perform. You can search before or after a date, or between two dates.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for records on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all services before – but not on – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve service records before midnight on June 22, 2005.

Select “After” to bring up all services after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter the beginning date in the first text field and the ending date in the second text field. Your
report results will include all services that occurred from 12:00 AM on the first date to 11:59 PM on the second date.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button. You can also click the Export button to export your report, but it is recommended that you first proof the report results before exporting them.

The report results display in a table where each row represents a CMP-enrolled client. The columns display from left to right the CMP Case number, the client’s URN, their name, and then the dates they last received CMP funded services. These services include: mental health counseling, attendant care, homemaker services, skilled nursing, durable medical equipment, food assistance, transportation assistance, and emergency financial assistance. If a cell is empty, the client did not receive that service during the time period specified.

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To **export your report**, click the Export button (see page 233).

**Last Date of CMP Services Compliance Report**

The Last Date of CMP Case Management Compliance report generates a table of all the clients at your agency enrolled in CMP (Case Management Program). The report also lists the most recent dates when the client received case management services.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “Last Date of CMP Case Management Compliance Report” link, which takes you to the report’s filters screen.
From the Date of Service drop-down list, select the type of filter you want to perform. You can search before or after a date, or between two dates.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

To filter for records on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all services before – but not on – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve service records before midnight on June 22, 2005.

Select “After” to bring up all services after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all services that occurred from 12:00 AM on the first date to 11:59 PM on the second date.
The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button. You can also click the Export button to export your report, but it is recommended that you first proof the report results before exporting them.

The report results display in a table where each row represents a CMP-enrolled client. The columns display from left to right the CMP Case number, the client’s URN, their name, and then the dates they last received face-to-face and non-face-to-face case management services. If a cell is empty, the client did not receive case management services during the time period specified.

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

The Missing CMP Required Data Compliance Report displays your agency’s clients enrolled in CMP (Case Management Program) and lists any missing documentation or information necessary for CMP compliance.
To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “Missing CMP Required Data Compliance Report” link, which takes you to the report’s filters screen.

From the Date of Service drop-down list, make sure “After” is selected. Enter the date you wish to report on in the first text field. The report will include all clients enrolled in CMP after that date. Use the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button. You can also click the Export button to export your report, but it is recommended that you first proof the report results before exporting them.
The results screen displays the dates of your report at the top of the screen. Underneath, the number of CMP clients enrolled during that period displays.

The report table rows correspond to clients. The columns display from left to right: the client’s CMP case number, their URN, their name, any missing demographic data, their enrollment date, any missing service data, and their last assessment date.

If a client’s missing demographic data and service data cells are blank, their records are up to date.

To export your report, click the Export button (see page 233).

Number of CMP Clients Served Compliance Report

The Number of CMP Clients Served Compliance report totals the number of clients enrolled in CMP (Case Management Program) who receive services at your agency per month. It does not tally the total number of services, but the clients who received them. So a client who receives multiple services in a single month is counted once.

To access the report, from the ARIES menu bar at the top of the ARIES screen, choose the Report → Compliance menu item to get to the Compliance Reports screen. Click the “Number of CMP Clients Served Compliance Report” link, which takes you to the report’s filters screen.
From the Date of Service drop-down list, select the type of filter you want to perform. You can search before or after a date, or between two dates.

Enter the date you wish to filter by in the first text field using the format MM/DD/YYYY. So for January 23, 2005, enter 1/23/2005. You can also click the calendar icon to use the pop-up calendar.

Use the drop-down lists to select the month and year you wish to enter. Click on the day and the date displays in the text field. The pop-up calendar window closes automatically.

To filter for records on a given day, select “On” from the drop-down list and enter a specific date, e.g. 6/23/2005, in the first text field. Leave the second text field empty.

Select “Before” to sort through all services before – but not on – that specific date. Enter the date, e.g. 6/23/2005, in the first text field and leave the second text field empty. This will retrieve service records before midnight on June 22, 2005.

Select “After” to bring up all services after a specific date, including records dated that day. For example, entering 6/23/2005 in the first text field and clicking Search will display all the records dated June 23, 2005 and all the days following it. For this option, leave the second text field empty.

To filter a range of dates, select “Between” from the drop-down list and enter in the beginning date in the first text field and the ending date in the second text field. Your report results will include all services that occurred from 12:00 AM on the first date to 11:59 PM on the second date.
The Display text field at the bottom of the screen allows you to control the maximum number of rows that will appear in your report. Selecting the “Display print format” checkbox will generate your report without the ARIES menu bar if you want to print your report directly from the browser window.

When you have finished entering your filter parameters, click the Report button. You can also click the Export button to export your report, but it is recommended that you first proof the report results before exporting them.

<table>
<thead>
<tr>
<th>Month</th>
<th>Number of Unduplicated Clients</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-January</td>
<td>1543</td>
</tr>
<tr>
<td>2-February</td>
<td>1323</td>
</tr>
<tr>
<td>3-March</td>
<td>1577</td>
</tr>
<tr>
<td>4-April</td>
<td>1352</td>
</tr>
</tbody>
</table>

**Number of CMP Clients Served Compliance Report**

*Criteria: ServiceLineItem.serviceDate BETWEEN '1/1/2004' AND '4/30/2004'*

4 records, generated 11/9/2004 2:20:58 PM

The report results display in a table where the first column lists the month and the second column lists the total number of unduplicated CMP-enrolled clients who received services. The report tallies the total number of clients in a given month who receive services; even if a client receives multiple services, they are only counted once.

At the bottom of the table, the number of records and the time and date of the report display. Beneath that are the filter parameters specified in the previous screen.

To export your report, click the Export button (see page 233).
Glossary

ADAP (AIDS Drug Assistance Program)
Administered by States and authorized under Title II of the CARE Act, provides FDA-approved medications to low-income individuals with HIV disease who have limited or no coverage from private insurance or Medicaid. ADAP funds may also be used to purchase insurance for uninsured CARE Act clients as long as the insurance costs do not exceed the cost of drugs through ADAP and the drugs available through the insurance program at least match those offered through ADAP.

Adherence
How well a patient follows a doctor prescribed course of medication.

Administrative Agency
An administrative agency manages other agencies and is allowed to report on their client and service data. If your agency has permission to create new agencies, then you are automatically an administrative agency. You automatically administer every agency you create. An ARIES administrator can change or remove the agencies administered by using ARIESAdmin.

AIDS (Acquired Immunodeficiency Syndrome)
A disease caused by the human immunodeficiency virus.

Antiretroviral
A substance that fights against a retrovirus, such as HIV. (See Retrovirus)

ARIES
AIDS Regional Information and Evaluation System.

ARIESAdmin
ARIESAdmin is the administration application for ARIES. With it, you can monitor and control ARIES activity as well as customize ARIES edit screens. You can oversee users and groups, design reports, customize data entry, troubleshoot problems, and perform maintenance.

ARIESImport
The ARIESImport application allows you to bring data into ARIES from other sources. ARIESImport accepts XML files, checks them for validity, and then inserts or updates the database with the data.

ARIESReportExport
The ARIESReportExport application allows you to define custom reports. You can also export ARIES data in a variety of formats including XML for inclusion in other applications.

ASP.NET
Active Server Pages, a technology by Microsoft to create robust interactive applications for the Web.

CADR (CARE Act Data Report)
A provider-based report generating aggregate client, provider, and service data for all CARE Act programs. Reports information on all clients who receive at least one service
during the reporting period. Replaces the Annual Administrative Report (AAR) used for Title I and Title II as well as separate Title III and Title IV data reports.

**CARE Act (Ryan White Comprehensive AIDS Resources Emergency Act)**
Federal legislation created to address the unmet health care and service needs of people living with HIV Disease (PLWH) disease and their families. It was enacted in 1990 and reauthorized in 1996 and 2000.

**CARE/HIPP**
The Health Insurance Premium Payment (CARE/HIPP) program was created under the CARE Act. Funded by Title II of the CARE Act and administered by the California Office of AIDS, CARE/HIPP will pay the insurance premium costs for eligible clients with HIV or AIDS.

**Care Plan**
Case managers design care plans outlining the steps needed to meet the client’s needs. These steps can include instructions for caregivers, tasks for staff persons, referrals, and services. With care plans, case managers can track a client’s progress, which helps ensure quality care.

**CD4 Cell Count**
The number of T-helper lymphocytes per cubic millimeter of blood. The CD4 count is a good predictor of immunity. As CD4 cell count declines, the risk of developing opportunistic infections increases. The normal adult range for CD4 cell counts is 500 to 1500 per cubic millimeter of blood. (The normal range for infants is considerably higher and slowly declines to adult values by age 6 years.) CD4 counts should be rechecked at least every 6 to 12 months if CD4 counts are greater than 500/mm3. If the count is lower, testing every 3 months is advised. (In children with HIV infection, CD4 values should be checked every 3 months.) A CD4 count of 200 or less is an AIDS-defining condition.

**CD4 or CD4+ Cells**
Also known as "helper" T-cells, these cells are responsible for coordinating much of the immune response. HIV's preferred targets are cells that have a docking molecule called "cluster designation 4" (CD4) on their surfaces. Cells with this molecule are known as CD4-positive (CD4+) cells. Destruction of CD4+ lymphocytes is the major cause of the immunodeficiency observed in AIDS, and decreasing CD4 levels appear to be the best indicator for developing opportunistic infections.

**CDC (Centers for Disease Control and Prevention)**
Federal agency within HHS that administers disease prevention programs including HIV/AIDS prevention.

**Client**
Clients are individuals who receive services from your agency. These services can be anything from medical care to housing to counseling to meals. There are clients who are related to or are affected by persons with HIV. Those may include family members, dependents, or roommates, who are eligible for services like housing assistance or transportation.
**Client ID**
A client identifier assigned internally by the agency with which they are enrolled.

**CMP**
The Case Management Program provides home- and community-based services for persons with AIDS and symptomatic HIV infection whose cognitive and functional abilities are impaired.

**Digital Certificate**
An electronic identification card, issued by a certificate server, that establishes a user’s credentials when doing business or other transactions on the Web.

**Early Intervention Program (EIP)**
A government-funded program designed to prevent and delay symptomatic HIV by providing prompt diagnostic services, continual support, and ongoing education.

**Eligible Metropolitan Area (EMA)**
Geographic areas highly-impacted by HIV/AIDS that are eligible to receive Title I CARE Act funds.

**Encryption**
The process of disguising information in a way such that only the people with the right key can uncover the information.

**Genotypic Assay**
A test that analyzes a sample of the HIV virus from the patient's blood to identify actual mutations in the virus that are associated with resistance to specific drugs.

**Grantee**
The recipient of CARE Act funds responsible for administering the award.

**HAART (Highly Active Antiretroviral Therapy)**
HIV treatment using multiple antiretroviral drugs to reduce viral load to undetectable levels and maintain/increase CD4 levels.

**HIV Disease**
Any signs, symptoms, or other adverse health effects due to the human immunodeficiency virus.

**Home and Community Based Care**
A category of eligible services that States may fund under Title II of the CARE Act.

**HOPWA**
The Housing Opportunities for Persons with AIDS Program was established by U.S. Department of Housing and Urban Development (HUD) to address the specific needs of persons living with HIV/AIDS and their families. HOPWA makes grants to local communities, States, and nonprofit organizations for projects that benefit low income persons medically diagnosed with HIV/AIDS and their families.

**HRSA (Health Resources and Services Administration)**
The agency of the U.S. Department of Health and Human Services that administers various primary care programs for the medically underserved, including the Ryan White CARE Act.
**HTML**
Hyper Text Markup Language, the standard language for describing how information is displayed and interacts with users on a web browser.

**HTTP**
Hypertext transfer protocol. A communication protocol that allows the web browser and web server to exchange data.

**HTTPS**
A protocol identical to HTTP except it uses the SSL protocol to allow the web browser and the web server to agree to an encryption methodology so that only the two of them can decipher the communication sent to each other over the Internet.

**HUD (U.S. Department of Housing and Urban Development)**
The Federal agency responsible for administering community development, affordable housing, and other programs including Housing Opportunities for People with AIDS (HOPWA).

**IDU**
Injection Drug User.

**Karnofsky Scale**
A score between 0 and 100 assigned by a clinician based on observations of a patient's ability to perform common tasks. Thus, 100 signifies normal physical abilities with no evidence of disease. Decreasing numbers indicate a reduced ability to perform activities of daily living.

**Longitudinal**
This refers to data points that have multiple values over a period of time. Longitudinal data for certain data points shall be maintained and displayed in ARIES, until they are moved off the production database. At that point, they may exist only as part of the historical data. Examples of longitudinal data in ARIES are CD4, viral load, HIV tests, and pregnancy. Each client may have zero, one or more records for each of these fields.

**Maintenance therapy**
A preventative therapy that follows successful initial treatment of an illness. Maintenance therapy typically continues for the lifetime of an individual to prevent disease reactivation, also known as secondary prophylaxis.

**MCWP**
The Medi-Cal Waiver Program provides home- and community-based services for persons with AIDS and symptomatic HIV infection whose cognitive and functional abilities are impaired.

**MDR Test**
Multi-drug resistance testing. If a client tests positive for tuberculosis, tests can be performed evaluating the drug resistance of the mycobacterium strain.

**Median Area Income**
The median household annual income of a geographic area as defined by the Department of Housing and Urban Development.
Monthly Adjusted Gross Income
A household’s monthly income reduced by deductions (or allowances) for dependents, elderly households, medical expenses, disability assistance expenses, and childcare.

Mycobacterium avium complex (MAC)
A bacteria which can infect the lymph system, bone marrow, liver, spleen, spinal fluid, lungs, and gastrointestinal tract causing diarrhea, wasting, fever, fatigue and spleen enlargement

Needs Assessment
A process of collecting information about the needs of PLWH (both those receiving care and those not in care), identifying current resources (CARE Act and other) available to meet those needs, and determining what gaps in care exist.

Pediatric Scale
The acuity of the client’s symptoms if the client is under 13-years of age. The scale is measured in a letter grade from A-C, where C is the most severe. If the client has no symptoms, they are scored an N.

Permissions
Each ARIES user is assigned permissions that grant them access to different portions of ARIES. Users can view, change, create, and deactivate records in ARIES based on their permissions. ARIES administrators can change these privileges through the Staff Permissions screen. A staff person cannot edit his or her own permissions.

Phenotypic Assay
A procedure whereby sample DNA of a patient's HIV is tested against various antiretroviral drugs to see if the virus is susceptible or resistant to these drug(s).

PLWH
People Living with HIV Disease.

Pneumocystis carinii pneumonia (PCP)
A life-threatening type of pneumonia thought to be caused by a fungus.

PPD
The purified protein derivative skin test used to test for tuberculosis.

Protease
An enzyme that triggers the breakdown of proteins. HIV's protease enzyme breaks apart long strands of viral protein into separate proteins constituting the viral core and the enzymes it contains. HIV protease acts as new virus particles are budding off a cell membrane.

Protease Inhibitor
A drug that binds to and blocks HIV protease from working, thus preventing the production of new functional viral particles.

Referral
Referrals are used to help clients access services that are unavailable at an agency. For instance, if an agency specializes in psychosocial counseling, but their client needs medical attention, a referral can be made to a medically based agency.
**Related/Affected Individual**
Clients associated with the client who are HIV negative as well as those with unknown HIV status. An affected client can be a family member or partner but must be linked to an infected client who is receiving services. Affected clients may be eligible for services like housing assistance or transportation.

**Relational Database**
A type of database in which complex data is separated and stored across multiple tables, tied together by a common key, such as a Client ID. Doing this improves the flexibility of the database and increases its robustness.

**Retrovirus**
A type of virus that, when not infecting a cell, stores its genetic information on a single-stranded RNA molecule instead of the more usual double-stranded DNA. HIV is an example of a retrovirus. After a retrovirus penetrates a cell, it constructs a DNA version of its genes using a special enzyme, reverse transcriptase. This DNA then becomes part of the cell's genetic material.

**Risk Factor or Risk Behavior**
Behavior or other factor that places a person at risk for disease; for HIV/AIDS, this includes such factors as male-to-male sexual contact, injection drug use, and commercial sex work.

**Salvage Therapy**
A treatment effort for people who are not responding to, or cannot tolerate the preferred, recommended treatments for a particular condition. In the context of HIV infection, drug treatments that are used or studied in individuals who have failed one or more HIV drug regimens. In this case, failed refers to the inability to achieve or sustain low viral load levels.

**Service**
Agencies provide services for clients. Services can include medical consultations, meals, housing assistance, psychological counseling, transportation, medication, and case management.

**SQL**
Structured Query Language, a standard language to create and manipulate data in a relational database.

**SQL Server**
A relational database server developed by Microsoft Corp

**SSL**
Secured Socket Layer, a protocol that allows client/server applications to communicate in a way designed to prevent eavesdropping, tampering, or message forgery.

**STI**
Sexually Transmitted Infection.

**TB (tuberculosis)**
Infectious disease caused by Mycobacterium tuberculosis that typically affects the lungs but may occur in other organs.
Title I
The part of the CARE Act that provides emergency assistance to localities (EMAs) disproportionately affected by the HIV/AIDS epidemic.

Title II
The part of the CARE Act that provides funds to States and territories for primary health care (including HIV treatments through the AIDS Drug Assistance Program, ADAP) and support services that enhance access to care to PLWH and their families.

Title III
The part of the CARE Act that supports outpatient primary medical care and early intervention services to PLWH through grants to public and private non-profit organizations. Title III also funds capacity development and planning grants to prepare programs to provide EIS services.

Title IV
The part of the CARE Act that supports coordinated services and access to research for children, youth, and women with HIV disease and their families.

TMP
The Therapeutic Monitoring Program is a care program in the state of California created to provide vouchers for viral load and resistance testing for certain ADAP participants.

Transmission Category
A grouping of disease exposure and infection routes; in relation to HIV disease, exposure groupings include, for example, men who have sex with men, injection drug use, heterosexual contact, and perinatal transmission.

URL
The Uniform Resource Locator is the address of a web page.

URN
Unique Record Number, an identity number developed by HRSA generated from a person’s last name, first name, date of birth and gender. ARIES employs an extended URN composed of the first and third characters of the client’s first and last name, their middle initial, the first and third characters of the client’s mother’s maiden name, their date of birth, and gender.

Viral Load
In relation to HIV, the quantity of HIV RNA in the blood. Viral load is used as a predictor of disease progression. Viral load test results are expressed as the number of copies per milliliter of blood plasma.

Web Browser
A desktop application, such as Internet Explorer, that processes the data exchanged with a web service, usually resulting in a display of a web page.

Web Server
A server designed to process HTTP requests from a web browser, such as to get a certain web page or image.
**Western Blot**
A test for detecting the specific antibodies to HIV in a person's blood. It is commonly used to verify positive EIA tests. A Western Blot test is more reliable than the EIA, but it is more difficult and more costly to perform. All positive HIV antibody tests should be confirmed with a Western Blot test.

**Wild Type Virus**
HIV that has not been exposed to antiviral drugs and therefore has not accumulated mutations conferring drug resistance.

**Windows**
The operating system developed by Microsoft for stand-alone laptop and desktop computers.

**Windows Server**
An operating system of Microsoft Corp designed to handle multiple user requests, such as in a web server or a database server.

**XML**
Extensible Markup Language is a cross-platform, software and hardware independent tool for transmitting information.
Index

Active EIP Clients Report, 328
actual minutes spent, 190
acuity tools, 130
agency, 212, 222
ADAP (AIDS Drug Assistance Program)
  CADR and, 297
documentation, 68
  TMP and, 101
adherence, 151
  CMP/MCWP and, 111
editing, 155
HAART, 112
non-ART, 158
agencies, 10, 204
  acuity tools, 212, 222
  administrative, 204
  contracts, 219
  creating, 210
details, 218
  editing, 221
  email, 219
  funding sources, 225
HRSA and, 212, 223
new, 207
permissions and, 205
phone numbers, 213, 224
primary services, 227
record sharing and, 38, 41, 62, 63
screens, 216
search results, 218
searches, 217
  services of, 220
  sites, 199, 223
  subservices, 227
  agency managers, 22
  agency specifics, 62
  agency status, 64
AIDS
  defining conditions, 127
  diagnosis, 122
  status, 125
  alcohol abuse, 95, 163
  alternative therapies, 124
ARIES
  applications, 10
  components, 10
  system requirements, 11
  uses for, 7
  ARIESAdmin, 10
  agencies and, 204
  ARIESImport, 10
  ARIESReportExport, 10
ART, 152
  drugs, 154
  editing, 152
  pregnancy and, 143, 147
  types, 152
  assets, 73
Bacille Calmette-Guerin (BCG), 139
back button, 18
basic medical, 122
additional, 129
editing, 123
bookmark, 14
budgets, 221
CADR, 221
  missing data, 264
  required fields, 9
  wizard, 292
cancel button, 17
CARE Act, 113
  data report, 292
  website, 292
care plans, 168
  editing, 172
  incomplete tasks reports, 269
  needs assessments and, 168, 169
care services, 301
CARE/HIPP, 113
  CADR and, 297
  editing, 116
  enrollment, 114
  enrollment change status, 115
case managers, 22
case notes, 180
  editing, 182
  printing, 182
  sealed, 181
  unsigned, 272
CD4+ counts, 131
  editing, 134
  reports, 255
CDC
  AIDS defining conditions, 127
  disease stage, 122
  CHAMPUS, 125
  checkbox, 8
  chlamydia, 135
  chronic medical conditions, 123, 130
  client records, 22
  client tab bar, 18, 41
  clients, 9, 22
  active roster, 245
  agency specifics, 62, 63
  alerts, 65
  assets, 73
  basic medical, 122, 123
  case notes, 180
  confidentiality, 42
  consent forms, 68
  contact information, 42, 43
  counting distinct, 274, 276
  creating, 37
  cross tab reports on, 274, 276
  eligibility, 65
  emergency contacts, 43, 44
  enrollment date, 62
  financials, 69, 70
  gender, 39, 48
  identifiers, 47, 48
  IDs, 35, 62, 65
  insurance, 73, 74
  mailing, 43
  medical, 121
  medical history, 130, 132
medical providers, 122
pediatric, 160
phone numbers, 42, 45
programs, 76
proof of residency, 68
record sharing, 38, 41, 62, 63
related/affected individuals and, 57
releases, 68
reports, 239
residence, 43
screens, 34
search, 34
search results, 36
status reports, 242
weight, 122, 130
clinicians, 22
clotting factor, 161
CMP
  compliance reports, 335, 337, 341
  missing data, 339
CMP/MCWP, 108
  assessment, 111
  enrollment, 109
  enrollment change status, 110
comma-separated values, 229, 236
complementary care, 124
confidentiality
  client, 42
  emergency contacts and, 44
  telephone, 45
consent forms, 68
Contact History Report, 323
contracts, 208, 219
  editing, 226
  Conventions, 7
  cookies, 11
  copy and paste, 19
cross tab reports
  accessing, 289
  by table, 283
  counting distinct clients, 274, 276
  counting services, 278, 281
  parameters, 286
  results, 275, 277, 280, 282, 285, 287
  saving, 289
  wizard, 273
data entry, 9
  shortcuts, 17
demographics, 41, 48
details, 46
digital certificates, 11, 14
disease management, 255
dosages, 158
drop-down list, 8
drugs. See also medications
  abuse of, 95, 163
  ART, 154
  HRSA codes, 189
  intravenous, 160, 161
  treatment, 164
drop-down list, 8
edit locks, 21
  back button and, 16
education, 51
EIP (Early Intervention Program), 78
active clients, 328
behavioral risk, 80, 91
CADR and, 299
change status, 81
compliance reports, 326, 333
Contact History Report, 323
enrollment, 80
functional status, 79, 88, 167
psychosocial factors, 79, 83, 167
Service Data Report, 320
Service Referral Report, 322
summary report, 330
eligibility, 65
documents, 66, 67
for services, 184
reports, 240
email
agency, 219
staff, 197
emergency contacts, 44
emergency room visits, 140
employment, 71, 199
enrollment, 22
enrollment date, 62, 65
exporting, 229, 234
fields, required, 9
filter values, 230
exporting and, 235
financials, 69
ingrunt, 70
reports, 260, 261
funding, 219
funding sources, 225
gender, 39
editing, 48
gonorrhea, 135
grantee numbers, 225
HAART, 153
adherence, 112
health department
partner notification, 123, 130
help, 17
shortcut, 18
hepatitis, 135
immunizations, 139
testing, 132, 135
herpes, 135
HIPP. See CARE/HIPP
Hispanics, 49, 51
HIV
acuity, 122, 130
drug resistance, 156
infection, 161
letter of diagnosis, 68
perinatal transmission of, 161
pregnancy and, 142, 146
status, 125
testing, 123, 126
HIV testing, 133, 160
TMP and, 105
home page, 16
home pages, 200
HOPWA (Housing Opportunities for Persons With AIDS), 59
documentation, 68
editing, 60
progress reports, 310
TDH Housing Assistance Program, 311
hospital visits, 132, 140
HPV (human papillomavirus), 135
HRSA (Health Resources and Service Administration)
agencies and, 212, 223
drug codes, 189
missing data reports, 264
related/affected individuals and, 58
HSDA, 44, 213, 224
HUD (Department of Housing and Urban Development), 55
immunizations, 132
editing, 139
reports, 252
income, 70
adjusted gross, 59, 61
client, 71
household, 72
median area, 59, 61
proof of, 68
insurance, 73
CARE/HIPP and, 113
editing, 74
related/affected individuals and, 58
intakes, 22
Internet Explorer, 19
settings, 11
interventions, 174
Is Not Null, 232
Is Null, 232
JavaScript, 11
lab accession number, 107
languages, 49, 52
living situation, 52
editing, 53
logging in, 11, 14
IDs, 200
timeouts and, 21
logout, 17
mail, 43
mailing labels, 257
marital status, 49, 51
MCWP
compliance reports, 313, 315, 317, 319
enrollment form, 313
MDR testing, 131, 138
medical, 121
Medi-Cal, 113
waivers, 313
medical history, 130
editing, 132
medical providers, 122
types, 124
medications, 151
other, 156
mental health, 165, 167
editing, 165
mental illness, 166
menus, 8, 17
active roster by staff, 245
care plan incomplete tasks, 269
client, 239
client status, 242
compliance, 290
disease management, 255
display order, 238
exporting, 229, 234
finance, 260
financials, 261
generating, 229
immunizations, 252
management, 263
needs assessments, 249
pending eligibility documents, 240
printing, 238
referrals, 246
results, 233
screens, 230
services, 257
unsigned case notes, 272
wildcards, 232
resistance testing, 108, 156
risk behavior, 91, 167
risk factors, 158
editing, 160
Ryan White
Cross Titles Data Summary, 307
save button, 17
scroll box, 8
search results, 35
security, 9, See also permissions
digital certificates and, 11, 14
services, 184
budgets, 221
cross tab reports on, 278, 281
dates, 190
default price, 221
default quantity, 221
editing, 186
eligibility for, 184
finalize, 190
interventions and, 176
of agencies, 220
primary, 189, 227
reports, 257
secondary, 189, 227
tiers, 189
sessions, 21
sexual abuse, 161
sexual behavior, 91, 159, 167
risk factors and, 160
sexual orientation, 49, 51
sexually transmitted infections testing, 132, 135
short names, 199
shortcuts
keyboard, 17
menu, 16
special needs, 50, 51
SSL, 11
staff, 10, 191
assignments, 77
details, 198
editing, 198
email, 197
groups, 200
new, 193, 196
passwords, 200
permissions, 201
phone number, 199
preferences, 192
screens, 195
search results, 197
searches, 196
titles, 199
user reports, 267
subservices, 189, 227, See also services
substance abuse, 162
   editing, 163
syphilis, 135
system requirements, 11
tab-separated values, 229, 236
tasks
   incomplete, 269
   interventions and, 175
   outcomes, 173
TB PPD testing, 131, 137
TDH, 311
tetanus, 139
text box, 8
text field, 8
timeouts, 21

TMP (Therapeutic Monitoring Program), 101
   change status, 104
   enrollment, 102
   service edit, 105
   service outcome edit, 106
transfusions, 161
tuberculosis
   testing, 137
treatment, 132
UDC
   goal, 221
goals, 228
UOS, 189
   goal, 221
goals, 228
urethritis, 135
URN, 48
veterans, 51
viral load testing, 108, 131
   editing, 135
   reports, 255
welcome screen, 15
WICY, 304
wildcards, 35
   in reports, 232
XML, 229, 236
   exporting, 10
   importing, 10
X-rays, 132, 138